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1

Dear Reader,

First, I would like to say thank you for giving me your trust by pur-
chasing this book! I owe and dedicate Th e VueScan Bible to my readers. 
It was your feedback that convinced me to write another book about 
scanning. Aft er publishing my successful book, Scanning Negatives and 
Slides, that describes all scanning processes in detail, I received loads of 
letters via my website, www.scanguru.info. Along with giving me use-
ful feedback, readers frequently demanded even more soft ware-specifi c 
guidance—and VueScan was at the forefront of those readers’ interests.  

So, here we go! Th e VueScan Bible is designed to help both begin-
ners and experienced users get the most out of their VueScan-powered 
scanners. While it includes all the basic scanning know-how you need, 
VueScan-specifi c workfl ows are the center of attention. Scanning is not 
rocket science, but you simply have to know certain things; otherwise, 
you will waste a lot of time and eff ort. Th is is especially true when you 
use soft ware as powerful as VueScan. Despite its rich features, VueS-
can is a remarkably lean scanning program that has been continually 
improved by its inventor, Ed Hamrick, for more than a decade. I want 
to express my gratitude to Ed Hamrick, who has been supporting this 
book project from the very beginning. 

VueScan was the fi rst scanning soft ware ever to provide sophisticat-
ed features, like RAW data scanning functionality, that live up to their 
promise. And it runs on Mac, Windows and Linux computers alike. 
Whether you are a techie-loving pixel peeper or just an average user 
who wants to work quickly and effi  ciently with the soft ware—you must 
get used to VueScan’s tricks and traps for the best scanning results. Th is 
book provides you with everything you need to know to convert your 
analog negatives, slides, documents, and photo prints into high-quality 
digital fi les. 

Best Regards

Sascha Steinhoff  
Bangkok, April 2011 

Preface

Vue_book_large.indb   1 13.04.2011   19:41:09

http://www.scanguru.info


2

Using this book

VueScan has an astonishing variety of options. Th is book uses diff erent 
styles for intuitive navigation through all these tabs, options, and but-
tons. Below is an explanation of how it works.

A. The entries of the menu bar

a) Adressing of fi rst level entries like File (Edit, Scanner, etc.): 
 File
b) Adressing of subentry: 
 File ▶ Save image
or when written separately: 
 go to File menu and pick Save image or Page setup.

B. The tabs of VueScan

a) Adressing of tab, like Input (Crop, Filter, etc.): 
  Input  
b) Adressing of subentry in tab: 
  Input  ▶  Task  
c) Adressing of confi guration option in subentry: 
  Input  ▶  Task  ▶ Scan to fi le
or when written seperately:
 go to  Input  ▶  Task  and confi gure Scan to fi le.
Th is format is used for the tabs  Preview  and  Scan  as well.

C. Keys and Buttons 

Pushbuttons either on the keyboard or in VueScan look like this:
 (Scan) for Scan Button in the GUI
 (F1) for F1 key on the keyboard
This format is used for the pushbuttons (Scan) and (Preview) in the 
VueScan GUI as well. Don’t mix it up with the tabs  Preview  and  Scan . 

A note on VueScan updates

Th is book refers to VueScan Professional 9.0.22, which was the new-
est version of VueScan at the time of writing. Ed Hamrick continually 
releases updates; a new version every two weeks or so is quite common. 
Please consider that the updates mainly contain bug fi xes; new func-
tionality is implemented much less frequently. Th at means the informa-
tion in this book will stay up to date even though you might be using a 
newer version of VueScan. If you have any questions contact the author 
at his website www.scanguru.info. 

In general the images for this book have been taken by the author, the 
exceptions are marked clearly.
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1
Contents

Field of application
Compatibility and license issues
VueScan GUI 
Dependencies – Automatic GUI changes 
Saving and restoring options 

VueScan – Look and Feel 
VueScan is possibly the most feature-rich application avail-
able on the market today. It allows you to control nearly all 
current scanner models plus a good portion of vintage mod-
els. When you compare the program to the scanner drivers 
shipped with scanning hardware, you will fi nd that VueScan is 
much more powerful. Of course, this power comes at a price. 
Th ough it has a beginners’ mode, the sheer number of options 
in VueScan can make it cumbersome if you are not familiar 
with its operation. But as this chapter will show, you can easily 
handle VueScan once you are familiar with the concepts. 
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4 1 VueScan – Look and Feel

1.1 Field of application

VueScan is a third-party scan application developed by Ed Hamrick. 
Although every scanner comes with a scanner driver provided by 

the manufacturer, you can noticeably expand your scanner’s abilities by 
using VueScan. VueScan is a commercial yet economically priced ap-
plication. It supports 1,600 diff erent scanners at the time of writing this 
book and new scanners are added frequently, therefore the numbers are 
still rising. Th e application supports almost all fl atbed and fi lm scanners 
available on the market today, and a good portion of vintage scanners as 
well. So if you are using any common desktop scanner, the chances are 
high that VueScan will work with it. 

CMOS scanners

Of course, there are a few exceptions to the rule. At present, VueScan 
does not support CMOS scanners. CMOS scanners are small, box-
shaped devices that have a CMOS chip inside to convert analog slides 
into digital pictures. Despite their comparably poor quality, they sell 
quite well—mostly because of their low price. For quality-conscious us-
ers, they are not a reasonable choice; though they have been around for 
some years, they still lag far behind traditional fl atbed and fi lm scan-
ners. Basically these are just cheap digital cameras in a box.

Drum scanners and Hasselblad scanners

Th e other scanners not supported by VueScan are vintage drum scan-
ners and their modern successors manufactured by Hasselblad. Drum 
scanners are the dinosaurs of scanning. During their heyday in the 
1990s, they were incredibly heavy, incredibly expensive, and very diffi  -
cult to operate. A specially trained scan operator had to run these mon-
ster scanners, which could easily cost as much as a house. Drum scan-
ners still exist in small numbers, but they are slowly dying out. If you 
still want to use one, either talk to the manufacturer regarding scanning 
soft ware or try your luck with SilverFast. SilverFast provides support for 
some of these high-end scanners, but the soft ware is quite pricey.

Th e modern alternative to a drum scanner is manufactured by a com-
pany originally called Imacon. Imacon was bought out by Hasselblad, 
so the scanners are now sold as Hasselblad devices. Hasselblad scanners 
operate with a kind of virtual drum, so they look quite diff erent from av-
erage fi lm and fl atbed scanners. Neither VueScan nor SilverFast provide 
scanning soft ware for Hasselblad scanners. For the average user, these 
scanners are not an option. Although Hasselblad scanners are cheaper 
than the old drum scanners, they still can cost as much as a car. For av-
erage desktop scanning, fi lm and fl atbed scanners are the fi rst choice—
and the chance that VueScan supports your desktop scanner is almost 
100%. Th e manufacturer’s website, www.hamrick.com, hosts a compat-
ibility list where you can see all supported scanner models.
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51.1 Field of application

Classic fi lm scanners like this Nikon Coolscan 5000 deliver 

brillant scans of 35mm fi lm. VueScan supports almost every fi lm 

scanner on the market.

Flatbed scanners are the most versatile desktop scanners. They 

can process transparencies and refl ectives of various sizes.

VueScan supports almost every fl atbed scanner on the market. 

CMOS scanners are relatively new on the market. Most of these 

devices are quite cheap and not capable of scanning analog 

originals in good quality. Not supported by VueScan, yet. 

Hasselblad scanners are the Ferraris of the scanning world. They 

cost as much as a car and, despite the high price, functionality 

like infrared channel is missing. Not supported by VueScan, yet.   
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6 1 VueScan – Look and Feel

* Unlike other software, VueScan 
provides the same functionality on 
every platform!  Infrared clean  will 
always work the same, no matter if 
you are using VueScan with Linux, 
Windows, or a Mac. With SilverFast, 
it can be diff erent due to license re-
strictions of proprietary correction 
fi lters like Digital ICE. While Windows 
versions of SilverFast may support 
Digital ICE, it may not be the case 
when you are using SilverFast on a 
Mac. You have to check this carefully 
for your individual scanner and your 
operating system.

1.2 Compatibility and license issues 

There is no other scanning soft ware available on the market that sup-
port a similar range of operating systems as VueScan. Th e support of 
Windows systems is more or less standard. VueScan supports all current 
versions of Windows, as well as all versions of Windows since Windows 
2000. Mac OS X is supported by VueScan, too - from version 10.3.9 to 
the latest version. Mac OS 9 is not supported any more. At this point all 
other scanning soft ware manufacturers usually stop. You can be happy 
if they provide compatibility with Windows and Mac OS X, and that’s it. 
VueScan, goes one step further, as you can use it with Linux, too! Th is 
is a very nice feature and can be quite convenient, especially if you want 
to reuse an existing computer as a scan machine and you have no Win-
dows license for it. All in all the support of diff erent operating systems 
by VueScan is quite unique in the world of scanning. Th e user can freely 
decide what platform he wants for his scanning computer and that is a 
very nice feature, indeed.*  

Unlike older scanning programs, VueScan is also available in 32-bit 
and 64-bit versions (the x32 and x64 versions). Th ese are available for 
Windows, Mac OS X and Linux operating systems. In addition, the Mac 
OS X versions of VueScan are universal binaries. Th e Mac OS X x32 
version is a universal binary with 32-bit Intel and PowerPC binaries, 
and the Mac OS X x64 version is a universal binary with 32-bit Intel 
and 64-bit Intel binaries. Th e x32 version of VueScan will run on both 
32-bit and 64-bit Windows, Mac OS X, and Linux. Th e x64 version will 
only run on x64 Windows, Mac OS X 10.5 and later, and 64-bit Linux 
of course. 

Flexible licensing regulations

Th e licensing scheme of VueScan is as fl exible as its operating system 
support. When you buy one license, you can use it on any kind of com-
puter—Windows, Mac OS X, or Linux. You can even switch among op-
erating systems while running the soft ware, if you like. Also, in contrast 
to SilverFast, the license is not dedicated to a specifi c scanner type. If 
you buy any VueScan license, you can use it with any scanner supported 
by the soft ware. If you buy a new scanner, you would have to buy a new 
SilverFast license; with VueScan, this is not necessary, since you can use 
VueScan with as many scanners as you like.  

In most cases,  you would buy a single-user license from VueScan. 
You can use this in two ways with your VueScan license. For one user or 
family, you can install VueScan on four diff erent computers in the same 
home. Th is is extremely convenient, especially if you are using diff er-
ent scanners at the same time at diff erent workstations. But if you have 
multiple users outside your family confi guration, you should only install 
VueScan on one computer at the same time. For workgroups or cor-
porate use, Hamrick Soft ware off ers multi-user licenses that are much 
cheaper than buying several single-user licenses.  
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71.2 Compatibility and license issues

* This book refers to the Professional 
Edition of VueScan as this is the only 
edition that off ers the full function-
ality. If you use the Standard Edition 
of VueScan, just skip the parts that 
deal with color management and 
raw scanning.

* Especially if you are going to use 
exotic fi lmholders with your scan-
ner, you should try out VueScan 
and make sure that it fully supports 
them. At the very least, run the soft-
ware before you buy it to make sure 
it matches your expectations. 

Standard vs. Professional Edition 

Due to the fl exibility of VueScan’s licensing regulations, there is only 
one major decision that you have to make before purchasing: do you 
want the Standard or Professional Edition? Th e Standard Edition costs 
$39.95, and the Professional Edition costs $79.95—about twice as much.
Th e Professional Edition off ers some nice features that you will not fi nd 
in the Standard Edition. None of them is a must—you can do proper 
scanning with the Standard version, too—but the extra features can be 
quite useful. 

Th e fi rst of these Professional Edition exclusive features is the ability 
to create raw scan fi les, which can be extremely helpful during batch 
scanning. When you use this feature, you can concentrate on the scan 
itself and do all your confi gurations later when processing the raw fi le. 
With the Standard Edition of VueScan, you have to decide before scan-
ning whether you want to use Infrared Clean or not. If you change your 
mind and decide you want to fi ne tune an image further, you would 
have to rescan it. But if you have a raw scan fi le, all you have to do is sim-
ply change the settings—there’s no need to do a time-consuming rescan. 

Th e second feature exclusive to the Professional Edition is the em-
bedding of ICC profi les. With IT8 color calibration, the third Profes-
sional feature, you can even create your own profi les. Th ese features 
are quite convenient, as they help you produce true colors throughout 
the workfl ow. Whether you really need them or not depends on what 
you are scanning—e.g., for slides, IT8 color calibration is useful, while 
for negatives it is not. In addition, the ability to embed color profi les and 
do color calibration will help improve picture quality only if you have a 
good scanner; if you have a cheap scanner, these options are more or less 
a waste of time. A poor quality scanner will produce mismatched colors 
whether you calibrate it or not. 

Th e fourth and potentially most important feature of the Professional 
Edition is an unlimited upgrade period. Ed Hamrick actively improves 
VueScan. Every two weeks or so, a new version is available for download. 
Most modifi cations are improved hardware support and bug fi xes, but 
from time to time new features and GUI improvements are available. 
Th us, it makes sense to update your VueScan installation from time to 
time. With VueScan Professional, you can upgrade as many times as 
you like. With the Standard Edition, you can upgrade for only one year, 
and then you have to buy a new license. Th us, it doesn’t take long for the 
higher price of the Professional Edition to pay off . 

Try before you buy 

Before you purchase VueScan, you should check out the free trial ver-
sion. It off ers the full functionality of VueScan with only one restriction: 
the scanned pictures will bear a watermark. If you buy a license, you 
can unlock the installation at any time—there’s no need to reinstall the 
program.*
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Input Information - 
VueScan permanently 

displays the source 

of data input in the 

bottom line of the GUI 

8 1 VueScan – Look and Feel

Program Version - Shows the current 

program version of Vuescan 

Menu Bar - The menu bar off ers some 

exclusive options that are not available via 

tab section 

Option Tabs - This is the main control 

center of VueScan; here you can handle all 

data input, datan output and processing 

options 

Graph display - Here you can check the 

graph, curves, and image histogram of 

the current scan 

Preview/Scan Panel - Here 

you switch between Preview 

and Scan forecast 
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91.2 Compatibility and license issues

Buttons - The buttons speed up 

frequent tasks 

Output Information - 
Absolute pixels, relative 

pixels, image dimensions 

and output fi le size are 

displayed here 

Vue_book_large.indb   9 13.04.2011   19:41:14



10 1 VueScan – Look and Feel

* The sheer number of confi guration 
options in VueScan can drive begin-
ners to desperation, which is prob-
ably why diff erent user modes were 
introduced some years ago. You can
switch between them with the but-
tons at the lower left of the VueScan 
window.  
.

1.3 VueScan GUI 

Th e user interface of VueScan can be perceived either as very user 
friendly or as extremely confusing. Th is depends not only on the set-
tings you make, but also on your degree of familiarity with the soft ware. 
Th e main concept behind VueScan is simple and easy to understand. 
VueScan is pure scanning soft ware: it helps you convert analog images 
into digital image fi les. VueScan focuses mainly on scanning; for image 
post-processing, you need image editing soft ware like Photoshop. Some 
basic image editing options, e.g., unsharp masking, are available in the 
GUI of VueScan as well.*

Guide me – Beginner’s mode 

Th e easiest option for beginners is the (Guide_me) mode. Here the pro-
gram will lead you step-by-step through the diff erent scanning options. 
For example, if you want to scan a slide, the soft ware will propose the 
following settings that you can change if you want:  Input  ▶  Task  ▶ 
Scan to fi le,  Input  ▶  Media  ▶ Slide fi lm, Input  ▶  Quality  ▶ Archive, and  
Crop  ▶  Crop size  ▶ Manual. For every setting, there is short explanatory 
text that provides the necessary information. You cannot choose a fi le 
type; the scan will be saved as a JPEG. All in all, (Guide_me) mode is a 
nice door opener for your fi rst steps in scanning. Sooner or later, when 
you need more control over the confi guration settings, you will want 
to switch over to (Advanced) mode. Th ere are actually two advanced 
modes to choose from, (More)and (Less).

Advanced/Less – Extended mode 

Th e (Advanced) mode can be overwhelming when you fi rst switch into 
it, as there are so many diff erent options. You can reduce the display to 
the most common options by pressing the (Less) button. Th is mode 
is convenient if you want to combine good confi guration control with 
an easily manageable interface. To display all of the options, you must 
switch over to (More). 

Advanced/More – Full display of all options 

You can display VueScan’s full range of options in (Advanced) mode only 
when you select the option (More). And this can be quite a lot, as you 
will see if you take a quick look at the  Prefs  tab! Even a 24-inch screen 
is too small to display all of the options without scrolling. But once you 
are familiar with the soft ware, you can work easily with it. When you’re 
scanning negatives and slides, this mode is recommended as it is the 
only mode where all fi lter options are displayed. For example, the  Filter  
▶  Grain reduction  is found only in this mode. (Advanced) mode with 
(More) is simply the best choice for experienced users. Once you are 
familiar with VueScan, you should use it. 
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111.3 VueScan GUI 

The variety of options in advanced mode can be confusing for the beginner. Start with (Guide_me) fi rst, and after you are familiar with 

that, switch over to (Advanced) mode. (Advanced) has the options [Less] and [More].
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12 1 VueScan – Look and Feel

1.4 Dependencies – Automatic GUI changes 

Th e concept behind VueScan is built upon pure logic. In contrast to oth-
er programs, VueScan is not a patchwork that grew over time; instead, 
it was created as a whole. It has a very lean design. Th ere are no popups, 
just a single window that includes the whole functionality. Th e price you 
have to pay for this is an interface that changes dynamically according to 
your settings. For beginners who are not familiar with the soft ware, this 
can be quite confusing. You can waste a lot of time searching for an op-
tion that magically seems to have disappeared—and when you give up 
searching, it may pop up again in the same mysterious manner. 

But this happens for a good reason: Th e key principle behind the user 
interface is that options are only displayed when they do something 
useful.  For instance, if you’re scanning fi lm, you won’t see any options 
about descreening, and if you’re scanning documents, you won’t see any 
options about color balance.  

Dependencies are the key factor

In fact, the VueScan concept is an extremely smart way to design a soft -
ware interface. You just need to know how it works. Th e secret behind 
it is dependencies! Th is has nothing to do with the previously discussed 
user modes— (Guide_me) and (Advanced). Th e options you can choose 
from the graphical user interface (GUI) depend on your settings, and 
in most cases the GUI changes according to the diff erent tasks you se-
lect. For example, go to  Input  tab and change  Task  ▶ Scan to fi le to Task  
▶ Make IT8 target. You will see that the GUI fl ips and a lot of options 
disappear. Th is GUI change is a smart feature, as it keeps the GUI lean. 
It displays only the options that are useful for a certain task. 

Frequent GUI changes

Even if you stay within a task, GUI changes may occur. For example, go 
to  Input tab  and set  Task  ▶ Scan to fi le. By default, there will be a  Qual-
ity  option  (between  Media  and  Bits per pixel ). If you go below to  Scan 
resolution , you will see that it is set to  Scan resolution  ▶ Auto. Change 
Scan resolution  ▶ Auto to any scan resolution in the dropdown list, e.g., 
2000 dpi. You can see that the  Quality  button disappears immediately. 
As a matter of fact, there are GUI changes every time you switch back 
and forth in  Scan resolution  between Custom, Auto, and specifi c resolu-
tion settings (e.g., 2000 dpi, but the numbers in the list depend on the 
scanner model). 

To sum up: if you are searching for a specifi c option that seems to 
be missing in the soft ware GUI, fi rst check what  Task  you have set in  
Input   tab. If that does not help, check the other chosen options as well. 
Aft er doing a couple of scans in VueScan, you will soon be familiar with 
the concept. *

* If you want to get familiar with 
the interface of VueScan there is 
only way way to success: Use the 
software frequently and scan as 
many analog originals as you can. 
Once you understood the concept, 
the program is actually quite easy 
to handle. Despite its rich variety of 
options.
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If you change  Input  ▶  Scan resolution  manually,  the option  Input  ▶  Quality  will disappear as if by magic. It will reappear only if you 

reset the  Input  ▶  Scan resolution  to Auto. 

The graphical user interface of VueScan can vary a lot depending on your individual settings. Per default the option  Input  ▶  Quality  is 

visible and  Input  ▶  Scan resolution  is set to Auto as you can see in the screenshot above. 

131.4 Dependencies – Automatic GUI changes 
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You can load, save and reset all options in VueScan easily. It is recommendable to save *.ini fi les for the most common scantasks; this will 

speed up you workfl ow remarkably. 

14 1 VueScan – Look and Feel

1.5 Saving and restoring options 

As previously described, it can be cumbersome to confi gure VueScan 
for your personal needs. It takes a lot of time to readjust the soft ware, 
especially when you are scanning diff erent templates. But VueScan pro-
vides a solution: you can save and load options quite conveniently. For 
example, if you scan negatives, slides, and paper documents, you can 
save each setting and simply load the correct option as needed. Confi g-
ure VueScan according to your settings and save the settings separately 
for each template as an *.ini-fi le via File ▶ Save options. Be sure to name 
the fi les in a comprehensible way, e.g., negative.ini, slide.ini, and paper-
document.ini. You can save the fi les anywhere on your computer, but 
the best choice is the VueScan folder. For Windows computers, this is 
usually C:\VueScan. Th en you can load the settings by pressing (F10). In 
addition, all your *.ini fi les can be quickly loaded with one of the func-
tion keys—just save your options in the same folder as the vuescan.ini 
and the next time you start VueScan you’ll see them in the File menu. 

Reset to default values

If you get lost during customization, you might want to restore the origi-
nal setup. By pressing File ▶ Default options, you can reset the program 
completely and start from scratch. But be aware that this will reset all 
your color management options as well.  
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2
Contents

Download and setup
Color management in a nutshell
Defi ning monitor color space
Scanner profi ling for positives 
Desired vs. actual colors after scanner profi ling 
Printer profi ling for true color output 

Initial Setup 
Th e initial setup of scanning programs does not always get the 
attention it deserves. Many users just start scanning, and in 
many cases, less than optimal procedures produce less than 
optimal results. Th ere is a better way: a proper one-time ini-
tial setup of VueScan and its parameters. It only takes a couple 
of minutes, and this small investment will defi nitely pay off  
in better scans. Th is chapter tells you what to do and what to 
avoid. 
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16 2 Initial setup

2.1 Download and setup

The fi rst step in installing VueScan is to download it. You can down-
load the trial version at any time from www.hamrick.com. You’ll be 

presented with a (Download) button. Click it and follow the instructions 
next to this button. VueScan has both x32 (32-bit) and x64 (64-bit) ver-
sions on Windows, Mac OS X, and Linux. In most cases, you only need 
to click on the (Download) button and this will download the most ap-
propriate version for your system. Th e web page detects the type of op-
erating system you’re using and whether it’s a 32-bit or 64-bit operating 
system. Th e advantage of the x64 version is that it’s faster, because the 
x64 programming model gives more processor registers and can process 
data in 64-bit chunks. However, some manufacturers don’t provide 64-
bit plugins—that’s why you need to consult the Supported Scanners list 
on www.hamrick.com. 

On Mac OS X, some older scanners need to use Rosetta with the x32 
version because they only have PowerPC plugins—the Supported Scan-
ner list will mention this if it’s necessary. Th ese include most scanners 
from Refl ecta, PIE, Plustek, some older Canon scanners. 

Aft er the installation is fi nished, the fi rst action is to start the pro-
gram and to check if all scanners attached to you computer are available. 
If everything is up and running, this usually is given. Minor problems 
can occur if you started VueScan fi rst and switched on the scanner aft er. 
In this case just restart VueScan, this will solve the problem.

In general it is wise to start VueScan aft er (!) switching the scanners 
on. Please keep in mind that the computer may need a few seconds to 
recognize the scanner. If this does not help, check the Device Manager. 
Th e scanners are listed in Imaging Devices on Windows. In case they 
are missing, install the original manufacturer’s driver and/or soft ware 
again, this will fi x the problem. Th ere is usually detailed scanner driver 
installation information in the VueScan Supported Scanners list. Once 
the scanners appear in the dropdown menu of  Input  ▶  Source , you are 
ready to start. By default,  Input  ▶  Task  is set to Scan to fi le, the basic 
scanning operation. 

Input Task What does it do?
Scan to fi le Outputs an image fi le to the hard disk; this is 

basic scanning
Copy to printer Sends image data directly to the printer - or 

better said the printer driver - without saving 
it on hard disk

Profi le scanner Creates a profi le for the scanner
Profi le printer Creates a profi le for the printer
Profi le fi lm Creates a profi le for a specifi c fi lm
Make IT8 target Prints out an IT8 target for printer profi ling

Input tab dependencies
The chosen  Input  option controls 
the subsequent tabs. The profi ling 
options deserve a closer look, as any 
scanning system will benefi t from 
profi ling. Profi ling ensures consis-
tent color reproduction and is part 
of the basic setup. It should be done 
before the fi rst scan. Please be aware 
that profi ling is only supported in 
the Professional edition, not in the 
Standard edition.
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172.1 Download and setup

VueScan off ers a wide range of Input options in its interface.  Task  ▶  Copy to printer  is very convenient when you use your scanner as a 

copier. VueScan will not store the scan, but send it immediately to the printer. Then your scanner works just like any copier. 

You can either reset the default state for the complete program (1) or for each tab (2) individually. The option in the tabs only shows up, if 

you have changed the default confi guration of this tab already.  

1

2
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18 2 Initial setup

2.2 Color management in a nutshell 

A basic problem in digital image processing is that there is no absolute 
color defi nition across the entire workfl ow. In an ideal world, it would 
be possible to scan the color of the original accurately, display the scan 
on the monitor, and print it in true colors. Unfortunately, the current 
workfl ow cannot do that. Th e various links in the chain of digital pro-
cesses each represent colors in diff erent ways. 

Th e most common term in color management is “color space”. A 
color space describes a range of colors. Th e most popular color spaces 
nowadays are sRGB and Adobe RGB. Th e main diff erence between color 
spaces is the gamut. Th e gamut of sRGB is smaller than Adobe RGB. In 
general, a bigger gamut is better. You can display more colors with a big-
ger gamut, and clipped images are less likely to occur than with a smaller 
gamut. Th ere is only one problem with a bigger gamut: most devices are 
unable to display its colors! Th e gamut of a good DSLR is much bigger 
than the gamut of the best monitor you can probably aff ord. It can cap-
ture even more colors than a top-notch inkjet printer can display. 

Most modern color spaces are designed for a monitor gamma of 2.2. 
In the old days, Apple promoted a gamma of 1.8, but this is history. By 
default, Mac OS now works with gamma 2.2 like any Windows system. 
But color spaces with a gamma of 1.8, e.g., ECI RGB and ProPhoto RGB, 
still remain popular. 

Every hardware device has its own device-dependent color space. 
Th e devices of a standard scanning workfl ow are the scanner itself, the 
monitor, and the printer. Th e scan program and image editor are part 
of the workfl ow as well. Each hardware device displays a diff erent range 
of colors. In VueScan, the internal color space of the scanner is called 
Scanner RGB. Th is describes the colors that a specifi c scanner can read. 
Th e gamut of Scanner RGB is diff erent with diff erent scanners; it is not 
standardized. Neither a monitor nor a printer can display the colors of 
Scanner RGB. Th ere is an unmanageable variety of devices and device-
dependent color spaces. 

Device-independent color spaces allow consistent data exchange 
among applications, e.g., between your scan application and image edi-
tor. Th e image editor (like Photoshop) works internally with a standard-
ized device-independent color space, e.g., sRGB or Adobe RGB. Th at 
means you have to convert the device-specifi c Scanner RGB into a de-
vice-independent color space to enable a consistent workfl ow. 

Th e RAW fi le of VueScan is never (!) transformed into any color 
space. But you can confi gure a color space in  Color  ▶  Output color 
space  for your JPEGs and TIFFs. Th is is where you defi ne the color 
spaces of the output fi les and convert the device-dependent color space 
of your RAW scans into a device-independent color space like sRGB or 
Adobe RGB. 

Th e default setting of  Color  ▶  Output color space  is sRGB. Th is is 
the smallest device-independent color space, and there are many ad-
vantages if you stick with it. First of all, nearly every device can cover it. 

Horseshoe chart and color spaces 
A common way to visualize diff erent 
color spaces is the so called horse-
shoe charts. The horseshoe symbol-
izes all colors and the triangle is the 
part of it that a certain color space 
is able to display. Just compare the 
horseshoe chart of sRGB with the 
chart for Adobe RGB. You will see 
that the triangle for sRGB is much 
smaller, as sRGB can display fewer 
colors than Adobe RGB.

sRGB has the smallest gamut of all 

popular color spaces.
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Adobe RGB has a much bigger gamut 

than sRGB.
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192.2 Color management in a nutshell 

Even standard monitors nowadays can display sRGB, and printers cover 
the gamut of sRGB as well. Most image editors and image viewers run, 
at least by default, in sRGB mode. Th us you achieve maximum compat-
ibility. sRGB images look nice even when displayed on standard hard-
ware like mobile phones or when viewed over the Internet via a browser.

But from the technical point of view, sRGB is nothing more than the 
lowest common denominator. Yes, it is convenient, but most devices can 
display a wider range of colors than sRGB has to off er. If you own a top-
notch monitor that is designed to display high-quality photography, it 
can display larger color spaces than sRGB. sRGB is obsolete in this cat-
egory, as a good monitor can display the full color space of Adobe RGB 
with ease. If you run a high-end monitor like this with sRGB, it’s like 
fueling a Jaguar with a two-stroke mixture. A good printer covers more 
than sRGB as well, which is why Adobe RGB and not sRGB is preferred 
in the prepress industry. 

In theory, a bigger gamut is always better. You can display more col-
ors, and image editing will less likely lead to clipping than with a small 
gamut. But if you own a good monitor and a good printer and switch 
from sRGB to Adobe RGB, you will also face the downside of the bigger 
gamut. Sure, your pictures on your own super screen and your prints 
from your own printer will look awesome. But if you give your scanned 
images to a photographic laboratory, the resulting prints may look quite 
dull if the lab works with sRGB. Th e fact that Adobe RGB is widely dis-
tributed in the prepress industry does not guarantee that every company 
printing pictures actually uses Adobe RGB! 

Similarly, the pictures that look perfectly colored and rich in contrast 
on your own super screen with Adobe RGB can look quite shabby on 
the laptop of your neighbor who only has sRGB. You can experience 
the same eff ect if you open those pictures on your own computer with 
an application that does not support color management, like some sim-
ple image editors. Color management in Internet browsers is still in its 
fl edgling stages. You can’t blame Adobe RGB for any of these eff ects, but 
the limitations of many devices out there can cause trouble when you 
work with any color space bigger than sRGB. 

Th ere are workarounds, like working with a wider gamut color space 
internally (e.g., ProPhoto is much wider than even Adobe RGB) and 
still using sRGB for the fi nal image output. All in all, using wider color 
spaces requires time, attention, and expert knowledge of the current 
technology. Th e wider the color space, the better the potential image 
quality—but also the bigger the potential problems, especially when us-
ing the pictures for the Internet. Th ere is a bon mot that hits the nail 
on the head: use Adobe RGB or any other big gamut color space only if 
you know exactly what you are doing! If you have to ask, you are better 
off  using sRGB.  Th e most common alternative to sRGB is Adobe RGB, 
which has a bigger tonal range and is widely distributed. Plus, you can 
display Adobe RGB on your monitor—if you own a very good one. ECI 
RGB and ProPhoto RGB are even bigger than Adobe RGB; choose them 
for maximum image quality, but compatibility will defi nitely be an issue. 

Controlling gamut in VueScan 
You can use the  Color  ▶  Pixel col-
ors  option to show if any colors are 
outside the range (gamut) of the 
selected color space.   If you’re scan-
ning pictures of ordinary scenes, you 
might be surprised to see that sRGB 
works fi ne with the images you’re 
scanning.  By default, the pixels that 
are outside the gamut of the color 
space will be displayed by VueScan 
in cyan (light blue).  
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20 2 Initial setup

sRGB is a widely distributed color space, but it has one major disadvantage. Its gamut is very limited. Large parts of this Kodachrome scan 

are out of gamut as you can see by the cyan marking.

Device RGB is the color space of the scanner, in this case a Nikon Coolscan 5000 fi lm scanner. Here you will have no colors that 

are out of gamut, because the the color space of the scanner covers all colors the scanning process delivers.
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The extremely large gamut of ProPhoto RGB can cover the full gamut of the original scan.  As you can see there is no out of gamut color 

here. Ekta Space will lead to the same result.

Adobe RGB has a bigger gamut than sRGB, but still it can not cover the full gamut of the scanner. At least you reduce the loss of image 

information compared to the sRGB setting.

212.2 Color management in a nutshell 
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22 2 Initial setup

2.3 Defi ning monitor color space

Without a calibrated monitor, image editing can be almost impossible. 
It can be diffi  cult to judge whether you are trying to correct a fl aw in 
the image fi le or whether you are being misled by an erroneous moni-
tor display. Th ere are various hardware and soft ware tools for monitor 
calibration. Hardware-based tools consist of a measuring device and 
special soft ware. In the case of soft ware tools, the human eye serves as 
the measuring device. 

Sofware vs. hardware calibration

Truly accurate results are only possible with a hardware tool. Such a 
tool measures screen colors, compares them with nominal values, and 
calculates the ICC profi le from the diff erences. For consistent quality, 
calibration and profi ling should be repeated monthly. Soft ware solu-
tions rely on your eye. Th eir calibration methods are far less accurate 
than hardware calibration methods, since the color adaptation of eye 
and brain depends on ambient lighting conditions. Color and contrast 
adjustments are done directly on the monitor’s controls without gener-
ating an ICC profi le. If you don’t want to spend the money for a hard-
ware-based calibration tool, you can at least improve some settings with 
a soft ware tool. 

Monitor color space

Th e monitor color space defi nes how your monitor displays colors in the 
VueScan window. Please be aware that this setting does not aff ect the 
image display in other applications. You defi ne it in  Color  ▶  Monitor 
color space . VueScan off ers a row of options ranging from individual 
ICC profi les to device-independent color spaces like sRGB, Adobe RGB, 
Prophoto RGB, and ECI RGB. sRGB is acceptable as a default setting in 
case you have no profi le for your monitor. But in general, you should 
avoid device-independent color spaces here. Since a monitor is a hard-
ware device with a device-dependent color space, it will not benefi t 
from device-independent color spaces. You need a specifi c ICC profi le 
for optimum results. 

Th e best practice is to use a colorimeter (e.g., Gretag Macbeth, La-
Cie, or Datacolor) to measure your screen individually. You will have 
to tell the profi ling soft ware the color temperature of your screen (e.g., 
6500° Kelvin) and the gamma of your color space (usually 2.2). You may 
be able to download an ICC profi le for your monitor model from the 
manufacturer’s homepage. Th is kind of service is sometimes supplied 
for more expensive monitors. However, the better alternative is an in-
dividually created ICC profi le. Th e colorimeter will measure the color 
display exactly, and you can use this information to create an ICC profi le 
that aligns current values with desired values. Occasionally you should 
create a new monitor profi le; the color display may change over time.
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This is a scan by a Nikon Coolscan 5000 scanner that has not been profi led, yet. The green 

color cast is clearly visible, overall the color reproduction is far from being accurate. An ICC 

profi le is needed to improve scanning quality.

This is another scan with the same Nikon Coolscan 5000, but this time it has been profi led 

with an IT8 slide and VueScan. Now the colors are much more neutral; overall the scan 

quality has improved. 

232.3 Defi ning monitor color space
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24 2 Initial setup

Buying IT8 targets 
On the german website of Wolf 
Faust (www.targets.coloraid.de), 
Kodak (www.kodak.com), Hutch 
(www.hutchcolor.com), Fujifi lm 
(www.fujifi lm.com), and SilverFast 
(www.silverfast.com) you will fi nd 
lots of information about IT8 tar-
gets. All these companies manufac-
ture targets for calibration. 

2.4 Scanner profi ling for positives 

Th e scanner is the most important device in the scanning process. With 
profi ling, you can improve accuracy of color reproduction under certain 
conditions. First of all, the procedure is designed for positive originals 
exclusively. It will help you in scanning prints or slides, both black-and-
white and color. For negatives, scanner profi ling will not have the de-
sired eff ect. 

For scanner profi ling, you will need VueScan Professional Edition 
and an IT8 target—more precisely, one IT8 refl ective target (IT8 print) 
and one IT8 transmissive target (IT8 slide). Th ese are standardized tar-
gets that will help you align the scanner’s color reproduction to the de-
sired standard. 
1. Insert the IT8 target in the scanner tray. 
2. Set  Input  ▶  Task  ▶ Profi le scanner. 
3. Press (Preview). 
4. Rotate the image if needed. If it needs mirroring, fl ip the original and 

perform (Preview) again. 
5. Adjust the crop manually until the VueScan grid matches the color 

fi elds of the target. 
6. If the target is skewed, align it properly on the tray and repeat 

(Preview). Do not (!) use the skewing option of  Input  tab. 
7. Go to  Color  ▶  Scanner IT8 data and tell VueScan where it can fi nd 

the IT8 description fi le on your hard disk. Th is fi le is usually shipped 
with the target and should be saved in the VueScan folder for con-
venience. IT8 data can have the fi le extensions *.it8, *.q60 or *.txt. 

8. If you have no IT8 description fi le, get one! Th e correct fi le is crucial 
for the profi ling process. Zoom into (Preview); at the bottom edge, 
you will see a number (e.g., E070409) that you can use to google a 
matching IT8 fi le, or you can directly check the manufacturer’s web-
site for it. 

9. Set Color  ▶  Scanner color space  ▶  ICC profi le . By default, the pro-
fi le is called scanner.icc. Rename it if you use more than one scanner 
(e.g., canoscan8800F.icc) and store it in the VueScan folder for conve-
nience. Th is will help you to align a scanner and its profi le properly 
even if you’re using several scanners at the same time.

10. Go to the menu and execute Profi le ▶ Profi le scanner. Th is will create 
the profi le fi le and store it at the chosen folder with the appropriate 
name. 

Th at’s it—the scanner profi ling process is complete. VueScan will auto-
matically switch among profi les when you are using diff erent scanners. 
It even notices the diff erence between refl ectives and transparencies. 
You will need to profi le your scanners for refl ectives and transparencies 
separately. If you want to further fi ne tune the profi les, there are diff er-
ent targets not only for diff erent fi lm brands (Kodak, Fuji) but also for 
diff erent fi lm types (Kodak Ektachrome, Kodachrome, Fuji Velvia, Fuji 
Sensia, etc.). But owning a row of targets for all possible circumstances 
is an expensive aff air. 
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For the creation of a quality monitor profi le you need a colorimeter. At a later stage, you can embed the created profi le in VueScan.

You will not need a colorimeter for the 

creation of a printer profi le. VueScan will use 

any fl atbed scanner for this task.
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252.4 Scanner profi ling for positives
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26 2 Initial setup

2.5  Desired vs. actual colors: Scanner profi ling 

IT8 has its limits; it is not a universal cure. It shows the desired eff ect 
only with good scanners. Cheap scanners with trashy color reproduc-
tion do not profi t from profi ling, since colors will still mismatch due to 
hardware limitations. Even with a good scanner, an expensive IT8 tar-
get, and proper profi ling, the colors will not be as perfect as you might 
expect—especially if you are used to the quality standards of modern 
digital photography. Scanning is an analog-to-digital conversion with 
all of the inherent restrictions. To demonstrate this, check the desired 
and the actual colors aft er profi ling. Th e example below refers to a Nikon 
Coolscan 5000, one of the best desktop fi lm scanners: 
1. Set  Input  ▶  Task  ▶ Make IT8 target. 
2. Press (Preview) button. 
3. Move your mouse over the white rectangle in the lower left  corner. 
4. Th e status information in the VueScan footer will show Output: 255 

255 255. Th ese are the RGB values for this fi eld; it is pure white with 
no color cast. Th e three color channels are perfectly balanced, and 
the values for each color channel are the same even when you move 
the mouse back and forth within the fi eld. Th is is how it should be, 
and this is the desired eff ect of scanner profi ling. Now compare this 
with the actual eff ect of profi ling. For the subsequent workfl ow, it is 
mandatory that the scanner has already been profi led. 

5. Insert your IT8 target and press (Preview) to scan the original. Th en 
set  Input  ▶  Task  to Scan to fi le. 

6. Move the mouse over the white rectangle. Th e RGB values will 
change between diff erent parts of the rectangle. Almost every pixel 
will have a diff erent RGB value. For a profi led Nikon Coolscan 5000, 
the range on the slide can be between 255/255/246 and 245/250/234. 

Compare these values with the targeted values of 255/255/255 from 
above. Almost every pixel has a diff erent color, but this is not too sur-
prising. Film surface is never consistently colored due to fi lm grain. An-
other fact is far more signifi cant: the color channels are not balanced! 
Th ey should have all the same values; instead, the red, green, and blue 
channels vary signifi cantly, even aft er scanner profi ling! 

Before and after profi ling

While this may sound disturbing at fi rst, a look at the unprofi led image 
will nevertheless show the benefi ts of profi ling. Switch  Color  ▶   Scanner 
color space  to Built-in for the eff ect. You will see that the color channels 
are even more disparate, with RGB values e.g. of 252/242/232. So the 
range between the color channels is remarkably bigger than those aft er 
scanner profi ling. Th e overall image impression is that the Built-in pro-
fi le results in images with a visible color cast. Th e image with the custom 
profi le looks more neutral, even though it is far from perfect. All in all, 
scanner profi ling visibly improves the image and is worth the eff ort. For 
color slides it is a must, for refl ectives it is recommended as well. 
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Use the option  Task  ▶  Make IT8 target  to create an IT8 reference image for printer calibration. As a nice side eff ect you have a test 

picture that helps you to estimate the eff ect of diff erent color management settings easily on your screen.

For the scanner calibration you need an IT8 target. VueScan will compare the color values of the raw scan fi le of this target with a reference 

fi le to correct color deviance.  Then VueScan can create an ICC profi le.

272.5 Desired vs. actual colors: Scanner profi ling 
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28 2 Initial setup

2.6 Printer profi ling for true color output 

While scanner profi ling is complex, it is nothing compared to printer 
profi ling. Th e quality of a printed image depends on a variety of factors 
such as the image fi le itself, its color space, the printer driver, the printer 
model, the paper brand, and the ink, to name a few. If you are printing 
from VueScan, however, you can implement a printer profi le with little 
eff ort. Just be aware that every time you change paper or ink, you should 
create a new profi le. Actually it is not a printer profi le, but a profi le for 
printer model + specifi c paper + specifi c ink! 

Before you profi le your printer, you must profi le your scanner. Th is 
is mandatory, as you will need the scanner profi le to create the printer 
profi le. 
1. Set  Input  ▶  Task  ▶ Make IT8 target. Th is will read out the image data 

of an IT8 target fi le. 
2. Press (Scan). Th is will open the print dialogue. 
3. Print the image with your printer. Do not touch any color manage-

ment options on the printer driver—neither now nor later! 
4. Take the print of the IT8 image out of the printer and put it into the 

scanner. 
5. Set  Input  ▶  Task  ▶ Profi le printer.
6. Press (Preview) and adjust the the grid to the image (same proce-

dure as scanner calibration). 
7. Rotate the image if needed to align it to the grid. If it is skewed, read-

just the print in the scan tray and repeat the (Preview). Do not use 
the skewing option in  Input  tab. 

8. Defi ne the desired output path and fi le name of the ICC profi le in
 Color  ▶  Printer ICC profi le. Th ere is no need to specify the IT8 de-
scription fi le at this time; VueScan will do this automatically. 

9. Replace the default name (printer.icc) with a more informative one 
that contains the codes for your printer model, paper, and ink (like 
HP-H470WBT_C7040A_C9369E.icc). If you always use the same 
printer model with the same paper and the same ink, you can simply 
keep the default name. 

10. Execute Profi le ▶ Profi le printer from the menu. Th is will write the 
new ICC profi le to the hard disk. 

Color management in practice 

Color management is a hype thing. Once it was a topic for publish-
ing houses exclusively; now everybody can buy IT8 targets and 
calibration devices for comparatively little money. Keep in mind 
that profi ling is just one of many steps on the way to a good scan. 
You will still have to do a lot of manual post-processing. Let’s get 
things into perspective: if you have no IT8 targets on hand, down-
loading scanner profi les from the Internet is a feasible alternative 
and not a reason to postpone your scanning project.
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292.6 Printer profi ling for true color output 

Film profi ling for color negatives 

Th e ability to create fi lm profi les with little eff ort is a remarkable feature 
of VueScan. Th is is not (!) an option for vintage fi lms, as you would need 
to take a picture of an IT8 target with the fi lm you want to profi le. Th e 
method works only for fresh rolls of fi lm that are still in your camera. 
If you are still shooting fi lm, fi lm profi ling comes in handy. It’s a good 
way to achieve true colors with notoriously diffi  cult color negative fi lms. 
Profi le your scanner before you start creating your fi lm profi le.
1. Take a picture of an IT8 target. Th is can be a refl ective or even better 

a slide. For a picture of a 35mm slide, you will need a slide duplicator. 
For a 81/2" x 11" IT8 refl ective, any standard zoom lens will do the job. 
Ensure that your camera is aligned at a right angle to the target to 
avoid perspective distortion. Use a lens with minimal distortion that 
will retain the proportions of the original, like a 50 mm lens. 

2. Develop the fi lm and get the negatives. 
3. Set  Input  ▶  Task  ▶ Profi le fi lm and  Media  to color negative.  
4. Insert the negative or slide with the IT8 picture in the scanner and 

press the (Preview) button. 
5. Rotate the image if needed according to the grid. Avoid skewing via 

the  Input  tab; reposition the original instead and repeat (Preview). 
6. Adjust the crop size and align it to the fi elds of the IT8 image. 
7. Get the IT8 description fi le for the IT8 target (compare scanner pro-

fi ling) and copy it into the VueScan folder. Rename it to fi lm.it8. (You 
can give it a diff erent name, but fi rst you must reconfi gure the name 
in  Color  ▶  Film IT8 data). 

8. If you execute Profi le ▶ Profi le fi lm from the drop down menu (!), 
VueScan creates the fi le fi lm.icc and saves it to the same location as 
vuescan.ini (usually c:\VueScan). You can use a more reasonable 
name (e.g., Kodak_Gold400.icc) if you reconfi gure Color  ▶  Film ICC 
profi le  accordingly. Alternatively, use Color  ▶  Film ICC description . 

9. Since fi lm changes over time, a fresh roll of a specifi c fi lm will not 
have the same colors as the same fi lm that was developed 10 years 
ago. Th at is the reason why fi lm profi les are a big help but not a uni-
versal cure for the problems of converting color negatives.

Embedding existing ICC profi les 

You can skip the entire time consuming profi ling process if you have 
ICC profi les already. Just save the existing profi les on your hard disk and 
confi gure the options  Color  ▶  Scanner ICC Profi le ,  Color  ▶   Printer 
ICC profi le , and  Color  ▶  Film ICC profi le  accordingly. In general it is 
recommended to renew profi les from time to time. But most modern 
scanners have LED lamps instead of the old fashioned fl uorescent lamps 
now. And LEDs age less that fl uorescent lamps. Th at means, you can use 
a scanner profi le for a longer period of time. Th ere is actually no need to 
create new scanner profi les every month or so like it was recommended 
in earlier times.
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30 2 Initial setup

Color Space Gamma Color temperature Remarks
Adobe RGB 2.2 6500 Kelvin Widely distributed color space, good alternative to 

sRGB since 1998
Apple RGB 1.8 6500 Kelvin Default setting of old Apple computers
Bruce RGB 2.2 6500 Kelvin Small output-oriented color space from 1997
CIE RGB -- -- Vintage color space, even older than NTSC
Colormatch RGB 1.8 5000 Kelvin Similar to Apple RGB, but diff erent color 

temperature
NTSC (1953) 2.2 -- Standard for analog TV in USA
PAL/SECAM 2.8 -- Standard for analog TV in Europe
SMPTE-C 2.2 6500 Kelvin Successor of NTSC
sRGB 2.2 6500 Kelvin Default setting for Windows computers
Wide Gamut RGB 2.2 5000 Kelvin Second biggest color space, a further development 

but not a replacement for Adobe RGB
Ekta Space 2.2 5000 Kelvin Covers (almost) the range of E6 slides
ProPhoto RGB 1.8 5000 Kelvin Biggest color range at the moment, even bigger 

than Wide Gamut RGB
ECI RGB 1.8 5000 Kelvin Big color space, popular for prepress

sRGB has a comparable small gamut. Most devices like scanners, 

printers and monitors can display sRGB completely. 

ProPhoto RGB has an extremely big gamut. There are very few if 

any devices available that can display ProPhoto RGB completely. 
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Talking about resolution: SPI, DPI, PPI, and absolute pixels  
SPI: Adjusting sampling quality
DPI: Output size in print
PPI: Output size on screen 
Relative output size does not matter: 300 dpi vs. 72 dpi

Resolution and Scanning
For a beginner, scanning can be quite confusing, as there are 
some technical terms involved. Th is is true even if you are an 
experienced digital photographer, as some things in the world 
of scanning simply work in a diff erent way. Don’t misunder-
stand me: if you want a quick scan, e.g., if you’re using the 
application as a photocopier, just press a button and that’s it. 
But if you have a more complex task at hand, e.g., if you’re 
archiving your vintage slide collection, that’s a completely 
diff erent story. Th en you should know the diff erences between 
terms such as spi (samples per inch), dpi (dots per inch), 
and ppi (pixels per inch). Th is chapter contains an overview 
of these basic scanning terms that will help you master the 
advanced features of VueScan with ease.  

Vue_book_large.indb   31 13.04.2011   19:41:21



32 3 Resolution and Scanning

3.1  Talking about resolution: 
SPI, DPI, PPI, and absolute pixels  

Let’s begin this chapter with the most basic and most discussed term 
in the world of scanning: resolution. Despite all the public attention 

that the topic of resolution gets, there is unfortunately no such thing as 
“the” resolution of the scanner and/or the scanned image. Resolutions 
vary depending on what step of the procedure you are actually perform-
ing, and mixing them up can cause misunderstandings. However, you 
can easily avoid any confusion by taking a closer look at the topic.  

Th e size of a digital image is alway defi ned by pixels. Th e pixel is the 
smallest component of any digital image. Pixel numbers are absolute 
values (e.g., a picture with a resolution of 1668 x 1790 pixels), but at 
the same time, pixels have limited information value. Th e reason is that 
diff erent devices—monitor, printer, scanner—display pixels at diff er-
ent sizes. Th at is the reason, in most cases, why absolute pixel numbers 
are set in relation to linear dimensions, like inches (e.g., 300 pixels per 
inch). Th ese relative values vary between diff erent devices. It makes a 
huge diff erence whether an image is displayed on a computer screen or 
printed out. 

3.2 SPI: Adjusting sampling quality 

Th e fi rst step in the scanning procedure is to put the item to be scanned 
into the scanner. Th en you adjust the scanner setting for scan resolu-
tion. In VueScan, you will fi nd the setting for scanning resolution on 
the Input tab. Scanning resolution is a relative value that you must set 
in relation to the size of the image. Th e measurement unit that VueScan 
uses here is dpi. Most scanning soft ware and even scanner manufactur-
ers use dpi in this context. Another common unit is ppi. 

SPI is the correct denomination

Th e correct unit, spi (samples per inch), is used much less frequent-
ly! From a technical point of view, spi is the most precise notation. Th e 
scanner will record samples from the image and generate pixels out of 
that. If it records 2000 samples (=pixels) per inch,  the relative scan-
ning resolution will be 2000 spi. Th e absolute pixel size of the scanned 
image will depend on the physical image size and scanning resolution.

Checking image size
You can check the absolute size of a 
digital image easily in Windows Ex-
plorer, or Mac OS X. Just right click on 
the image fi le and choose Properties 
in Windows or Get Info in Mac OS X. 
In the Details tab you will fi nd the 
absolute image dimensions. Since a 
digital image has two dimensions, 
you will see one pixel value for width 
and one value for height, e.g., 3008 
x 2000 pixels. You will fi nd informa-
tion about the relative image reso-
lution (e.g., 300 dpi) there as well. 
But information about the resulting 
output size from these parameters is 
missing. The image size information 
in Photoshop is better, because you 
can see that a digital image of 3008 
x 2000 pixels at 300 dpi will have an 
output size of 10.027” x 6.67”.

Example: General calculation of scan sizes 

You want to scan a 35mm slide that is 24 x 36 mm. Converted to 
inches, the size is 0.94" x 1.42" (rounded). With a scanning resolu-
tion of 2000 spi, the resulting fi le will be 1880 pixels (0.94" x 2000 
spi) by 2840 pixels (1.42" x 2000 spi).

Scanning resolution in VueScan
Adjust the resolution of the scanner 
in  Input  ▶  Scan resolution . Don’t 
look for any spi values in the GUI of 
the program. VueScan uses dpi as 
this is the common denomination. 
In this book I will use spi for scanning 
resolution, as this is the correct and 
more precise denomination. 
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333.3 DPI: Output size in print 

Determining the original size

Th us, the spi value can be used to determine the size of the scanned im-
age. If you choose a low resolution, you will get a relatively small digital 
image. If you choose a higher resolution, you will get a relatively large 
digital image. 

Selecting scanning resolution

Setting the correct scanning resolution is a crucial step. You cannot re-
scale a small scan later for a larger output size without a signifi cant loss 
in quality. You can, of course, rescale a large scan for a smaller output 
size. But all in all, you should keep in mind that a scan is not a vector 
graphic. Th e quality of a vector graphic remains constant at all sizes, but 
the same is not true for scans. Upsizing a scan always leads to a loss in 
quality, and downsizing can have negative eff ects as well. For example, 
when you downscale a large scan to a smaller output size, the grain ef-
fect may be amplifi ed. Due to this, the scanning resolution should match 
the desired output size. Th en you will not need subsequent rescaling and 
you will avoid possible negative eff ects.

Avoid interpolated resolution

In any case, VueScan will only allow scanning up to the optical resolu-
tion of the scanner.  Since it’s a waste of time to scan at higher than the 
scanner’s optical resolution, VueScan won’t do this even if you specify 
a custom resolution. Note also that some scanners can scan at a higher 
resolution in the stepper motor direction than in the CCD direction. 
Th is leads to manufacturer’s quoting resolutions of 2400 x 4800 dpi, 
when in reality the CCD only has enough pixels for 2400 dpi. One last 
trick manufacturers use is using a high-resolution CCD but low-quality 
optics. Th e optics of most fl atbed scanners are seldom good enough for 
more than 1200 to 2400 dpi, so any resolution higher than this is just a 
waste of storage space.

3.3 DPI: Output size in print 

When you fi nish making your scan, you will probably want to obtain a 
print of the digital image. Glossy photo prints usually require an inkjet 
printer as an output device. Inkjet technology generates images by pro-
pelling droplets of ink onto the paper, thus producing tiny dots on the 
surface. Th e image consists of these dots, and the resolution is displayed 
in dots per inch (dpi). 

To achieve suffi  cient quality for magazine or book reproduction, you 
will usually need a resolution of 300 dpi. If it is a higher resoltion it will 
not hurt, but it is not needed. Consequently, your scan will need a reso-
lution that matches the desired dpi output.  

Interpolated vs. optical vs. eff ec-
tive resolution 
Scanner manufacturers know that 
they can impress their custom-
ers with large resolution numbers. 
For the popular Canon CanoScan 
8800F, the interpolated resolution is 
19200 spi. That sounds impressive, 
but scanning with this resolution will 
just create an unnecessarily bloated 
monsterfi le with no gain in scan-
ning quality. The more interesting 
value is the optical resolution; for the 
CanoScan 8800F, this is 4800 spi. At 
this setting, the scanner will deliver 
its maximum resolution. Of course, 
there is still a wide gap between op-
tical resolution and eff ective resolu-
tion, as you can see for yourself with 
a USAF 1951 testchart. The eff ective 
resolution of the CanoScan 8800F is 
only 1600 spi. That’s the maximum 
you can get when scanning with the 
full optical resolution of 4800 spi. So 
for the best scanning quality, you 
should use optical resolution. 
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34 3 Resolution and Scanning

Printing smaller sizes is always possible, but if you exceed the maxi-
mum print size, you will get noticeably pixelized prints of inferior quali-
ty. Of course, you can enlarge your scanned images in Photoshop or with 
applications like PhotoZoom, but keep in mind that these programs have 
to interpolate the original image to blow it up to the new size. In general, 
interpolation is not ideal for the high picture quality, since interpolation 
algorithms only guess how a picture would look if it were larger. 

3.4 PPI: Output size on screen 

Th e most common way to view digital pictures is on a computer screen. 
Computer screens generate an image by displaying pixels. Accordingly, 
the resolution of a computer screen is indicated in pixels, and the rela-
tive resolution is indicated in pixels per inch (ppi). Common values for 
screen resolution are either 72 ppi (old screens) or 96 ppi (new screens), 
but neither is precise. Th ere is no such thing as a fi xed standard for 
screen resolution, so the actual ppi will vary. A screen that shows exactly 
96 ppi is more the exception than the rule, but in general it will be some-
where around that value. Th e relative resolution of an average monitor 
is roughly one third of the printing resolution. If you compare a 300 dpi 
printout with a 96 ppi screen display, you will discover that the picture 
on the screen is about three times larger than the printout.

Example: Determining maximum print size 

You have scanned a 35mm slide that is 24 x 36 mm at 2000 spi. 
Th e absolute size of the scan is 1880 x 2840 pixels. To determine 
the maximum possible print size, you need to know the relative 
resolution of the print. In this case it is 300 dpi, suffi  cient for maga-
zine print quality. 1880 pixels equal a print size of 6.27" (1880 pix-
els/300 dpi), and 2840 pixels equal a print size of 9.47". Th us the 
maximum print size for a scan of 1880 x 2840 pixels is 6.27" x 9.47, 
or 15.93 x 24.05 centimeters. 

Example: Determining output size on screen  

You have a scan with a size of 1880 x 2840 pixels. Let’s assume you 
have a screen resolution of 96 ppi. 1880 pixels equal a screen size of 
19.58" (1880 pixels/96 ppi), and 2840 pixels equal a screen size of 
29.58" (2840 pixels/96 ppi). Th e size on the screen is approximately 
three times larger than print size (300 dpi). Even though the scan 
in this example is from a relatively small 35 mm slide with only 
2000 spi, it will exceed the dimensions of almost every customary 
screen in the trade. Most scans cannot be displayed on screen in 
1:1 scale; they will be scaled down by the viewer application.  

Printing resolution in VueScan
Adjust the resolution of the print in
 Output  ▶  Printed size . Please keep 
in mind, that this confi guration will 
not change the absolute size of your 
image and that many output de-
vices will ignore it. For scanning pur-
pose you can just set it to scan size. 

Screen size in VueScan
You can and will have to adjust the 
screen size resolution exactly in the 
same way as the print resolution. 
That means you choose a setting 
that is either for print or for screen 
display, you cannot have both in 
one fi le. But there is little practical 
use for a dedicated screen setting 
as many programs like Photoshop 
ignore this anyway.
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The relative resolution of this scan is 2000 pixels/inch. You can reconfi gure it to any value you like (i.e. 300 dpi for print) and this will not 

aff ect the absolute image size of 2776 x 1860 pixel, unless you deliberately resample the image of course, but that is a diff erent story.

353.5 Relative output size does not matter: 300 dpi vs. 72 dpi

3.5  Relative output size does not matter: 
300 dpi vs. 72 dpi

Relative resolution is a measurement unit that determines the output 
size of an image and sets it in relation to an inch of the output or input 
medium. In fi le properties of Windows, this relative resolution is stored 
as additional information. It looks like “horizontal resolution 300 dpi, 
vertical resolution 300 dpi”. Th e relative resolution of an image fi le can 
be reset in image editing programs like Photoshop. Keep in mind that 
only the absolute resolution of the image determines its size (e.g., 2000 
x 3008 pixels), not its relative resolution (e.g., 300 dpi). If you change a 
300 dpi image fi le to a relative resolution of 72 dpi, it has no eff ect on the 
absolute image size or the pixel numbers. 

Th e image will be recalculated only if you select the option Resample 
Image in Photoshop. Resampling is OK if you have to shrink an image, 
e.g., for mailing it to a friend. Avoid sampling an image at a larger size 
than the original, as you will gain nothing. In general, if you scan for ar-
chival purposes, you should avoid resampling. For example, if you want 
to scan an average 35mm slide for archival purposes, do so at 2000 spi. It 
does not really matter whether the relative resolution of the scan is set to 
72, 300, or 2000 dpi in fi le properties. Th e only important value for pic-
ture quality is always the absolute number of pixels the fi le contains! Th e 
relative resolution value is ignored anyway for display in most viewer 
applications and for opening the image in Photoshop. 
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36 3 Resolution and Scanning

A print needs more pixels per inch than a monitor display. For a print you need at least 300 dpi, while 72 dpi (sometimes up to 96 dpi, 

depending on the monitor) is suffi  cient for the screen. Just compare the diff erence of these two resolutions in print.  

72 dpi

300 dpi
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RGB, grayscale, and infrared
TIFF - Lossless but capacious
JPEG - Compressing images 
PDF - Versatile document format 
RAW fi les - Storing internal scanner data 
DNG vs. RAW-TIFF

File Formats
VueScan off ers a wide variety of formats for fi le output. Actu-
ally it has more options than any other scan program on the 
market. As a user, you get to pick the best from many diff erent 
formats. Th is chapter shows you the pros and cons of every 
fi le format in detail. 
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38 4 File Formats

4.1  RGB, grayscale, and infrared  

VueScan’s output options can only process the source data that the 
scanner itself produces. Th us it makes sense to take a closer look 

at the operating mode of scanners in order to understand and classify 
the diff erent output options. Naturally, you have to be aware of the input 
side before you can discuss output options! Almost any scanner capable 
of full-color scanning has three diff erent color channels according to the 
RGB model, similar to typical digital cameras. Th e three color channels 
are R for red, G for green, and B for blue. Th e output fi le format of a scan 
can be confi gured in the  Output  tab. 

At this point, we are not (!) talking about output formats, but
exclusively about internal color channels. Th e color depths of these col-
or channels can indeed vary. Low-end scanners may still work internally 
with 8-bit color channels, but top-of-the-line scanners allow higher col-
or depths. Th ey may have 12-bit, 14-bit, or even 16-bit color channels. 
Th is is the internal data used by the scanner. But common output op-
tions for color scans are 8-bit or 16-bit only, e.g., as TIFF fi les. 

8/16-bit vs. 24/48-bit 

Unfortunately, there are no consistent naming conventions for color 
depth of image fi les, such as TIFFs. Sometimes people refer to the color 
depth of each color channel, like 8-bit or 16-bit; sometimes they refer to 
the combined color depth of all three channels in RGB mode. As there 
are three color channels, an 8-bit fi le (per channel) can be referred to as 
24-bit as well (3 x 8-bit). Similarly, 16-bit color channels are sometimes 
referred to as 48-bit (3 x 16-bit). Although the 8/16-bit is used more fre-
quently than the 24/48-bit, it really is a question of personal preference. 

Better scanners have an additional infrared channel that is quite use-
ful if you want to remove dust and scratches from slides or negatives. 
Th e information provided by the infrared channel is usually not visible 
to the user. As a matter of fact, most scanning programs on the market 
completely hide the infrared channel. Th ey use infrared data only for 
removing scratches internally and don’t usually store it. 

VueScan leaves this decision to the user. With VueScan, you can store 
the infrared data together with the RGB data in a 64-bit RGBI fi le. Here 
you have the three color channels (3 x 16-bit = 48-bit) of a common 
RGB fi le plus the infrared channel (1 x 16-bit), which together equals 
64-bit RGBI (48 + 16 = 64-bit). If you want, you can even save the out-
put of the infrared channel for experimental use as a 16-bit infrared fi le. 

Whatever you want to do with the scanner’s internal data, VueScan 
provides a rich variety of output options ranging from 1-bit black-and-
white to 64-bit RGBI. In particular, the diff erent grayscale options can 
be quite handy. A grayscale image does not have diff erent color channels 
because there is no color. Th ere is only one channel containing lumi-
nance data. You should simply be aware of the fact that every conversion 
of the original scan data can lead to data loss. 
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394.1 Color channels in scanning: RGB, grayscale, and infrared  

Consequently, if you are scanning for archival purposes, you should 
at least choose an output option that equals the internal channels of the 
scanner. 

For every option you choose that is below the internal color depth, 
VueScan has to convert the scanned data. Th e most common case for 
this is grayscale. Usually the results of this conversion are satisfying, 
but keep in mind that a manual conversion in Photoshop with channel 
mixer can produce even better results. 

To sum up: if you are quality conscious (and have suffi  cient hard disk 
space), you should try to save all of the data that the scanner can squeeze 
out of your original. If you want small fi le sizes and can accept some 
compromise in quality, use VueScan’s downsizing options. All in all, it 
really depends on the quality of the originals.

Black-and-white scanners 

Once in a while, you might fi nd a vintage scanner that can scan only 
black-and-white. Th is is very rare, and you would not seriously want to 
use an old crock like that as a workhorse for productive scanning! Every 
current desktop scanner today processes colors, and RGB is standard. 

Index fi le – All images in overview

An index print is a relic from analog times that fell partly into oblivion 
with the success of digital cameras. Th is was unjustifi ed, as index prints 
are still quite useful for anyone dealing with analog images. Tradition-
ally, an index print contained all of the images from a roll of fi lm on a 
single sheet of paper. It’s very handy, as you can get an overview of the 
contents of a fi lm roll with a quick glance. Usually, index fi lms are gen-
erated from negative fi lm, but it is possible to have index prints from 
slide fi lm as well. In  Output  ▶  Index fi le  you can confi gure VueScan to 
generate index prints while scanning. You can also use other programs 
that produce index prints of collections of JPEG or TIFF images. Th is is 
possible with many image editing programs like Photoshop.

Example: 

You own a Nikon Coolscan V, that has a internal color depth of 14-
bit and an infrared channel as well. In VueScan there is no 14-bit 
output option. You can choose either 8-bit or 16-bit. If you choose 
8-bit TIFF (like 24-bit RGB) as the output format, you will loose 
color information but you will get comparably small fi les sizes. 
To keep full color information, better choose 16-bit TIFFs (48-bit 
RGB or 64-bit RGBI). Th e 48-bit RGB will be twice as large as in 
8-bit mode, with the high 14-bits of each 16-bit sample holding the 
image data, and the low 2 bits fi lled with zero. 
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All modern scanners work with 48-bit color depth internally. VueScan can reduce this to grayscale or even to 1-bit B/W if needed. For color 

output the program has a wide range of options as well.
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414.1 Color channels in scanning: RGB, grayscale, and infrared  
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4.2 TIFF – Lossless but capacious  

TIFF (Tagged Image File Format) is a fi le format that encompasses 
many internal formats, several compression methods, and color depths 
ranging from 1 bit to 32 bits per color channel. VueScan supports only a 
portion of these options. Still, you will have enough choices to cover all 
of your needs during the scanning process.  

VueScan can store both raw fi les and processed images in TIFF fi les, 
as either *.tif or *.dng fi les.  Th e diff erence between TIFF and DNG fi les 
is that DNG fi les have a few extra TIFF tags that are used by RAW fi le 
converters.  Th e DNG format has two variants—one color per pixel or 
three (or 4) colors per pixel.  Because scanners, by their nature, have 
three (or 4) colors per pixel, VueScan uses this format.  All of Adobe’s 
programs that read raw fi les can read VueScan’s DNG, but Apple’s Ap-
erture only supports DNG fi les with one color per pixel at the moment. 

TIFF (and DNG) fi les are used for both raw fi les and for color-cor-
rected output fi les.  Th e main diff erence is that the raw fi les contain the 
data that’s received directly from the scanner, usually without any color 
correction, in the color space of the CCD in the scanner, and with a 
gamma of 1.0. Th e color-corrected output fi les are normally in the sRGB 
color space (other color spaces are possible with the Professional Edi-
tion) with a gamma of 2.2 or 1.8, depending on the color space.  Th is 
means that if you use a normal image viewer to view the raw fi les, they 
will look dark - this is just an artifact of their using gamma 1.0.  And 
that’s the diff erence between 64-bit RGBI DNG-TIFF and raw-data 
DNG: Th e raw fi les have a gamma of 1.0 and the  Output  ▶  TIFF fi le  has 
the gamma specifi ed by the output color space (1.8 or 2.2). 

Scanned TIFF fi les at 16 bits per color channel contain the maximum 
image information the scanner can produce. Since many scanners pro-
duce raw data with 12-bit or 14-bit color depth, storage space is not fully 
utilized with a 16-bit TIFF fi le. A 12-bit scan must be saved as a 16-bit 
TIFF, which is a waste of storage space. You will not face this problem 
with a scanner like the Coolscan 5000 that already works with 16-bit 
color depth internally. 

Although VueScan has optional TIFF size reduction, TIFF is still a 
true lossless image format. Th e TIFF format does support compression 
for 1-bit, 8-bit and 16-bit samples, but if you’re using 16-bit samples, 
this compression is only useful if your image has large  areas of solid 
color (i.e. black or white).  Th e 1-bit compression is the CCITT Group 
3 fax compression, and results in very small fi le sizes. A TIFF fi le stores 
always the full image information. Th at’s the biggest diff erence between 
TIFF and lossy formats like JPEG. JPEG compresses image information. 
Usually this compression is not visible, but for post-processing in an im-
age editing program, lossy pictures are far from ideal. Even with TIFF, 
not all image editing programs support every variation. Due to this, it 
may be wise to dispense with more exotic features like multipage TIFF 
or compression options. From a quality point of view, TIFF is the best 
output format if you want to do image post-processing. 
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434.2 TIFF – Lossless but capacious  

From a practical standpoint, the big fi le sizes can be quite a showstop-
per, especially if you scan in 48-bit or 64-bit. An average 35mm slide 
scanned at 4000 spi will have a fi le size of approximately 135 MB in 
48-bit RGB as a TIFF. As a JPEG, it will be much smaller; even a low-
compressed JPEG will not be much more than 4 MB. 

To sum up: TIFF is a good lossless output format. But due to the 
large fi le sizes, it should be used with care. Use it whenever you need 
good quality and plan to do some post-processing in an external pro-
gram, like tonal curve adjustments and so on. For scanning negatives 
and slides, TIFF is perfect, especially in 16-bit color depth. If you do not 
plan to do image post-processing, if you are short on storage space, or if 
you simply have scan templates that are of lower value (e.g. plain paper 
documents, JPEG or PDF format) can be the better choice. 

Output ▶ TIFF multi page 

Th is option allows you to combine several scans into a single TIFF fi le. 
It can be quite handy, but you should be aware that many image editing 
programs don’t handle this option well. Th ey will show you only the fi rst 
page of the multi page TIFF, and that’s it. 

Output ▶ TIFF size reduction 

Th ough TIFFs are great, they are simply too big for many purposes. One 
way to address this issue is VueScan’s TIFF size reduction. Th is is a kind 
of downscaling. If you set it to factor three, it will convert a scan resolu-
tion of 5380 x 3608 pixels into a fi le size of 1795 x 1202 pixels. You can 
achieve the same TIFF size by simply confi guring a lower resolution 
in the scan directly. However, TIFF size reduction can have a positive 
infl uence on image noise since this is an identical eff ect as multi-sam-
pling.  For instance, a TIFF size reduction of 2 will take each 2x2 block 
of pixels and output one pixel, which is equivalent to multi-scanning or 
multi-sampling each pixel 4 times.  

Output ▶ TIFF compression

Th is option reduces the fi le size of TIFFs directly and has no eff ect on 
image quality or image size. According to VueScan, it can produce a 
fi le size reduction of up to 40%; in fi eld use, we found it to be more like 
25%. In some cases, the compression can even lead to the opposite eff ect 
and increase fi le size! Due to this, there are two recommended settings: 
OFF, which has no compression but achieves maximum compatibility; 
and AUTO, which VueScan activates only if compression will actually 
save space. At the end of the day, this setting will produce the smallest 
archives. Th e third setting, ON, is not advisable as it can produce even 
bigger fi les in some cases. Since most image editing programs can deal 
with compression, compatibility should generally not be an issue. But 
no compression delivers the best compatibility possible.
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JPEG is a lossy format
JPEG is by defi nition a lossy format. 
It will never (!) preserve the original 
data of the image. You get small 
fi lesize but you will pay by losing de-
tails. If you want to postprocess your 
pictures to some degree, a lossless 
format like TIFF may be the better 
choice.

4.3 JPEG – Compressing images 

JPEG (Joint Photographic Experts Group) is a format well known from 
digital cameras. It combines small fi le sizes with at least respectable 
quality and is very popular, especially with amateur photographers. But 
even professionals sometimes use JPEG; when small fi le sizes are impor-
tant, JPEG is hard to beat. 

Th e JPEG format uses compression, and in VueScan, you can con-
fi gure the compression ratio yourself. Th is process reduces the raw data 
from the scanner to a fraction of its original size. When opened, the fi le 
is decompressed, and the image expands in RAM. Th e small fi le size 
has many advantages—more fi les fi t on a data carrier, and fi les can be 
sent easily over the Internet. Furthermore, JPEG is a popular standard 
and is supported by practically all image viewers and editors. But it has 
one major fl aw: with compression, some image quality gets lost perma-
nently. Plus, it usually does not support 16-bit color depth, only 8-bit. 
Th e JPEG standard allows more than 8 bits per sample, but very few 
programs actually support this.

High compression results in visible quality decline

Th e amount of quality degradation depends on the chosen compression 
ratio. Th e smallest fi le size requires the highest compression, which in 
turn causes the greatest loss of detail. A JPEG fi le in digital photography 
can be compared to a print from a lab in analog photography. Th e qual-
ity of the result depends on many factors, most of which are out of your 
control. Th ere are few possibilities to enhance the image aft erwards; you 
have to accept it the way it is. 

JPEG is poorly suited for processing in an image editor. If your goal 
is high image quality, JPEG should be used only at the very end of the 
image editing chain. It is fi ne for simple, quick scans; but if you want 
to post-process your images, you will quickly run into limitations and 
choose TIFF or even RAW instead. 

Good choice for economical scanning

JPEG is always a good choice when scans need to be done economically. 
It is perfect for scanning large archives or when you have to ship your 
pictures over the internet. Th is is the reason why almost every scanning 
service uses JPEG by default. TIFF usually costs extra per scan. If you 
want to squeeze every last bit of information out the template and pre-
serve it in digital form, you are better off  with TIFF or RAW. For quick 
and economical scanning, JPEG is the better choice because it is smaller. 
And that’s its sole key qualifi cation anyway. JPEG is leading in fi lesize 
and wide compatibility. In any other discipline, TIFF and especially 
RAW are of higher value for the user. And there is one thing that you 
can reason from the wide distribution of JPEG: Th e majority of users 
are more interested in convenient handling than in good image quality. 
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Strong JPEG compression will result in visible artifacts. TIFF will never have these kinds of artifacts, and with low JPEG compression the 

eff ect is so minimal, that you can hardly see it; not even when you are using a good screen. 

TIFF JPEG high compression JPEG low compression

454.3 JPEG – Compressing images 

JPEG 2000 

Some years ago, there were rumors about a new fi le format that was ex-
pected to replace the old JPEG format within a short time. Th e name of 
the saviour was JPEG 2000 and it seemed to combine the image quality 
of JPEG with the small fi le sizes of the known JPEG format. JPEG 2000 
uses fi le compression like its predecessor JPEG, but with a diff erence: 
Th e compression of JPEG 2000 is lossless! At least you can choose loss-
less compression with it, lossy compression is still possible if you need 
minimal fi le sizes. Th at means JPEG 2000 combines small fi le sizes and 
full image quality. But despite these nominal advantages, JPEG 2000 
never really took off . 

Th e old JPEG is still around, and JPEG 2000 is (at least for the mass 
market) as dead as the biggest platform that ever used the format in 
large scale. Just in case anybody remembers, that platform was Second 
Life. Neither Second Life nor JPEG 2000 no longer play a major role. 
Still, the format is far from being completely dead, as it survived in sev-
eral niches in the market. Some companies that are providing large scale 
archival solutions are using JPEG 2000 as it helps them to save precious 
storage space. For the average user, the poor compatibility of JPEG 2000 
is still an issue. Not even Photoshop can open JPEG 2000 fi les by default. 
You have to install a plugin fi rst, and many viewers don’t support it. 
Consequently there is no support for JPEG 2000 in VueScan. Just in case 
anybody wonders why it is missing.
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PDF or image fi le?
If you’re going to do a couple of 
scans and you aren’t sure about the 
planned purpose yet, stay on the 
safe side and scan everything in im-
age fi le formats. You can alway con-
vert the image fi les into PDFs later; 
converting PDFs to image fi les is less 
advisable. 

4.4 PDF – Versatile document format 

PDF (Portable Document Format) is a document format, and that al-
ready describes what separates PDF from JPEG and TIFF. JPEG and 
TIFF are image formats that can store original digital images produced 
by your scanner. In contrast, PDF is a versatile document format that 
can store text, images, graphics, and more sophisticated things like in-
teractive hyperlinks. While PDF documents can embed images, they 
should not be considered as full-fl edged image repositories.  You can 
extract embedded images out of PDFs later, but usually with limitations 
in picture quality. Storing full-size scans of your slides and negatives in 
PDF format is not a very elegant solution. Th ere are better ways to uti-
lize the specifi c benefi ts of PDF format. In general, if you are scanning 
negatives, slides, or photo prints for archival purposes, PDF is not rec-
ommended. A true image format like JPEG or TIFF is the better choice. 

Facsimile vs. archival scanning

If you are scanning paper documents (or comparable media, like over-
head transparencies) there are two ways of doing this, depending on 
the planned purpose of the scans. Th e fi rst option would be to do fac-
simile scans; that would be a common choice if you want to preserve 
documents like historical certifi cates. Th is suitable if you are not only 
interested in the written content, but you also want to preserve the tex-
ture of the original as closely as possible. In this case you should do a 
high-resolution scan and save this into an image format, not into PDF.  

Th e second option and a common alternative to facsimile scans 
would be archival scans. In this case you are more interested in the writ-
ten content than in preserving the analog original 1:1. A common ex-
ample for this, are old paper records you want to store in digital form 
for the future. In this case you will be happy to have a digital copy of 
the original letters or whatever. Th e convenience of use would be more 
important for you, than the last bit of image quality. 

The perfect electronic document

And this is when PDF kicks in. If you scan a multipaged paper record 
and let VueScan convert it directly into a multipage-PDF, then you 
would just have one fi le from the whole record and you can easily fl ip 
through the digital copy with any PDF-reader (like Adobe Reader). If 
you use OCR, you can even convert the scan into computer readable 
text. Th en you can even use search functionality or little helpers like 
Copy and Paste with the digital copy. Not to forget that printing of PDFs 
is quite fool-proof, you can exchange PDFs even with less experienced 
computer users conveniently. Note also that VueScan can do Optical 
Character Recognition (OCR) of each page in a PDF fi le, and output 
text over the image of each page. Th is makes the PDF fi les searchable on 
Windows and Mac OS X.
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474.4 PDF – Versatile document format 

PDF is the perfect fi le type for paper documents. Set  Input  ▶  Media  either to Text (for b/w documents) or to Lineart (for colored 

documents) for clean letter reproduction. 
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Scan vs. camera RAW
Despite common fi le formats like 
DNG you should not mix up scan 
RAW with RAW fi les from digital 
cameras. RAW scans have features 
like an infrared channel that a RAW 
fi le from a camera never has.

4.5 RAW fi les – Storing internal scanner data 

Scanning in RAW format is a comparably new phenomenon, even 
though VueScan has supported that functionality for a couple of years 
already. Most people nowadays are used to RAW workfl ows from their 
digital cameras, but in scanning there are some diff erences. Here we 
will compare a traditional scanning workfl ow in VueScan with a RAW 
scanning workfl ow. 

Traditional scanning workfl ow 

A traditional (non-RAW) scanning workfl ow is quite simple. Select 
 Input  ▶  Task  ▶ Scan to fi le and the name of your scanner model at 
 Input  ▶  Source . Th e result will be an image fi le like a JPEG or TIFF. 
You must decide several crucial things before scanning: do you need 
dust and scratch removal, and if so, to what degree? Do you need color 
restoration? Do you need to fi lter out grain? All of these choices will 
be hard coded into the image fi le, though the infrared channel is not 
stored. Th e maximum color depth of the resulting TIFF will be 48-bit. 

Th is process is quite convenient, but it can be dangerous as well—es-
pecially when you do batch scanning. If you make a mistake in any of 
these options, you will have to rescan the slide. Th ere is little room for 
corrections aft er you start the scan. Consequently, you need an experi-
enced scan operator who will stay focused on the task to avoid errors. 

As everybody knows, scanning is time-consuming, and as a result 
the traditional process is error-prone and laborious—at least when you 
want to achieve maximum quality. But if you are happy with VueScan’s 
standard settings during simple tasks, e.g., when using it as a photo-
copier, you will probably not see any need for rescanning. 

RAW scanning workfl ow 

Whereas the traditional workfl ow is a one-way process, the RAW scan-
ning workfl ow is a two-way process. First, you perform a standard scan, 
just as in the traditional workfl ow, with  Input  ▶  Task  ▶ Scan to fi le and
 Input  ▶  Source  set to the scanner you use. Th e diff erence is in the out-
put: instead of standard JPEG or TIFF, choose a RAW format like DNG. 
Th is way you can store the full 16-bit color depth of every color channel, 
plus the 16-bit infrared channel. A genuine RAW fi le contains the same 
information that the scanner uses internally. Th is results in a 64-bit fi le. 
You can choose other options if you don’t need full quality. But if you 
are serious about RAW, you should not downscale but instead use all of 
the information supplied by the scanner internally! Aft er you press the 
(Scan) button, the scanner will save the RAW fi le. Th is fi le can be pro-
cessed via VueScan as well, but fi rst you have to change a setting: Change
 Input  ▶  Source  to File. Th is allows you to do a kind of virtual scan-
ning. By accessing the RAW fi le on the hard disk, VueScan can perform 
almost all of the actions that are usually only possible with the scanner. 
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494.5 RAW fi les – Storing internal scanner data 

Camera RAW in VueScan 
VueScan can process RAW fi les 
from a number of diff erent camera 
manufacturers, e.g., Canon, Nikon, 
Olympus, Pentax, Kodak, Fuji, and 
Sigma. That’s a nice extra, but if you 
compare VueScan with programs 
like Adobe Lightroom or Apple Aper-
ture, you will see that VueScan gets 
the short end of the stick when pro-
cessing Camera Raw. VueScan uses 
the same dcraw.c code from Dave 
Coffi  n that most other raw convert-
er programs use. But it has of course 
not the post processing abilities 
of dedicated programs like Adobe 
Lightroom or Apple Aperture..

RAW scanning from disk is fast

Th e biggest advantage of RAW scanning is that VueScan does not have 
to wait for the scanner; it imports the RAW fi le from the hard disk, 
which is a very fast process. Th en you can jump between fi lter confi gu-
rations with just a mouse click—e.g., it is extremely convenient to try 
out the various settings of  Filter  ▶  Infrared Clean  without any holding 
time. All in all, RAW scanning is a good method if you want to separate 
the input operation from the processing. 

Limitations of RAW 

Choosing RAW fi les does not in and of itself guarantee good scanning 
results. Th e idea, “If I do some quick RAW scans, every confi guration 
can be done in the second step,” sounds too good to be true—and it is 
more wishful thinking than reality. You can compare it with RAW fi les 
from digital cameras. Th e best RAW format of a digital camera will not 
help you get a proper picture if you overexpose during shooting. For 
scanning, the situation is similar. 

During scanning, you have to ensure that the RAW fi le actually con-
tains the proper and complete data, starting with the scanning resolu-
tion itself. If you want to max out your scanner’s quality reserves com-
pletely, use the optical resolution of the scanner if it is justifi ed by the 
template. For a fi lm scanner like a Nikon Coolscan 5000, this would be 
4000 spi for a color slide. Check this setting on the  Input  tab. If you 
choose a setting like  Input  ▶  Quality  ▶ Email by mistake, your RAW 
fi les will be tiny and of little use. 

Always focus before you scan

Th e same thing can happen if there is anything wrong with the fo-
cus. Good fi lmscanners  are able to focus and usually do this auto-
matically, most fl atbedscanners don’t have this feature. In the menu 
Scanner ▶ Focus you can do it manually via shortcut (Ctrl)+(F) as well. 
Th ere is a blinking focus point in the  Preview  tab. If you want to change 
its location, use  Crop  ▶  Focus x off set  and   Crop  ▶  Focus y off set . 
Normally this is not an issue, but misconfi gurations of the focus point 
can lead to unusable raw scans. 

Th e crop itself is another potential source of error. If you acciden-
tally crop a piece of the slide, it is lost. Th e automatic frame detection 
of VueScan helps minimize this risk, and it works quite reliably. But for 
diffi  cult images, like low-contrast night shots, it’s best to check the frame 
setting before scanning. Alternatively, you can enlarge the crop to cover 
the full preview window and crop later. Th at way you will not have to 
check cropping any more, but the fi le sizes of the scans will be signifi -
cantly larger. Multi sampling, multi exposure, and color brightness are 
other options that you cannot simulate on the raw level.  To make use of 
them, you must confi gure them before scanning.
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* Display fi le extensions
By default Windows systems nowa-
days hide fi le extensions. You have 
to enable the feature manually in 
the Folder options of Windows if you 
want to display the extensions.

4.6 DNG vs. RAW-TIFF 

In VueScan, the RAW fi le option lets you choose between TIFF and 
DNG formats.  DNG fi les are the same as TIFF fi les, but they have a 
few extra TIFF tags. When introducing the raw scanning feature, this 
RAW-TIFF was the fi rst fi le format supported. It still is fully functional, 
but there are some disadvantages in daily use. First of all, in the explorer 
view on your hard disk, it is impossible to tell what a standard-TIFF and 
what a RAW-TIFF is. Th is might lead to some confusion unless you use 
fi le names that give a clue—try beginning fi le names of RAW-TIFF fi les 
with “RAW”. 

Viewing RAW-TIFF

Plus, if you display a RAW-TIFF via any picture viewer or Photoshop, 
it will look dull and much too dark. Th e reason for that is that raw fi les 
contain data straight from the CCD of the scanner, and the CCD uses 
gamma 1.0 (while normal TIFF fi les are gamma 2.2). You are better off , 
if you use the widely supported DNG format, since they assume gamma 
1.0 and are then displayed properly. Th e fi le extension will help you to 
recognize RAW fi les in Explorer view*. Plus the DNG is displayed cor-
rectly in most image viewers, i.e. in Adobe Bridge. Th is allows you to 
fl ip through your DNG-RAW archives more conveniently than through 
RAW-TIFF.  VueScan reads RAW-TIFF and DNG fi les identically, since 
internally they are actually almost identical—there are just a few extra 
TIFF tags in the DNG fi les. 

Color depth in RAW

Last, but not least, you should be aware of the color depths you have to 
confi gure, no matter what fi le format you choose. A real RAW scan is 
64-bit—48-bit from RGB and 16-bit from the infrared channel. Th ere 
are some templates that do not profi t from the infrared channel, like 
classic black-and-white negatives and prints. In those cases, you don’t 
need the infrared channel. VueScan provides you with many additional 
options, from 1-bit black-and-white to grayscale and various RGB op-
tions—but all of them reduce the amount of information provided by 
the scanner. While this can be convenient and space-saving, it is no 
longer true RAW scanning. 

How and when to use RAW 

If you sum up the pros and cons of RAW scanning and compare it to 
traditional scanning, you will see that both methods are justifi ed. RAW 
scanning is a good way to separate the physical input of data (within 
the above-described limitations) from the processing of data. For batch 
scanning, this is perfect. You can save a lot of energy during the scan 
itself and do most of the confi guration retroactively. 
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514.6 DNG vs. RAW TIFF 

RAW in daily use

But this convenience comes at a price. First, RAW scans are big by na-
ture; second, you would need to produce another image fi le for every 
scan, as you cannot use the RAW fi le for direct editing. Traditional scan-
ning is much leaner, even though it off ers less fl exibility. For scans where 
a fast workfl ow is more important than getting the best quality out of the 
original, scanning into (non-RAW) TIFF or JPEG is the smarter choice. 
It all depends on what you want to do, how much time and energy you 
want to invest, and your personal expectations in regards to quality.   

Lightroom and Aperture

Adobe Lightroom and Apple Aperture have some very good tools for 
the comprehensive processing of RAW fi les. Lightroom can read the 
standardized DNG format used by VueScan, since Adobe’s program-
mers implemented the full DNG specifi cation. Apple’s programmers 
didn’t implement the full DNG specifi cation, so Aperture can’t read Vu-
eScan’s DNG fi les.

But still, there are some limitations in the use you should be aware of.  
Specifi c scanning functionality, like Infrared Clean, is not (!) supported 
by RAW editing programs designed for Camera RAW. In this case, you 
would still have to use VueScan to perform dust and scratch removal—
assuming that you stored the infrared channel during scanning. Conse-
quently, Lightroom and Aperture cannot be regarded as complete alter-
natives to the workfl ow that uses VueScan for generating image fi les and 
Photoshop to process them. Scan RAW is not identical to Camera RAW! 

Most viewing applications display RAW-TIFF images too dark, as RAW fi les have only gamma 1.0. DNG-images have the same gamma 1.0 as 

RAW-TIFF, but most viewing appplications automatically detect DNG as a raw fi le and display it in gamma 2.2.
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File size comparison (4000 spi scan of 35mm slide, 24 x 36 mm)

File Type Color Depth Infrared
Channel

Compression/
Quality

Absolute 
Size (KB)

Absolute 
Size (MB)

Relative 
Size (%)

DNG 
(RAW)

48-bit RGB 16 bit n/a 167,414 167,41 100,00%

TIFF 48-bit RGB 16 bit OFF 165,337 165.34 98.76%
TIFF 48-bit RGB 16 bit ON 125,538 125.54 74.99%
TIFF 48-bit RGB -- OFF 125,568 125.57 75.00%
TIFF 48-bit RGB -- ON 150,614 150.61 89.96%

TIFF 24-bit RGB -- OFF 62,799 62.80 37.51%
TIFF 24-bit RGB -- ON 46,673 46.67 27.88%
JPEG 24-bit RGB -- 100 17,187 17.19 10.27%
JPEG 24-bit RGB -- 75 2,342 2.34 1.40%
JPEG 24-bit RGB -- 50 1,391 1.39 0.83%
JPEG 24-bit RGB -- 25 798 0.80 0.48%

TIFF 16-bit 
Grayscale

-- OFF 41,861 41.86 25.00%

TIFF 16-bit 
Grayscale

-- ON 48,132 48.13 28.75%

TIFF 8-bit 
Grayscale

-- OFF 20,930 20.93 12.50%

TIFF 8-bit 
Grayscale

-- ON 13,256 13.26 7.92%

JPEG JPEG black/
white

-- 100 10,993 10.99 6.57%

JPEG JPEG black/
white

-- 75 1,969 1.97 1.18%

JPEG JPEG black/
white

-- 50 1,194 1.19 0.71%

JPEG JPEG black/
white

-- 25 678 0.68 0.40%

TIFF 1-bit black/
white

-- OFF 2,619 2.62 1.56%

TIFF 1-bit black/
white

-- ON 103 0.10 0.06%

The RAW fi le is the reference for all other fi le formats, as this is the full information the scanner uses internally.

In some cases, TIFF compression actually increases the fi le size instead of decreasing it.
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Scanning Media Types
Th ere is quite a range of media types in the world of scan-
ning, and each has its own particular characteristics. First of 
all, it makes a big diff erence whether you are scanning refl ec-
tive media, like paper documents, or transmissive media, like 
slides and negatives. While you can use any standard fl atbed 
scanner for refl ective media, transmissive media is more de-
manding: you will need a scanner with a transparency unit for 
this task. 

But choosing diff erent hardware is the easiest part of the 
job. If you dig deeper, you will soon fi nd out that paper docu-
ments, newspapers, magazines, and photo prints may all be 
refl ectives, but due to diff erent printing technologies they 
have very diff erent characteristics that require diff erent scan-
ning techniques. Regardless of the type of media you scan, 
one thing is for certain: VueScan has a specifi c confi guration 
for it. 
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This Fuji Velvia slide was used for the 

scans on the opposite page.

54 5 Scanning Media Types

5.1  Transmissive media – Color slide (E6) 

Color slides off er the maximum obtainable image quality in a purely 
analog workfl ow. Th ey off er more vivid images than color nega-

tives, and their contrast range is higher as well. With color slides, the 
processing lab has little impact on the image result. As a photographer, 
you will most likely get the picture you actually took, and you will have 
good control over the fi nal image. Film development for color slides is 
standardized by the E6 process; almost every lab that processes fi lm can 
handle E6. For decades, these advantages made color slides the profes-
sional photographer’s fi rst choice. 

Slides are superior to negatives because they have fi ner grain, more 
contrast, better color depth, and a much better density range. However, 
slides demand accurate exposure by the photographer, as there is little 
margin for error. Even a small exposure error will aff ect the image. In 
comparison, you have much more leeway with exposure when using 
color negative fi lm. 

In addition, slides make much greater demands on scanning hard-
ware than negatives. For example, scanning slides using low-end scan-
ners oft en leaves much to be desired, since such cheap scanners cannot 
typically handle the wide range of colors, contrast, and density inherent 
in slides. 

Still, if you have a good quality scanner, your scans of slides will be 
more brilliant than your scans of negatives. Due to their relatively fi ne 
grain, color slides are the perfect source material for poster-sized prints. 
Another big advantage of color slides is that they are positives. Th ere’s 
no need to invert color, and there’s no orange mask as with color nega-
tives. As a result, you can directly compare your scanned image to the 
original color slide. 

With IT8 calibration, you can scan your slides with true colors as 
well. However, IT8 calibration does not automatically guarantee the 
perfect colors you might expect. It simply reproduces colors 1:1 from 
the original slide. If the original slide is faded or has a color cast, you 
will need to do some post-processing to achieve a presentable result, 
whether you use IT8 calibration or not. 

Film profi les for slides
Even though color slides are positive 
images that don’t usually need spe-
cifi c correction, VueScan off ers some 
fi lm profi les for color slides, e.g., for 
Kodak Ektachrome. These are de-
signed to achieve a realistic impres-
sion of the original scene. If you don’t 
use them, you will get a scan that 
exactly reproduces the color charac-
teristics of the original slide. It’s more 
or less a question of personal taste.

Common scanning resolutions for 
color slides range between 2000 and 
4000 spi. Higher resolutions demand 
not only a high-end scanner but 
also high-quality templates. If you 
have medium or large format slides, 
you can reduce the scanning resolu-
tion to avoid monster-sized fi les. 

Pros and cons: E6 slide  

 ∏ Infrared-based dust and scratch removal possible 
 ∏ Most brilliant colors of any fi lm type 
 ∏ High contrast 
 ∏ Fine grain, especially for low-density fi lm 
 ∏ Insensitive to scratches on fi lm surface 
 ∏ True color scanning with IT8 calibration possible 
 π Good (that means unfortunately expensive) hardware needed 

for best scanning results 
 π Exact exposure is mandatory when taking photos 
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The scan with an Epson V750 shows remarkably less details and brillance than the fi lm scanner. The fl atbed scanner has a glass supporting 

layer between optics and slide. This is one key factor for the comparably inferior quality. 

This is a scan of a 35mm slide with a dedicated fi lmscanner Nikon Coolscan 5000. A true fi lmscanner like the Nikon has no glass supporting 

layer between its optics and the slide. 

555.1 Transmissive media – Color slide (E6) 
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Common scanning resolutions for 
Kodachrome slides range between 
2000 and 4000 spi. Higher resolu-
tions demand not only a high-end 
scanner but also high-quality tem-
plates. If you have medium or large 
format slides, you can reduce the 
scanning resolution to avoid mon-
ster-sized fi les. Keep in mind that 
Kodachrome in general needs good 
scanning equipment to deliver re-
spectable results. 

5.2  Transmissive media – 
Kodachrome slide (K14) 

Kodachrome fi lms are color transparency fi lms that have been on the 
market for more than half a century. Th is is genuine vintage material, 
once the standard fi lm for generations of press photographers. But Ko-
dak has already stopped manufacturing this fi lm; when the remaining 
stock is sold out, Kodachrome will not be available on the market. 

Professional photographers benefi tted from some special Koda-
chrome features that still cannot be matched by any other fi lm. Th e col-
ors are quite consistent throughout the Kodachrome family. For exam-
ple, in a slideshow, you can easily mix Kodachrome 25, Kodachrome 64, 
and Kodachrome 200. When it comes to archiving, Kodachrome is also 
without equal. Kodachrome can be stored for decades and still maintain 
consistent colors. Th at sounds too good to be true, and there is another 
side of the coin. Kodachrome is very sensitive to light, so if you want to 
preserve it, store it in a dark, cool, dry location. 

Kodachrome is in many ways a dinosaur. It could not be developed 
by the standard E6 process for color slides; it needed the special K14 
process. You had to send your exposed Kodachrome fi lm directly to 
Kodak for development. Nowadays, not even Kodak is developing Ko-
dachrome any more. K14 is diff erent in many ways from E6; you could 
say that Kodachrome is not genuine color fi lm, but rather black-and-
white fi lm to which Kodak adds some colors. In fact, this diff erence in 
technology is something you need to take into account when scanning. 

Standard infrared cleaning with Kodachrome is a diff erent than with 
E6-slides. Usually Infrared Clean works fi ne even with Kodachrome. 
But there are some exceptions to the rule. If the fi lm wasn’t developed 
properly, it can still contain silver halides that will aff ect the fi lter in a 
negative way. While it will remove dust and scratches, it will also remove 
desired details due to the diff erence in fi lm structure. Enable  Color  ▶
 Pixel colors  and you can survey the scratch detection sensitivity in 
VueScan and switch off  Infrared Clean if needed.  Kodachrome slides 
should not be scanned with an E6 profi le. Use VueScan’s Kodachrome 
fi lm profi les; they will produce much more vivid colors.

Pros and cons: K14 Kodachrome slide

 ∏ Characteristic colors throughout the Kodachrome family 
 ∏ Fine grain, especially for Kodachrome 25 and 64 
 ∏ Infrared-based dust and scratch removal is in general possible 
 π Most scanners do not support special dust and scratch remov-

al needed for Kodachrome 
 π Sensitive to scratches on fi lm surface 
 π Good scans only possible with expensive scanners 
 π Kodachrome dyes fade quickly when exposed to light—store 

in dark places! This Kodachrome slide was used for the 

scans of the opposite page.

Im
ag

e:
 P

et
er

 S
te

in
ho

ff 

Vue_book_large.indb   56 13.04.2011   19:44:15



575.2 Transmissive media – Kodachrome slide (K14) 

Scan with E6 profi le

Scan with Kodachrome profi le
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Common scanning resolutions for 
color negatives range between 2000 
and 4000 spi. If you have medium 
or large format negatives, you can 
reduce the scanning resolution to 
avoid monster-sized fi les. 

5.3 Transmissive media – Color negative (C41) 

Color negative fi lm has been the most widespread fi lm material for de-
cades, at least for amateur photographers. In the past, there were a cou-
ple of good reasons to use these fi lms. Now, though, if you want to con-
vert your old color negatives into digital images, you will soon fi nd out 
that they are a pain in the neck. Th is is mainly due to their orange mask. 
Of course, there are some workarounds to address this, but positive scan 
originals, like color slides, are much easier to handle than negatives. 

Let’s start with the positive points. Color negatives are not only quite 
cheap, but also quite robust regarding exposure. Even if you expose the 
fi lm sloppily, you can still get usable photos back from the lab. Because 
of this, the quality of many old color negatives is quite good for scanning 
purposes. 

Due to their comparably low dynamic range, even an inexpensive 
scanner can yield acceptable results when scanning color negatives. But 
for the same reason, the color and contrast of color negatives will never 
reach the level of good color slides. In addition, the fi lm base of color 
negatives is relatively sensitive and susceptible to scratches. You can get 
good scans from color negatives only if you use a scanner with good 
infrared-based scratch removal. 

A big issue when scanning color negatives is wrong colors. Keep in 
mind that IT8 calibration is for positive pictures only—it’s useless for 
negatives. Negatives have an orange mask that makes it almost impos-
sible to judge the original colors of the scenery. Just scanning and in-
verting the colors is not enough; removing the orange mask is the tricky 
part of the process. Since the characteristics of fi lm emulsions are as 
manifold as the off erings of color negative fi lms, there is no universal 
setting that fi ts every color negative original. 

You will need a specifi c fi lm profi le for each color negative fi lm type 
you want to scan. VueScan off ers a big range of fi lm profi les that covers 
most fi lms on the market. But these fi lm profi les will not automatically 
produce great colors in every case. Remember that fi lm fades out and 
colors shift  over time. All in all, it takes more eff ort to get proper colors 
from negative originals than from positive originals. Manual correc-
tions in Photoshop are needed frequently. 

Pros and cons: C41 Color negative 

 ∏ Infrared-based dust and scratch removal possible 
 ∏ Acceptable scan results even with inexpensive scanners 
 ∏ Tolerant against wrong exposure 
 π Colors and contrast less vivid than color slides 
 π Sensitive to scratches on fi lm surface 
 π Impossible to compare scanned image with original negative 
 π Specifi c fi lm profi les needed for each fi lm type 
 π Manual correction oft en needed in spite of fi lm profi lesThis color negative was used for the scans 

on the opposite page.
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595.3 Transmissive media – Color negative (C41) 

A simple inversion of the original negative will usually not bring the desired eff ect. Almost every negative fi lm on the market has a colored 

mask, for a color negative it’s usually orange colored. Use a fi lm profi le to convert the inverted negative into a presentable image.

Color corrected positive image

Inverted negative

Source Negative
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60 5 Scanning Media Types

Scanner lamps and B/W
Black-and-white fi lm is quite picky 
concerning scanner lamps. Even 
expensive scanners like Nikon fi lm 
scanners do not guarantee a good 
result. Nikon uses harsh LED light 
that’s perfect for brilliant color slide 
reproduction. For black-and-white 
scans, old-fashioned fl uorescent 
lamps—as used in vintage Polaroid 
Sprint Scan 120 scanners—are the 
better solution. 

5.4  Transmissive media – Black-and-white 
negative 

Black-and-white negative fi lm has been around for ages. Ever since 
the fi rst Leica camera hit the market in 1925, people have used black-
and-white fi lm in the same 35mm format we have today. Due to this, 
there are a lot of black-and-white pictures and negatives around. If you 
have some really old negatives, they will probably be black-and-white 
fi lm. Scanning of these old and frequently worn originals requires a lot 
of manual work. As with color negatives, black-and-white negatives suf-
fer from dust and scratches; but in this case, hardware-based scratch 
removal does not work at all. In fact, Infrared Clean actually decreases 
scan quality.  Th e reason you can’t use infrared light to fi nd dust and 
scratches is that black and white negatives look exactly the same in vis-
ible light as infrared light. Silver particles look the same in both types 
of light. Th is is a general physical symptom that aff ects all scanning 
programs, not only VueScan. Other infrared-based dust and scratch re-
moval soft ware, e.g., Nikon’s Digital ICE and Canon’s FARE, struggle 
with the same problem. Due to this, automated dust and scatch removal 
is not possible with black-and-white fi lm. You must correct abberations 
manually in Photoshop. Th is general rule applies to almost all black-
and-white fi lm—but, of course, there is no rule without an exception. 
Th e exception is chromogenic black-and-white fi lm. Th is fi lm contains 
no silver halides and instead uses a technology similar to color nega-
tives. Chromogenic black-and-white fi lm is processed in C41, the stan-
dard development process for color negatives. 

Films like Ilford XP2 Super, Kodak BW400CN, Konica Monochrome 
VX400, Tura BW-C41, and Fujifi lm Nexia Sepia are chromogenic. With 
these fi lms, infrared-based dust and scratch removal is possible. Classic 
black-and-white fi lms like Kodak T-Max, Ilford HP5, and Fujifi lm Neo-
pan are all silver-based, and VueScan’s Infrared Clean will not work with 
them. Many black-and-white fi lms have a masking layer that can lead 
to color casts if you scan in RGB. You can avoid color casts by scanning 
them as grayscale. VueScan off ers specifi c fi lm profi les for black-and-
white fi lms like Kodak T-Max 100/400/3200. Scanning  black-and-white 
fi lm is an elaborate process, as this fi lm is designed for purely analog 
use. But apart from the retouching, it is more convenient to handle than 
color negatives. A missing fi lm profi le for a specifi c fi lm can be tolerated 
easily. All in all, it’s just black-and-white.

Pros and cons: Classic black-and-white negative  

 ∏ Good scan results even with inexpensive scanners 
 ∏ No color correction needed if scanned as grayscale 
 π Sensitive to scratches on fi lm surface 
 π Infrared-based dust and scratch removal not possible 
 π Elaborate manual retouching oft en necessary 

Common scanning resolutions for 
classic black-and-white negatives 
range between 2000 and 4000 spi. 
If you have medium or large format 
negatives, you can reduce the scan-
ning resolution to avoid monster-
sized fi les. 
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 Infrared clean  works very well for this sample, but this is a rare exception for black-and-white fi lm. This negative is from Ilford XP2 and that 

fi lm is chromogenic. With classic black-and-white fi lm like Kodak T-Max,  Infrared clean  can not work due to physical restrictions. 

Black-and-white negatives can suff er heavily from dust and scratches. Especially when they are old and storage conditions are not ideal. 

The fi lm surface is prone to damages of any kind. 

615.4  Transmissive media – Black-and-white negative 
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Common scanning resolutions for 
facsimile reproduction of paper 
documents are between 300 and 
600 spi. You should scan RGB if you 
want to retain the original colors of 
the documents, including age-re-
lated discoloration. If you only want 
to convert analog text into digitized 
text, you can reduce the resolution 
and switch to grayscale. Avoid us-
ing full optical resolution on fl atbed 
scanners for big templates like paper 
documents. You will produce giga-
byte-sized fi les that will bring most 
computers to their limits without a 
signifi cant gain in picture quality. 

5.5 Refl ective media – Paper documents 

Th e overwhelming majority of documents from the analog age are sim-
ple paper documents. Analog archives may contain tons of paper sheets 
that have been written by hand, composed on electronic typewriters, 
or printed out with old-fashioned dot matrix printers, inkjet printers, 
and laser printers. If you want to scan these kinds of documents, fi rst 
ask yourself these questions: are you interested in preserving the whole 
document as is, or do you just want to keep the written content and con-
vert it into an electronic document? In the fi rst case, you would scan the 
document at high resolution and in full color to reproduce it as precisely 
as possible. Th is scanned facsimile could be used for a reprinting that is 
true to the original. 

Skipping color information for smaller fi les

In the second case, when you are only interested in the written content, 
you don’t necessarily need high resolution and you usually won’t need 
full RGB information. Th is will allow you to produce much smaller scan 
fi les. If you are scanning a couple of old letters, scan fi le size is not im-
portant. But if you are going to digitize an entire archive, scan fi le size 
will have a big eff ect on your budget and should be considered carefully. 

Facsimile scanning is pretty much like picture scanning, but you need 
to invest more energy to convert analog text into computer-readable 
digital information. Th e method behind the conversion is OCR (Opti-
cal Character Recognition). It helps you to convert the image provided 
by the scanner into editable digital information. VueScan has a built-in 
OCR module that allows you to do OCR within the scanning program. 

In general, OCR has reached a high level of text recognition over the 
years, thanks to improved algorithms and the sheer increase of process-
ing power in computers. Now everybody with a standard computer can 
do text recognition at home. Th e method is not yet perfect; in particular, 
the recognition of handwritten text is a serious challenge for any OCR 
program, especially if the handwriting is messy. On the other hand, if 
you have a clean, laser-printed document that does not use unusual type 
fonts and that is written in English, you will have a very high recogni-
tion rate with minimal manual corrections. Exotic languages are more 
diffi  cult to handle. But all in all, OCR is a convenient and well-engi-
neered technology that covers most applications very well. 

Pros and cons: Paper documents   

 ∏ Good scan results even with inexpensive scanners 
 ∏ OCR allows digital conversion of analog text without the need 

to retype everything 
 π Paper does not have much latitude for enlargement, fi lm is the 

superior analog medium 
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635.6 Refl ective media – Scanning paper prints 

Common scanning resolutions for 
paper prints are between 300 and 
600 spi. There are some printers 
around that claim to reach higher 
resolutions, e.g., around 1200 dpi, 
but for this purpose 300-600 dpi is 
regarded as suffi  cient. Please keep 
in mind that paper is an undesirable 
medium for subsequent enlarge-
ments. The scan from a standard 
print is suitable for 1:1 reproduction, 
not for producing poster-sized en-
largements. 

5.6 Refl ective media – Scanning paper prints 

In the analog age, paper prints were the most common way for photog-
raphers to display pictures. Usually pictures were taken on fi lm; then a 
photographic laboratory developed the fi lm and enlarged the compara-
tively small fi lm pieces into larger paper prints. Th erefore, the original 
picture is always on the fi lm, and the paper print is just an analog copy. 
Th ere are exceptions, like instant pictures (e.g., Polaroid and Fuji In-
stax), but in general you should have the original fi lm in your archive 
for every paper print. 

To preserve the image quality of the original, you should scan the fi lm 
directly and not the paper print. If you use a good quality scanner, you 
will get a much more detailed and high-contrast digital image from the 
negative than from the print. Plus, you have more latitude for enlarge-
ment with fi lm. Unfortunately, sometimes all you have is a paper print 
and you have to deal with what’s there. A good print can be an accept-
able template for scanning. As with any other recording techniques, the 
quality among prints can vary widely. For example, an old-fashioned 
enlargement made with worn-out laboratory equipment will be of lower 
quality than an up-to-date injket print. 

In all cases, you have to deal with the limitations of paper as the car-
rier medium. If you are aware of the limits, you can still get some de-
cent scans out of paper prints. While you can use fi lm scans to produce 
poster-sized image fi les, a paper scan is suitable for 1:1 reproduction. Of 
course, you can enlarge it beyond 1:1, but be aware that the quality will 
suff er visibly.

Rasterization in books, magazines and newspaper scans

When scanning photos out of a book, magazine, or newspaper, you will 
confront a side eff ect of the normal printing technique: rasterization. In 
a magnifi ed view, you can see that the photos are rasterized. VueScan 
off ers a descreening fi lter that helps remove the raster from the scanned 
image. Whether you use this fi lter or not is more a personal decision 
than a technical necessity. With standard settings VueScan will repro-
duce the raster exactly and this will result in a busy appearance of the 
scan. If you use the descreening fi lter you will get a better looking image, 
but this comes at a price. Image sharpness and some loss of details are 
side eff ects of the descreening.

Pros and cons: Paper prints   

 ∏ Good scan results even with inexpensive scanners 
 π Paper does not have much latitude for enlargements (fi lm is 

the superior analog medium) 
 π If possible, scan the original source slide/negative and not the 

print 
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◀ It is old, it is fi ssured and the image quality is for sure inferior to modern painting styles. But 

nobody ever even thought about dumping the analog original of the Mona Lisa, not even a 

correction fi lter had been applied so far. Happily enough the museum still keeps it like it is. 

Even so, they made a couple of high quality scans of it in the meantime.Im
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64 5 Scanning Media Types

5.7 The originals: To dump or not to dump? 

Aft er you have successfully scanned your originals, you will probably 
ask yourself whether there is still an urgent need to keep them. Nobody 
would fl ip through shoeboxes of negatives when all the data is easily 
accessible on your computer, right? Well, that’s a diffi  cult question to 
answer, and you should think twice before dumping anything. 
First of all: once you discard or destroy your originals, you will obvious-
ly have no chance to scan them again. At the very least, you should en-
sure that you have a good, working backup; otherwise, you might dump 
the originals and later lose all your scans because of a stupid thing like a 
crashed hard disk. Since things like that can always happen, redundant 
data storage is a must. 

Th e other consideration is that your current scans might not have 
squeezed all of the image information out of your originals due to tech-
nical limitations. Th is can and will probably happen, e.g., with 35mm 
fi lm. While modern scanners deliver good results, there is still some-
thing left  to be desired. If you keep the originals, you can profi t from fu-
ture scanner enhancements. However, if you are just scanning a couple 
of old insurance documents for your personal archive, the situation is 
quite diff erent. In that case, you have no desire for enhanced scanning, 
plus you are usually happy to get rid of those old paper fi les. 

About the value of analog originals

When it comes to originals that have emotional value, e.g., family pho-
tographs, you should defi nitely keep them. Aside from practical reasons, 
it is a diff erent and valuable experience to see analog originals that you 
can actually hold in your hands. Flipping through vintage Kodachromes 
and checking them with a loupe on a lightbox is a nostalgic experience 
that is hard to match on the digital level. Th e better alternative to com-
pletely dumping old archives is to sort them properly and to discard 
only bad pictures. Th is will dramatically reduce your needed storage 
space. Almost every archive contains a lot of mediocre and simply bad 
shots among the good ones. Consequently, if you sort out the bad stuff , 
you will have a much leaner image collection. As scanning is quite time-
consuming, sorting beforehand is advisable anyway. You can save lots of 
time by scanning only the good pictures and eliminating the bad shots. 
To sum it up in short: Always keep good analog originals! Th ey have 
their own value, no matter if you have a digital copy of them or not.
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Multiscanning
Multi-exposure
Scanner exposure
Descreening

Special Scanning 
Techniques 
Scanning can be much more than a simple 1:1 reproduction 
of the original in the tray. Actually, if you employ the same 
standardized scanning technique for all of your originals, you 
are unlikely to achieve the best possible image quality in every 
case. When carefully used, techniques like multiscanning, 
multi-exposure and descreening can make the diff erence be-
tween a mediocre and an optimal scan. 
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66 6 Special Scanning Techniques

6.1 Multiscanning 

Standard scanning requires only one pass for the entire original. Th e 
scanner collects data samples from the surface of the original line by 

line and uses that data to generate the scan fi le. However, this is not nec-
essarily the best option. You can oft en improve the overall image quality 
by repeating the process. Instead of scanning the original once, VueScan 
can scan it multiple times and combine the images into one fi nal fi le. 
Th is process is called multiscanning.  

You can use multiscanning either with transparencies or refl ectives, 
but it is more common with transparencies. In VueScan, you can choose 
any value between scanning twice (2x) and 16 times (16x). With each 
additional pass, the time duration of the overall scan adds up and it uses 
more RAM .  

Th e benefi ts of multiscanning may justify the eff ort. First of all, the 
overall quality of the scan data should improve. Like any digital camera, 
a scanner produces not only the desired information signal but also a 
good portion of undesired interference. Th is interference is the notori-
ous image noise. For example, when you take a photo of a pitch black 
night with your digital camera, you will get some erratic green, red, or 
blue pixels for no obvious reason; scanning suff ers from the same ef-
fect. Due to image noise, some pixels will be miscolored. At an average 
viewing distance, this will give the picture a slightly uneven appearance. 
If you enlarge it in Photoshop, you will easily see the miscolored pix-
els. Multiscanning visibly reduces image noise and can also improve the 
color gradient and the grain appearance of the scan. 

However, multiscanning can have side eff ects and therefore does not 
automatically lead to an overall improvement in image quality. Dur-
ing multiscanning, the scanner must reposition itself a couple of times. 
Since scanning hardware does not always work with the utmost preci-
sion, the result can be blurry, unsharp images. You simply have to try 
out multiscanning with your particular scanner to see if its application 
is justifi ed. Th e benefi ts and side eff ects amplify with each additional 
pass; thus, a 2x scan may be preferable to a 16x scan in some cases. In 
the end, it all depends on the precision of your scanning hardware. A 
little loss in sharpness seems to be inevitable with multiscanning, but 
this eff ect should be balanced out by decreased image noise.  

Nikon and Minolta fi lm scanners have very accurate repositioning 
of the scanner at the start of each scan pass, so the results with multi 
scanning are quite good. But in comparison to a standard scan you will 
always experience loss in sharpness. 

Th e low-cost versions of the Nikon fi lm scanners (Nikon Coolscan 
III, Coolscan IV, Coolscan V) do not support multi-sampling, but work 
well with multi-scanning.  Multi-scanning is only useful for fi lm, since 
the density range of refl ective media is much less than an inexpensive 
CCD can record in a single pass. Multi scanning helps mostly in reduc-
ing noise in the dark areas of slides, and is less useful for scanning nega-
tives. Th e dark areas of negatives aren’t very dense compared to slides.

Number of samples/passes 
In VueScan, you can confi gure mul-
tiscanning in the  Input  tab. De-
pending on your scanner, you will 
either see the option  Input  ▶  Num-
ber of samples  or the option  Input 
▶  Number of passes . For  Number
of samples , the scanner reads each
line several times during multisam-
pling. This is the best option for mul-
tiscanning with the least probabil-
ity of inaccuracies, but your scanner
hardware needs to support it.  Num-
ber of passes  scans the whole im-
age several times consecutively. Here
the scanner must reposition itself be-
fore each pass, making it somewhat
less precise than the fi rst option. 
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676.1 Multiscanning 

Multiscanning can improve image noise and reduce grain. On the other hand the overall image sharpness can suff er from mulitscanning. In 

the end it really depends on the specifi c scanner if multiscanning leads to an overall image improvement.
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68 6 Special Scanning Techniques

Practical eff ect of Multi-exposure
The eff ect of multi exposure depends 
very much on the scanner used. A 
good scanner can cover the dynam-
ic range of a slide completely. In this 
case you will not need multi-expo-
sure. Cheaper scanners with a lower 
dynamic range can indeed improve 
their dynamic range very much by
using multi-exposure.

6.2 Multi-exposure 

In the slow-moving world of scanning, multi-exposure is something 
like le dernier cri. Actually, it has been around since 2008, but it is still 
a greenhorn compared with other scanning methods. Multi-exposure 
resembles multiscanning with a few important distinctions. First of all, 
multi-exposure is designed for transparencies only; it will not work with 
refl ectives. Multi-exposure scans an image two times completely, you 
simply enable it in the Input  tab by ticking the  Multi exposure  option. 
It resembles an average 2x multiscan with  Input  ▶  Number of passes . 
Th e diff erence lies in the exposure. Traditional multiscanning exposes 
all passes in the same way. With multi-exposure, every pass has a diff er-
ent exposure. 

HDR for scanners

Multi-exposure works very much like the popular High Dynamic 
Range (HDR) imaging method in digital photography. With HDR, the
photographer takes an exposure bracketing series of a single image. 
Some of the pictures are exposed correctly, some are underexposed, 
and some are overexposed. Because the dynamic range of digital SLRs is
limited, you cannot expose the full range between highlight and dark areas
correctly in one shot. With HDR, you can combine several images into 
one image that covers the full dynamic range from highlights to shadows.  

In scanning, you have a similar initial state. Th e dynamic range cov-
ered by analog originals is bigger than the dynamic range of most scan-
ners. With multi-exposure, you can increase the dynamic range of a 
scanner, very much resembling HDR. But unlike HDR with DSLRs you 
have to keep in mind that you are working with analog originals. Multi-
exposure is only eff ective if you have good analog originals. 

2x multiscan automatically included

Multi-exposure in VueScan works with two passes. Th e fi rst pass has a 
normal exposure, and the second pass has a longer exposure. Th e com-
bination of the two produces an image that usually shows more detail 
in the shadow regions compared to a standard scan.  Multi-exposure 
elongates scanning times similar to a standard multiscan and shares 
the same side eff ects. Blurred images can result if the scanner is not 
positioning itself corrrectly, and even under the best conditions there 
can be a slight decay in image sharpness (although this decay may not 
be obvious when using a good scanner). On the other hand, fi lm grain 
and image noise usually improve, so all in all multi-exposure is a good 
option to expand the capabilities of your scanner. In VueScan, you can 
even combine multiscanning with multi-exposure if you like. But keep 
in mind that by default, only originals that have a bigger dynamic range 
than the scanner can benefi t from multiscanning. Th us, cheap scanners 
benefi t more than high-class scanners from the use of multi-exposure.
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With multi-exposure the scanner catches more details in the shadows and Photoshop can make use of this.

Standard scans sometimes lack details in the shadows, Photoshop cannot fi x this completely.

696.2 Multi-exposure

Multi-exposure 
disabled

Multi-exposure 
enabled
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Scanner exposure vs. multi-expo-
sure
Multi-exposure produces an eff ect 
that is similar to scanner exposure; 
but, in contrast, it expands the dy-
namic range of the scanner on the 
whole, which is the better technol-
ogy. My advice is: if you need more 
structure in dark areas of your origi-
nal, try multi-exposure fi rst. If that 
does not have the desired eff ect, 
then try scanner exposure as a last 
alternative. With a properly adjusted 
scanner and well-exposed images, 
you will not need to touch scanner 
exposure.  

6.3 Scanner exposure 

Scanner exposure is usually taken care of automatically by the scanning 
program as part of exposure control. For fi lm with normal exposure, 
this function is not really necessary and the exposure may be left  at its 
default setting. For underexposed or overexposed pictures, manipulat-
ing scanner exposure can in some cases produce better image results.

Scanner exposure directly controls the scanner hardware. It governs 
exposure time, i.e., how long the scanner lamp shines through the fi lm. 
Th e same eff ect cannot be produced later in image processing; more 
light must be physically projected through the fi lm. VueScan shows the 
eff ect in the preview window to give a point of reference. Confi guring 
scanner exposure makes sense only if your computer monitor is cali-
brated. Oft en, a scanned image looks too dark or too bright simply be-
cause the monitor is not adjusted properly. If you try to compensate for 
poor monitor adjustment with scanner exposure, the scanned fi les will 
not be usable on a calibrated monitor. 

Th e eff ects of scanner exposure are fi xed in the image fi le. Since scan-
ner exposure represents a change at the hardware level, a poor setting 
cannot be fi xed later in Photoshop or in VueScan with the  Color  tab. 
One negative side eff ect of increasing scanner exposure can be an in-
crease in image noise. On average the automatic calculation of the scan-
ner exposure will work fi ne.  You seldom need to manually set this. But 
you can try manual settings: For overexposed images, reduce scanner 
exposure to lessen image noise. Th is may salvage image areas that would 
be blown out by the scanner light on the standard setting. For underex-
posed images, increase scanner exposure. 

Scanner exposure does not work miracles; it merely helps to recover 
some detail in poorly exposed images. Th e results of using scanner ex-
posure can never match a properly exposed shot. Th e best practice is 
always to ensure correct exposure at the moment you take the picture.

RGB Exposure and Analog Gain 

VueScan provides two options for controlling scanner exposure 
when scanning transparencies:  Input  ▶  RGB exposure  and   In-
put  ▶  Red/Green/Blue analog gain . RGB exposure controls the 
overall exposure for all three color channels together; it is available 
with most scanners. Analog gain is a special feature of some Nikon 
scanners that allows you to control the brightness of each color 
channel separately. Most scanners will not support Analog gain, 
but some do. In both cases, you physically control how much light 
is used for the scan. Th ese settings even aff ect the appearance of 
the RAW fi le and should not be mixed up with the settings in the 
Color Tab. In the Color Tab, you only confi gure how the RAW fi le 
is processed, and that is a diff erent cup of tea.
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This is the analog original of a book cover. 

See the enlarged scans on the next page.

716.4 Descreening

Descreening is not a must
If you are a minimalist and just want 
to reproduce the print 1:1 (e.g., for a 
facsimile), scan it like a photo print 
without any descreening. This will 
ensure optimal sharpness, but you 
will have to live with the raster. 

Consumption of  processing power
Descreening is a fi lter that consumes   
quite a lot of resources even when 
you own a modern multicore com-
puter system. If you descreen high 
resolution scanning fi les of large 
analog originals, you can bring al-
most any current computer system 
to its limit, especially when you use 
it in combination with the output 
size reduction. Having a 64-bit op-
erating system with suffi  cient RAM is 
defi nitely an advantage in this case. 

6.4 Descreening 

Th e printing methods used for books, newspapers, and magazines 
must be cost effi  cient; this factor is more important than anything else. 
Since halft one printing is the most economical way to produce huge 
print runs at aff ordable costs, it is used for virtually every mass-printed 
item available on the market. If you want to scan an image from a book, 
newspaper, or magazine, you will for sure run into challenges due to its 
halft one printing, or better put, to its raster. 

In halft one printing, every digital image fi le is converted for the print. 
Th e pixels of the source fi le transform into a printable raster. You can 
check this raster easily; just grab your grandmother’s reading glasses 
and examine any picture printed in this book. Th e distinctive raster is 
easily visible. 

During scanning, you may want to convert this raster image back 
into a proper image, but that is diffi  cult. First, there is a good chance that 
you will get some moiré when scanning the raster image. Second, you 
usually don’t want to scan a facsimile of the printed image, but rather to 
rebuild the original image as closely as possible. However, the printed 
raster contains much less image data than the original source fi le, and 
thus it is impossible to get the original image back via scanning. Your 
only option is to restore the scan as far as possible with the descreening 
functionality of VueScan.  

Descreening is activated by default when you scan magazines or 
newspapers. You cannot switch it off  in this mode, only choose its mag-
nitude (1 to 300 dpi). For a quick comparison between a descreened 
scan and one that has not been descreened, do a preview and switch  
Input  ▶  Media  from Magazine  to Color Photo. Especially when you 
zoom in, the diff erence is quite obvious. Th e descreening fi lter polishes 
the scan, and the printing raster disappears. As a side eff ect, the overall 
sharpness of the scan suff ers a little bit.  

Finding the correct setting is tricky, as there is no standard raster 
around. In many cases, a setting of 75 dpi produces good results, but if 
you want to fi nd the best setting you may have to experiment. Th e opti-
mum setting depends not only on the printing method but also on the 
paper. You can save a lot of time during the process if you scan in raw 
mode. In that case, aft er you scan the original once, you can produce a 
couple of scans at diff erent settings with no holding time in between. If 
you have to rescan, this surely takes more time. 

Descreening in VueScan  

VueScan off ers an integrated fi lter at  Input  ▶  Descreen dpi . It 
pops up when you choose the options Magazine or Newspaper in
 Input  ▶  Media . You can only choose descreening for refl ective 
originals; it is not accessible for transparent media because they 
use a diff erent printing method. 
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72 6 Special Scanning Techniques

The  Descreening  fi lter deburrs the scan. The single dots of the print are less obvious after fi ltering but the overall sharpness will suff er a 

little bit.  Descreening  consumes a lot of processing power, especially with big scans. 

Pictures in magazines or books show distinctive patterns especially when scanning with high resolution. You can reduce this raster with a

 Descreening  fi lter in VueScan.

Descreening disabled

Descreening enabled
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General workfl ow suggestions  
Clever use of output size reduction 
Generic RAW scanning workfl ow  
Paper documents - Scanning text
Newspapers - Scanning text and pictures in black-and-white
Magazines - Scanning text and pictures in full color
Photo prints - Scanning printed images
Color slides - Scanning E6 and K14 transparencies
Color negatives - Scanning C41 negatives
 Black-and-white negatives - Classic and chromogenic fi lm

Scanning Workfl ows
Proper scanning workfl ows are a matter of nuts and bolts 
when you are serious about archiving your analog documents 
as digital fi les. Every document type needs its own specifi c 
workfl ow. Th is depends not only on the analog original and 
the scanner, but also on the intended use of the fi les in the 
future. Th is chapter contains an overview of general workfl ow 
suggestions and specifi c recommendations for current types 
of analog originals, both for fl atbed and fi lm scanners.  
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74 7 Scanning Workfl ows

7.1 General workfl ow suggestions  

In general, there are two ways to scan your analog originals: the fast 
way and the accurate way. Both are not possible at the same time, so 

you need to fi nd a compromise for economical scanning. Th is may be 
disappointing from a pixel peeper’s point of view, but everybody who 
has to scan more than a handful of originals will appreciate this ap-
proach. And that’s what it’s all about: you want a good result in reason-
able amount of time, which requires diff erent workfl ows for diff erent 
types of originals. Don’t try to achieve the absolute best quality! Instead, 
try to discover the most suitable settings for your individual purpose.  

Input tab 

Th e most important settings on the  Input  tab are  Input  ▶  Scan resolu-
tion  and  Input  ▶  Bits per pixel . Th ese settings determine the size of 
the RAW scan that VueScan will have to handle internally. If you use 
the maximum settings, you can easily bring even a powerful computer 
system to its knees. For example, scanning an 81/2" x 11" paper document 
in 64-bit RGBI with a full optical resolution of 4800 spi will result in a 
16.6 GB monster fi le! Scanning the same document in 48-bit (you don’t 
need the infrared channel here) with a resolution of 300 spi will result in 
a much smaller image fi le, approximately 50 MB. 

Please keep in mind that we are talking here about the input side 
of the scanner—i.e., the raw image fi le that the scanner has to handle 
internally. Th e actual output is confi gured in the  Output  tab, and that’s 
a completely diff erent story! Th e lower the resolution and color depth, 
the faster your scanner will work. Using features like  Input  ▶  Multi 
scanning  and  Input  ▶  Multi exposure  will increase the size of the 
raw fi le at least as long as the scanner is working. For multi exposure, 
it will double, and for multi scanning, the factor will be identical to the 
number of passes/samples. In both cases, output size is not aff ected, but 
internal processing speed will be. 

Crop tab 

Cropping is an essential part of every scanning workfl ow, but there are 
defi nitely smarter ways to do it than adjusting the crop box individually 
for each scan. Th e best practice is to use fi xed crop sizes for standardized 
analog originals like 81/2" x 11" paper documents. Th en all you have to do 
is change the documents, and there is no need to worry about the crop.

Slides and negatives present a diff erent issue. Th ey may be all 35mm 
fi lm, but the actual size of each image will vary from camera to camera, 
and even the lens can have an eff ect. Using Auto for  Crop  ▶  Crop size  
is not 100% reliable, although it usually delivers good results. One solu-
tion is to simply scan full frame (e.g., 24 x 36 mm) and do the cropping 
aft erwards. Just remember to confi gure  Crop  ▶  Buff er  accordingly to 
keep the black borders from having an eff ect on the exposure. 

Batch scanning
One option that can save you lots of 
work is using document/fi lm feed-
ers. Instead of having to change 
the originals manually, you can just 
start a batch with an automatic 
feeding unit and let it work unsuper-
vised. With  Crop  ▶  Multi crop , you 
can do batch scanning e.g., with a 
fl atbed scanner that has several 
slides in the scan tray at once. 
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757.1 General workfl ow suggestions  

Using fi le compression
An important factor in the output 
process is fi le compression, with var-
ious options depending on the fi le 
type. By all means, use these options 
to reduce your image fi le size and 
save precious storage space, but be 
aware of potential quality and com-
patibility issues that might pop up 
due to inappropriate settings. 

Filter tab 

In many cases, fi ltering is both crucial and a good opportunity to wreck 
your scans completely. Th ere are two ways to handle it: either use a set-
ting that matches your scans 100%, or use RAW scanning instead. With 
RAW scanning, you can conveniently try diff erent settings without a 
single rescan. If you apply the fi lters directly to the image fi le—as with 
TIFF or JPEG—you should be confi dent about what you are doing. Th e 
Medium setting of  Filter  ▶  Infrared clean  is usually a good choice for 
negatives and slides; grain reduction is more of an issue, as the amount 
of grain can vary even among diff erent slides of the same fi lm. However, 
subsequent changes are only possible in the standard workfl ow if you 
rescan. Scanning raw is the better option.  

Color tab 

Similar to the fi ltering options, this tab off ers a row of diff erent settings 
for color correcting your scan. Color correction can be tricky, especially 
for slides and even more so for negatives. Due to the aging process of 
fi lm, a matching fi lm profi le in VueScan cannot guarantee perfect col-
ors, and manual correction may be needed. Th us the recommendation 
is standard settings for uncritical originals; for the rest, raw scanning is 
simply the best choice.  

Output tab 

Th e  Output  tab is the point of no return. Here you decide the type and 
specifi cations for the output images. Th e options are RAW, PDF, TIFF, 
and JPEG, and you can fi nd detailed descriptions of them in chapter 4, 
which deals with fi le formats.

Raw scanning is perfect, but only if you are willing to open the fi le 
once more in the scan program for conversion to another image format. 
You can, of course, post-process DNG in Adobe Lightroom, but the full 
scanning functionality is only available in VueScan.  PDF is a very con-
venient and widely distributed format for electronic documents, but it is 
not well suited for post-processing. Use PDF when you are happy with 
your fi les as they are, as everybody can easily handle even multipaged 
PDFs. For electronic document transfer, they are perfect. 

For image post-processing, TIFF is the best choice. If you want to 
tweak your scans in Photoshop, TIFF is defi nitely better than PDF. Re-
member that PDF is not an image format, and this comes with certain 
restrictions. JPEG is a native image format, but due to the compression 
algorithms it has some shortcomings that you can easily avoid by using 
TIFF, especially the 16-bit version. 

All in all, the fi le format you choose depends on what you want to 
do. For post-processing scans, choose RAW; for image post-processing, 
choose TIFF; for immediate output with little or no post-processing, 
choose JPEG or PDF (i.e., JPEG for images and PDF for documents).
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Careful selection of originals 
The most effi  cient way to save time, 
eff ort, and storage space is to select 
the originals you want to scan care-
fully. Most people prefer doing it the 
other way around. They scan every-
thing fi rst and then delete the scans 
they don’t want at a later stage. This 
is a great waste of time and resourc-
es. Examining the analog originals 
fi rst is simply much faster than scan-
ning. Especially if you have a big 
slide collection and you examine it 
with a loupe and a light box, you will 
fi nd out for sure that not every pic-
ture is worth preserving. To sum up: 
a properly structured analog archive 
and a careful selection process can 
dramatically reduce the number of 
analog originals for scanning. This 
is the real secret to effi  cient and fast 
scanning of big archives.

7.2 Clever use of output size reduction 

For maximum image quality, you should use the highest optical resolu-
tion for scanner input—but only if the analog original requires it! With 
VueScan’s output size reduction feature, you can reduce the scan’s fi le 
size in many cases without any eff ective loss of image quality—as long 
as you know what you’re doing! Check these factors: 
1. Nominal optical resolution of the scanner (see the scanner packag-

ing) 
2. Eff ective optical resolution of the scanner (check good reviews like 

www.fi lmscanner.info) 
3. Quality of the analog original (this depends on various factors)
4. Pixel size of the raw data that VueScan uses internally (see  Input  ▶

  Scan resolution  and  Input  ▶  Bits per pixel ) 
5. Pixel size of the output fi le (reduce it with size reduction in the  Out-

put  tab) 
Th e following examples show how to approach for diff erent scanner 
types. It depends all on the eff ective resolution of the scanner used.

In most cases you will get no eff ective gain in image quality when you 
use 4000 spi instead of 2000 spi with the Nikon. Th e scanner can deliver 
this resolution, but most analog originals simply don’t have the quality 
to justify 2000 spi. Instead, you only waste storage space on a large scale 
by doing so. 

Th ere are now two ways to create an output fi le at 2000 spi with the 
Nikon. Th e fi rst is to scan directly at 2000 spi. Resolution-wise, this is 
suffi  cient, and it’s actually the fastest way as scanners tend to work faster 
when scanning lower resolutions. 

But for maximum image quality, you should use output size reduc-
tion instead. Confi gure  Input  ▶  Scan resolution  at 4000 spi and  Out-
put  ▶  TIFF size reduction  at factor 2. Th is will convert the 4000 spi scan 
into a 2000 spi fi le—eff ectively, the fi le size will shrink from 160 MB to 
40 MB! But the main reason for using output size reduction instead of 
scanning directly at 2000 spi is reducing image noise. Shrinking a 4000 
spi scan to a 2000 spi output fi le has a positive eff ect on image noise—
there is simply less of it left . Th at’s the reason why it can be justifi ed to 
scan 4000 spi, even when your desired output size is only 2000 spi. 

Scanning 35mm with a good fi lm scanner

Th e Nikon Coolscan 5000 has a nominal optical resolution of 4000 
spi. Its eff ective optical resolution is roughly 3900 spi, a minimal 
diff erence. You could say that its optical and eff ective resolutions 
are more or less equal. If you scan a slide at 4000 spi, the scan 
fi le will have roughly the same quality. Th e question now is: Will 
the slide actually need a 4000 spi resolution that produces 160 MB 
TIFF monster fi les in 64-bit? 

Vue_book_large.indb   76 13.04.2011   19:46:04

www.filmscanner.info


777.2 Clever use of output size reduction 

Absolute fi lesize and resolution
In general, the bigger the source fi le, 
the better the image noise reduc-
tion if you use downsizing. In theory, 
that would justify a 4800 spi scan for 
300 spi output, but this would cause 
problems—especially for larger 
originals. Apart from the super-slow 
scanning process at high resolution, 
the computer cannot process a fi le 
like this. An 81/2" x 11" print scanned 
at 48-bit (no need for Infrared clean 
at this point) has terrifying size of 
12.4 GB. Even the fastest 64-bit com-
puter system will struggle with it, 
and of course the whole scenario 
is like cracking nuts with a sledge-
hammer. Better to use an input scan 
resolution of 600 spi (that’s 200 MB 
the computer has to process) and 
reduce the fi le to 300 spi during out-
put. Then you will have a 50 MB TIFF 
fi le which is much leaner than the 
original input size.

Th e fi rst step in the example above is to fi nd out the precise desired 
output size. A scan fi le is not a vector fi le that you can scale without side 
eff ects to any desired size (in this case, 1600 spi). Instead, if you just 
divide the optical resolution by even numbers, you will get resolution 
steps of 4800/2400/1200/600/300 spi. Accordingly, for 1600 spi, we have 
to pick the 2400 spi output size in this case. Confi gure   Input  ▶  Scan 
resolution  at 4800 spi and   Output  ▶  TIFF size reduction  at factor 2. 
Th is will convert the 4800 spi scan into a 2400 spi fi le and eff ectively 
shrink the fi le size from 240 MB to 60 MB. You will preserve the full 
optical quality of the 4800 spi scan—eff ectively, a puny 1600 spi—and 
you will reduce image noise as an appreciated side eff ect as well. 240 
MB may not sound much when you have a multiple-gigabyte sized hard 
disk, but if you scan more than a couple of originals, storage place will 
defi nitely become an issue. 

Image editing: VueScan vs. Photoshop 

For the best image quality, every scan can potentially benefi t from man-
ual corrections, e.g., tonal and contrast corrections and unsharp mask-
ing. By default, most scans look a bit dull, like raw diamonds that need 
cutting to shine in full grandeur. VueScan off ers some basic options for 
color and tonal value adjustments directly in the program. Most of them 
(though not scan-specifi c things like fi lm profi les, of course) can be con-
fi gured either in Photoshop or in VueScan. And that’s what the user has 
to decide: Do you use VueScan or Photoshop for image editing? 

In the author’s humble opinion, VueScan is a great scan program, but 
Photoshop is defi nitely better suited for image editing. Th erefore, the 
guideline for all workfl ows in this chapter is, “Adjust what is necessary 
in VueScan, but do the fi ne tuning in Photoshop during post process-
ing”. Th is is more convenient and usually delivers better results, than 
trying to do everything in VueScan. Photoshop has more sophisticated 
options and tools for image editing than any scan program on the mar-
ket. You can of course use any other good image editing program, there 
are many like the open source program GIMP.

Scanning 35mm fi lm with a good fl atbed scanner 

Th e Canon CanoScan 8800F has a nominal optical resolution of 
4800 spi. Th e eff ective optical resolution is roughly 1600 spi—quite 
a big diff erence. For best quality you will still have to use the 4800 
spi setting, that will result in fi les sizes of heft y 240 MB if scanning 
35mm slides in 64 bit. Th at means you will waste storage space on 
a large scale, as the eff ective resolution is just 1600 spi. Scanning 
at a lower resolution than 4800 spi might not use the full opti-
cal quality of the scanner—which is desired  for color slides. Th e 
question is now: How can you scan in 4800 spi and still produce 
an output fi le that just covers the eff ective resolution of 1600 spi?  
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Raw scanning and physics
With raw scanning you have a wide 
range of post processing options 
without any need to rescan the 
original. Still, you have to respect 
the physical limits. Wrong crops or a 
severe misconfi guration of the scan-
ning program can still wreck your 
scan. That’s why you have to scan 
carefully, even when you are using 
raw.

7.3 Generic RAW scanning workfl ow  

Th e diff erence between the classic scanning workfl ow and the RAW 
workfl ow may seem tiny at fi rst, but it is actually signifi cant. A RAW 
fi le is more than just another output fi le. Let’s take a look at the classic 
workfl ow fi rst: 
1. Insert analog original in scanner 
2. Make comprehensive adjustments in scan program  
3. Scan analog image 
4. Output image fi le 
Th is is a lean workfl ow, and subsequently you can post-process the 
scans in an image editor if needed. Th is workfl ow is perfect for quick 
results, but it has a major disadvantage: if you confi gure some adjust-
ments wrong, you will have to rescan the analog original. In many cases, 
a rescan is the only option if you are not happy with the outcome of the 
fi rst scan. Th is scenario can generally be avoided if you use a RAW scan-
ning workfl ow. Th e RAW workfl ow has more steps: 
1. Insert analog original in scanner 
2. Make basic adjustments in scan program  
3. Scan analog image 
4. Output RAW fi le  
5. Input RAW fi le in VueScan 
6. Make advanced adjustments in scan program  
7. Scan RAW fi le 
8. Output image fi le  
Th e big advantage of the RAW workfl ow is that it separates pure scan-
ning from processing. Of course, there are some physical limitations to 
consider. If the crop of the fi rst scan is too tight, you will have to rescan, 
no matter whether you used RAW or TIFF in the fi rst place. Th e same 
is true of settings like  Multi exposure  and  Multi scanning . But usually 
it’s the tricky color and fi ltering options that give you a hard time, and 
this is where the RAW workfl ow scores better than the standard work-
fl ow. You can try out diff erent settings and create diff erent output fi les 
without having to rescan once. Th is works perfectly even with  Infrared 
clean . 

Archiving in RAW

RAW fi le output is the perfect method for archiving. Nowadays VueScan 
uses DNG for RAW output, and you can easily administer this in RAW 
converters like Adobe Lightroom (but only to some degree). Lightroom, 
Aperture, and the like are all designed for digital camera RAW. Th us 
they have no specifi c options for scanning. For full functionality you 
will need to use VueScan for the conversion process. Still, with DNG 
you have a wide option of viewing programs and image editors for fur-
ther processing. Th at’s a big improvement compared to the TIFF-RAW 
that VueScan used in the early days of raw scanning. RAW output is now 
a suitable alternative for building up an archive.
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797.3 Generic RAW scanning workfl ow  

Mandatory confi guration steps before scanning RAW 

Raw scanning involves more than just inserting the original into the 
scanner and pressing a button. Th ere are some confi guration steps that 
you must execute fi rst. What you’re doing is creating the basis for a good 
RAW fi le, and if you make a mistake you can easily wreck the whole 
process. Below is a list of the confi guration steps to do before scanning 
in RAW.  
1.  Input  ▶  Bits per pixel 
2.  Input  ▶  Scan resolution  /  Quality  
3.  Input  ▶  Number of passes  /  Number of samples 
4.  Input  ▶  Multi exposure 
5.  Input  ▶  Lock exposure  (rarely needed in daily use) 
6.  Crop  ▶  Crop size  (if you don’t want to crop now, scan full size with

 Crop  ▶  Buff er ) 
7.  Crop  ▶  Focus X/Y off set  (focusing before scanning is important if 

your scanner supports it) 
8. Output fi le format: TIFF RAW or DNG RAW
9. Color depth: 24-bit for refl ectives and 64-bit for transparencies are 

in general recommendable.
Th e option  Input  ▶  Lock image color  has no eff ect on raw scans, none 
of the options in the  Color  tab have an eff ect either. You might not 
need to confi gure each option for all scans, but if you need them, you 
must confi gure them before the scan. Other options like image rotation, 
skewing, or mirroring are not mandatory, and you can easily do them 
later—though it is more convenient for post-processing if you do them 
right away in the scanning workfl ow.  

None of the settings in the  Color  tab are saved into the RAW fi le. You can conveniently try out diff erent settings at a later stage without 

rescanning when you do raw output.
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7.4 Paper documents – Scanning text 

Th is workfl ow is for scanning text, like black-and-white computer printouts or typewritten documents. Th e 
aim is not a 100% true-to-detail facsimile, but rather a lean and economical digital conservation of the analog 
text. Th is is the perfect workfl ow for scanning large document archives.
Basic workfl ow
Tab Option Setting Remarks
Input Media Text Th e options Color photo or B/W photo would work 

as well, but the Text option does most settings 
automatically.

Input Media size As needed When scanning standardized paper documents 
like 81/2" x 11", it is useful to confi gure  Media size  
accordingly. Th e scanner will save time by only 
scanning that portion of the tray. 

Input Bits per pixel 1-bit B/W Th is option is for typewritten documents or black-
and-white prints. Th e aim is not to create a 1:1 
facsimile but to preserve the analog text digitally.

Input Multi page As needed Enable this option if your original document has 
more than one page and you want to output the 
whole document as a single fi le.

Input Scan resolution 300 dpi Th is is the fastest and easiest setting for 300 dpi 
output.

Input Auto save Scan Th is option saves the scan automatically aft er 
scanning.

Crop Crop size Maximum Note that size confi guration is done already on the  
Input  tab.

Color Th reshhold As needed Usually the default setting is fi ne, but if necessary 
you can change the threshold between black and 
white manually.

Output PDF fi le Enable For documents, PDF is usually the best choice.
Output PDF multi page As needed Enable this option if your original has more than 

one page (compare  Input  ▶  Multi page ) and you 
want the output of the whole document in a single 
PDF fi le. If not selected, you will get a separate PDF 
fi le for every page.

Output PDF fi le type 1-bit B/W --
Output PDF 

compression
On Th is option will switch the embedded image fi le 

from TIFF to JPEG, further shrinking the fi le size.
Output PDF paper size As needed Use this option to switch to the desired output size. 

Usually it equals the  Media size  of the  Input  tab.

80 7 Scanning Workfl ows
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For all variations, use the basic confi guration of the workfl ow above and change only the settings described 
below.
Variation A - Using OCR text recognition
Output PDF OCR text Enable When this option is enabled, OCR tries to recognize 

the scanned text. You can then use the copy, paste, 
and search functions for your PDF.

Output OCR text fi le Enable Th is option writes the OCR text into a separate text 
fi le. Th is is the easiest way to edit the text manually. 

Output OCR text 
language 

As needed Use this option to select the text language. It 
improves the OCR recognition rate remarkably.

Variation B - Scanning full color 
Input Media Color photo Th is option enables full-color scanning. Full-color 

scanning needs much more storage space than 
grayscale scanning.

Input Bits per pixel 24-bit RGB Th is option enables full-color scanning.
Filter Sharpen Enable Th is option makes the output crisper.
Color Various options As needed In this mode, you have full access to options like

 Color balance ,  Curves , etc. Usually you do not 
need them for scanning text.

Output PDF fi le type 24-bit RGB Th is option enables full-color output.
Variation C - Scanning grayscale
Input Media B/W photo Th is option enables grayscale scanning.
Input Bits per pixel 8-bit Gray Th is option enables grayscale scanning.
Filter Sharpen Enable Th is option makes the output crisper.
Color Various options As needed In this mode, you have full access to options like  

 Curves .
Output PDF fi le type 8-bit Gray Th is option enables grayscale output.

817.4 Paper documents – Scanning text 
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82 7 Scanning Workfl ows

7.5 Newspapers – Scanning text and pictures in black-and-white

Th is workfl ow is only for scanning black-and-white newspapers. Scan full-color newspapers like magazines. 
Th e aim is to conserve the original analog text and pictures in a lean and economical way. Since the quality 
of the originals is usually quite poor, descreening helps to squeeze the best possible scans from the analog 
originals.  
Basic workfl ow
Tab Option Setting Remarks
If the backside of the page shines through during scanning, it helps to put a piece of black cardboard 
behind the newspaper page.
Input Media Newspaper Th is setting is mandatory, as it enables the 

descreening option. It also sets some of the 
subsequent options automatically. If you do not 
want to use descreening, switch over to B/W photo.

Input Descreen dpi 75 Th is default setting works very well for most 
newspapers. 

Input Media size As needed Newspaper sizes are not standardized and are 
usually much bigger than 81/2" x 11". Use an 11" x 17" 
scanner for full-format scans and set the  Media size  
to Maximum. For cropping, use the  Crop  tab. 

Input Bits per pixel 8-bit Gray Using grayscale is mandatory for preserving the 
images. 8-bit is usually suffi  cient for newspapers, as 
the print quality is quite low. 

Input Multi page As needed Enable this option if your original document has 
more than one page and you want to output the 
whole document in a single fi le.

Input Scan resolution 300 dpi Th is is the fastest and easiest setting for 300 dpi 
output.

Input Auto save Scan Th is option saves the scan automatically aft er 
scanning.

Crop Crop size As needed Confi gure the crop size to cover the entire 
newspaper page. For subsequent pages, you won‘t 
need to readjust the crop.

Filter Sharpen Enable Remember that the output is PDF, so you must 
sharpen in VueScan.

Color Color balance White balance You can do a lot of labor-intensive fi ne tuning in the  
Color  tab. For scanning newspapers, it is usually 
suffi  cient to switch to White balance. 

Output PDF fi le Enable For documents like newspapers, PDF is usually the 
best choice.
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837.5 Newspapers – Scanning text and pictures in black-and-white

Output PDF multi page As needed Enable this option if your original has more than 
one page (compare  Input  ▶  Multi page ) and you 
want the whole document in a single PDF fi le. If not 
selected, you will get a separate PDF fi le for every 
page.

Output PDF fi le type 8-bit Gray Th is option is needed to preserve the color 
information of the scan.

Output PDF 
compression

On Th is option switches the embedded image fi le from 
TIFF to JPEG, shrinking the fi le size.

Output PDF paper size As needed Th is option switches to the desired output size, 
which should be at least the same as the input size. 
In general, it is best to use one of the standardized 
paper sizes in the dropdown list. 

For all variations, use the basic confi guration of the workfl ow above and change only the settings described 
below.
Variation A - Using OCR text recognition
Output PDF OCR text Enable When this option is enabled, OCR tries to recognize 

the scanned text. You can then use the Copy, Paste, 
and Search functions for your PDF.

Output OCR text Enable Th is option writes the OCR text into a separate text 
fi le. Th is is the easiest way to edit the text manually. 

Output OCR text 
language 

As needed Use this option to select the text language. It 
improves the OCR recognition rate remarkably.

Variation B - Facsimile scanning
Facsimile scanning is the 1:1 reproduction of the analog original. Th us, it is slightly sharper than a descreened 
scan. However, the fonts are more diffi  cult to read, and the pictures show the distinctive marks of the printing 
method. Facsimile scanning is used to preserve the original newspaper when you plan to do some post-
processing later. For any kind of retouching and restoration, a facsimile is the perfect ground-level state.
Input Media B/W photo Th is option enables grayscale scanning.
Filter Sharpen Disable If you do post-processing, sharpening should 

happen at the very end of the workfl ow and not 
during scanning.

Output TIFF fi le Enable For post-processing, TIFF is the best choice. 
Output TIFF fi le type 8-bit Gray You can upgrade to 16-bit if you like, but for most 

originals this is simply not needed but only a waste 
of precious storage space.
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7.6 Magazines – Scanning text and pictures in full color

Th is workfl ow is for scanning full-color magazines and full-color newspapers. Th e aim is to conserve the 
original analog text and pictures in a lean and economical way. When compared to newspapers, the print 
quality of magazines is usually better because the paper quality (not necessarily the printing method) is better. 
Spending more eff ort on full-color originals results in better scans. Descreening is a powerful tool to help 
squeeze good scans even out of demanding analog originals. 
Basic workfl ow
Tab Option Setting Remarks
If the backside of the page shines through during scanning, it helps to put dark cardboard behind the page. 
Due to the better paper quality of magazines as compared to newspapers, this is seldom necessary.
Input Media Magazine Th is setting is mandatory, as it enables the 

descreening option. It will set some of the 
subsequent options automatically. If you don‘t want 
to use descreening, switch to  Color photo  instead.

Input Descreen dpi 75 Th is default setting works very well for most 
magazines. 

Input Media size As needed Th e size of magazines is usually around 81/2" x 11". If 
the magazine does not match one of the predefi ned 
values, choose the smallest dimension that fi ts the 
original and make fi ne adjustments in the  Crop  tab.

Input Bits per pixel 24-bit RGB 24-bit is usually suffi  cient for magazines, as the 
print quality in absolute terms is quite poor.

Input Multi page As needed Enable this option if your original document has 
more than one page and you want to output the 
whole document in a single fi le.

Input Scan resolution 600 dpi You can reduce image noise if the input resolution 
is higher than the output resolution. Scanning at an 
even higher resolution takes more time as well, so 
600 dpi is a good compromise.

Input Auto save Scan Th is option saves the scan automatically aft er 
scanning.

Crop Crop size As needed Confi gure the crop size here to cover the entire 
magazine page. For subsequent pages, you won‘t 
need to readjust the crop.

Filter Sharpen Enable Remember that the output is PDF, so you must 
sharpen in VueScan.

Color Color balance Auto levels It  is usually suffi  cient to switch to Auto levels; this 
will produce scans rich in contrast. For neutral 
colors, choose White balance or Neutral.
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Output PDF fi le Enable For documents like magazines, PDF is usually the 
best choice.

Output PDF size 
reduction

2 Factor 2 shrinks a 600 spi input fi le to a 300 dpi 
output fi le. For higher in-out resolutions, use 
adequate factors.

Output PDF multi page As needed Enable this option if your original has more than 
one page (compare Input  ▶  Multi page ) and you 
want the output of the whole document in a single 
PDF fi le. 

Output PDF fi le type 24-bit RGB Th is option preserves the color of the scan.
Output PDF 

compression
On Th is option switches the embedded image fi le from 

TIFF to JPEG, shrinking the fi le size.
Output PDF paper size As needed Th is switches to the desired output size, which 

should be at least the same as the input size. In 
general, it is best to use one of the standardized 
dimensions in the dropdown list. 

For all variations, use the basic confi guration of above and change only the settings described below.
Variation A - Using OCR text recognition
Output PDF OCR text Enable When this option is enabled, OCR tries to recognize 

the scanned text. You can then use the copy, paste, 
and search functions for your PDF.

Output OCR text Enable Th is option writes the OCR text into a separate text 
fi le. Th is is the easiest way to edit the text manually. 

Output OCR text 
language 

As needed Use this option to select the text language. It 
improves the OCR recognition rate remarkably.

Variation B - Facsimile scanning
Facsimile scanning is the 1:1 reproduction of the analog original. Th us, it is slightly sharper than a 
descreened scan. However, the fonts are more diffi  cult to read, and the pictures show the distinctive marks 
of the printing method. Facsimile scanning is used to preserve the original magazine when you plan to do 
some post-processing later. For any kind of retouching and restoration, a facsimile is the perfect ground-
level state.
Input Media Color photo Th ere is no descreening in this mode.
Filter Sharpen Disable If you do post-processing, sharpening should 

happen at the very end of the workfl ow and not 
during scanning.

Output TIFF fi le Enable For post-processing, TIFF is best choice. 
Output TIFF fi le type 24-bit RGB You can upgrade to 48-bit, but that would be like 

cracking nuts with a sledgehammer.

857.6 Magazines – Scanning text and pictures in full color
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7.7 Photo prints – Scanning printed images

Th is workfl ow is for scanning photo prints. Th e aim is to conserve the original analog pictures in a lean and 
economical way. As the quality of photo prints is usually much better than magazines, you can get much better 
image quality from photo prints. But if you have the source negative or slide, that is even better than the print. 
Scan prints only if the source negative or slide is not available.
Basic workfl ow for color prints
Tab Option Setting Remarks
Input Media Color photo --
Input Media size As needed Prints usually have a standard size, and you should 

confi gure to it if possible. If the print size does not 
match one of the predefi ned values, choose the 
smallest format that fi ts the original and make fi ne 
adjustments in the  Crop  tab. 

Input Scan resolution 600-1200 dpi You can reduce image noise if the input resolution 
is higher than the output resolution. Use 600 dpi as 
the default and upgrade to 1200 dpi for a bit of extra 
quality if needed.

Input Auto save Scan Th is option saves the scan automatically aft er 
scanning.

Crop Crop size As needed Confi gure the crop size here to cover the entire 
print. 

Filter Sharpen As needed Apply the sharpening fi lter only if you are 100% 
sure that you won‘t do any post-processing.

Color Color balance Auto levels You can do a lot of labor-intensive fi ne tuning in the  
Color  tab. For scanning prints, it is usually suffi  cient 
to switch to Auto levels; this will produce scans rich 
in contrast. For more neutral colors, choose White 
balance or Neutral.

Output TIFF fi le Enable For images that you are going to post-process in 
Photoshop, TIFF is usually the best choice. 

Output TIFF size 
reduction

2-4 Th is factor depends on the combination of your 
input resolution and your desired output resolution. 
If you choose 600 dpi for input and want 300 dpi for 
output, you need a factor of 2. If you scan at 1200 spi 
and want 300 dpi output, you need a factor of 4. In 
most cases, an output resolution of 300 dpi is fi ne.

Output TIFF fi le type 24-bit RGB Switch to 48-bit if you have appropriate data input. 
Usually 24-bit is fi ne.
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Output TIFF 
compression

Auto Th is option enables TIFF compression if it will 
actually save space. Use this option only if you are 
sure that your image editor can handle it!

For all variations, use the basic confi guration of above and change only the settings described below.
Variation A - Scanning black-and-white prints
Input Media B/W photo --
Input Bits per pixel 8-bit Gray Th is is usually suffi  cient for prints. For a bit of 

extra quality, switch to 16-bit and accept the 
subsequently bigger fi le size. If you want to get the 
best result possible at a great expense, scan in RGB 
as described above and do the conversion manually 
with Channel Mixer in Photoshop. 

Output TIFF fi le type 8-bit Gray Use grayscale output only if you are sure that your 
image editor can handle it. Th e best compatibility is 
with 24-bit RGB, but this option needs three times 
more space. 

Variation B - Batch scanning of photo prints
Th e batch scanning workfl ow described for slides in this chapter also works well when you have more than 
one photo in the scan tray. Please compare the appropriate section.

Old and faded paper prints are in many cases the only analog originals that withstood the ravages of time. When the source negatives are 

lost, you can use those old photos for scanning as well. If the negative is still at hand, you should prefer using that negative. 

877.7 Photo prints – Scanning printed images
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7.8 Color slides – Scanning E6 and K14 transparencies

Th is workfl ow is for scanning color slides. In general, fi lm is the only type of analog original that can be 
enlarged during output. In theory, you can generate A3+ poster sized prints from an analog slide (though the 
conversion from analog to digital takes its toll). You are better off  with smaller output sizes. Th e quality can be 
very satisfying if you scan a good slide with accuracy.
For any fi lm scan, the RAW workfl ow described below is highly recommended. Only a RAW fi le allows you 
to try various settings for a complete roll of fi lm without rescanning; this is quite handy, as there are many 
fi ltering options and color corrections available. If you prefer the classic scanning method, just combine the 
two workfl ows into one and skip the options related to RAW input and output. 
Basic RAW workfl ow I  - From E6 slide to RAW fi le
Tab Option Setting Remarks
Input Task Scan to fi le --
Input Source Your scanner --
Input Media Slide fi lm --
Input Bits per pixel 64-bit RGBI --
Input Scan resolution Depends on 

your scanner
Use the highest optical resolution of your scanner for 
best scanning quality. For a Nikon Coolscan 5000 
fi lm scanner this is 4000 spi; for a fl atbed scanner 
Canon 8800F it is 4800 spi. You can simply pick the 
highest resolution that VueScan displays here, but 
keep the resulting size of the RAW fi le in mind. For 
35mm, there will be no problems, but once you start 
scanning medium or large format slides you might 
have to reduce the resolution a little bit. 

Input Auto save Scan Th is option saves the scan automatically aft er 
scanning.

Perform the Preview. You can skip this to save time if the initial setup is OK.
Crop Crop size As needed Use a setting that covers the whole area of the 

slide, including the black borders. Th is will prevent 
problems with cropping, and you can process the 
scans faster. As a side eff ect, the fi le size will increase 
slightly. Instead of that, you can adjust the fi nal crop 
size at this stage.

Crop Buff er As needed Th is setting compensates for the eff ect of the black 
borders on the exposure. Usually 10% is suffi  cient.

Output Raw fi le Enable --
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897.8 Color slides – Scanning E6 and K14 transparencies

Output Raw size 
reduction

Depends on 
your scanner

Th is option reduces the high-input resolution to a 
level that matches both the quality of your slide and 
the eff ective resolution of your scanner. Use factor 2 
for either a fi lm scanner (e.g., Nikon Coolscan 5000, 
4000 spi to 2000 dpi) or a fl atbed scanner (e.g., 
Canon 8800F, 4800 spi to 2400 dpi). An output 
resolution higher than 2000 dpi is only justifi ed if 
the slide is of excellent quality and the scanner’s 
eff ective resolution is higher than 2000 spi. You can 
do this output size reduction at a later stage, too, 
but shrinking at the RAW level saves more storage 
space.

Output Raw output 
with

Scan --

Output Raw DNG 
format

Enable --

Perform the scan. Th e scanner input will be written to a RAW fi le.
Basic RAW workfl ow II - From RAW fi le to TIFF/JPEG
Input Task Scan to fi le --
Input Source File Th is option directs VueScan to the storage location 

of the RAW fi le.
Input Mode Transparency 

(or Your Scanner)
Input Media Slide fi lm --
Input Quality Archive Th is preserves the original pixel size of the scan.
Input Bits per pixel Auto Th is option uses the settings of the RAW fi le. If you 

want to change it for any reason, perform a Preview 
to update the GUI and Preview pane. 

Input Scan resolution Auto Th is uses the original resolution of the RAW fi le.
Perform the Preview. With a RAW fi le as data input, it only takes a second.
Crop Crop size Auto Th e Auto Crop setting is convenient. In the vast 

majority of cases, it delivers good results with 
no eff ort. If it fails, you can still adjust the crop 
manually. 

Filter Infrared clean As needed Check the eff ect of this option on diff erent correction 
levels, and choose the weakest setting that delivers 
satisfying results. In general, the Medium setting 
works well for most slides. 
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Color Color balance Neutral For post-processing in Photoshop, Neutral is in 
general the best setting. But it preserves the original 
color casts of the slide as well. If you want more 
correction by VueScan, try White balance instead. 
Auto levels is more of a setting for JPEG output 
when you don‘t want to do any post-processing.

Color Slide vendor As needed Adjust these settings according to your source slide. 
If there is no profi le for your fi lm, use the GENERIC 
profi le. In some cases, you can achieve good results 
with a profi le designed for another fi lm. Even when 
you are using fi lm profi les, some manual correction 
in Photoshop is usually required.

Color Slide brand As needed Compare above.
Color Slide type As needed Compare above.
Output TIFF fi le As needed Use this option if you want to post-process the 

image in Photoshop. Choose 48-bit RGB for the 
best quality.

Output JPEG fi le As needed Use this option if you do not want to post-process 
the image in Photoshop. Keep in mind that you will 
get more artifacts if you dim the settings for JPEG 
quality.

Perform the scan. Th is will convert the data input from the RAW fi le into a JPEG or TIFF.
For all variations, use the basic confi guration of the two workfl ows above and change only the settings 
described below.
Variation A - Batch scanning with fl atbed scanner 
Every fl atbed scanner can carry more than one slide at a time. Th is is perfect for batch scanning. Just 
insert the slides, do all the confi gurations, and then go off  and do something else when the scanner works 
unsupervised. In general, it is best to do diff erent batches for diff erent types of originals. Don‘t mix color 
slides with negatives, or photos with magazines or newspapers. Correctly sorted scanning is much easier.  
Basic RAW workfl ow I  - From E6 slide to RAW fi le
Crop Multi crop Custom Here you enable more than one crop at the same 

time. Usually VueScan detects fi lm holders 
automatically, but you can confi gure it manually, 
too. Switch between diff erent frames via  Input  ▶
 Frame number  or by clicking in the  Preview  pane.

Perform the Preview. 
Input Batch scan All Use this option if you want to scan all the frames in 

the batch. Choose List if you want to select frames.
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Output Auto fi le name Enable If you enable the option, VueScan will write the 
scans onto the hard disk withour further inquiry. 

Prefs External viewer Disable When this option is enabled, the viewer window 
will pop up aft er each scan.

Prefs Beep when 
done

Enable VueScan will beep when the batch is done, so you 
don‘t have to keep checking the status of the batch.

Perform the scan. 
Basic RAW workfl ow II - From RAW fi le to TIFF/JPEG
Th e workfl ow described above also works fi ne if you are using RAW fi les instead of a physical scanner. 
For easier processing, store all of the RAW fi les from one batch in one folder on your hard disk. You can 
confi gure the settings for each frame individually if needed, e.g., diff erent color settings for each frame. 
VueScan saves the settings individually for each frame, but only for the current batch. With the next 
preview, all individual settings are wiped out! Th en all frames will have the settings of the frame chosen 
during the preview. It’s best to do just one preview for each batch to avoid confusion. If you want to assign 
the current color settings of a single frame to the full batch without a new preview, you can use the option
  Color   ▶  All frames . Select it, and all frames will have the same settings. Th e  Crop  tab has an All frames 
setting as well, but usually it is of little use as the crops may vary.
Variation B - Batch scanning with a fi lm scanner
Many fi lm scanners have an automated feeding unit; one that can either handle batches of framed slides 
or an automatic feeder for fi lmstrips that works with unmounted slides and with negatives. In contrast to 
batch scanning on a fl atbed scanner, the originals are moving. Th at’s why a preview of all frames is diffi  cult 
to impossible, and the crop settings are not really accurate. 
Basic RAW workfl ow III - From E6 slide to RAW fi le
Input Batch scan Off If you switch it On, the preview is performed for all 

frames of the slide feeder, which is time-consuming 
and unnecessary. For the fi nal scan, the feeding unit 
has to transport every frame again, and the position 
can vary. Do a preview of the fi rst frame only. 

Perform the Preview.
Crop Crop size As needed Use a setting that covers the whole area of the 

slide, including the black borders. Th is will prevent 
problems with cropping, and you can process the 
scans faster. As a side eff ect, the fi le size will increase 
slightly.

Crop Buff er As needed Th is setting compensates for the eff ect of the black 
borders on the exposure. Usually 10% is suffi  cient.

Crop All frames Enable All crops will have same size and position.
Output Auto fi le name Enable VueScan will write the scans directly onto hard disk. 
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7.10 Black-and-white negatives – Classic and chromogenic fi lm

Th e workfl ow for black-and-white negatives is in general the same as the workfl ow for color slides. Apart 
from the fact that  Input  ▶  Media  should be set to B/W negative, of course. To use  Infrared clean  properly, 
you have to know exactly what kind of fi lm you are using.

a) Classic black-and-white fi lm 

Th is is silver-based, and  Infrared clean  will not work. So do your scan without the infrared channel. A 
pixel depth of 16-bit grayscale is the best choice for both input and output. 

b) Chromogenic black-and-white fi lm 

Th ere are a couple of black-and-white fi lms that you can develop in C41 like any standard color negative 
fi lm. Th ese fi lms are chromogenic and not silver-based. In this case,  Infrared clean  works perfectly, and 
you should scan with the infrared channel activated. However, VueScan does not yet support scanning 
with the infrared channel activated in grayscale mode. If you want to do raw scanning with the infrared 
channel, you have to use 64-bit RGBI. Th ere is no way to save grayscale with the infrared channel, at least 
not at the program’s current stage of development. If you want to avoid big fi les, you can either skip the 
raw process completely or use  Output  ▶  Raw save fi lm  instead. In this case, fi lm corrections like  Infrared 
clean  are written irreversibly into the RAW fi le, and you will not need a separate infrared channel. Th en 
you can choose 16-bit grayscale for output. 

7.9 Color negatives – Scanning C41 negatives

Th e workfl ow for scanning color negatives is very much the same as for E6 slides. Th e only diff erence is 
that  Input  ▶  Media  should be set to Color negative. Along with that, you will usually have to do a bit more 
post-processing in Photoshop, especially if you are using generic fi lm profi les. But this issue is not related 
to the scanning process itself, that is basic image editing.  

Prefs External viewer Disable Th e viewer window will not pop up aft er each scan.
Prefs Beep when 

done
Enable VueScan will beep when the batch is done, so you 

don‘t have to keep checking the status of the batch.
Perform the scan. 
Basic RAW workfl ow IV - From RAW fi le to TIFF/JPEG
Th is workfl ow is the same as for the fl atbed scanner.
Variation C - Scanning Kodachrome slides (K14)
Th e structure of Kodachrome is similar to classic black-and-white fi lms. Th at’s why they can’t use standard 
E6 processing but instead require the K14 process. Due to this,  Infrared clean  may not work very well; but 
this really depends on the scanner and on the development of the Kodachrome. Do some sample scans to 
fi nd out whether  Infrared clean  is a good or a bad idea for your scanner. 
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A complete reference for the  Input  tab

8
Reference – Input Tab
Th e  Input  tab is the fi rst and the most important tab in the 
graphical user interface of VueScan. Here all confi guration 
options for data input are available. With average scanning 
applications, the input options are moderate—usually little 
more than access to the physical scanner as a data source. 
With VueScan, however, this is only one of many choices. Th e 
most outstanding feature of VueScan is the ability to do vir-
tual scanning, i.e., using RAW fi les to scan directly from your 
hard disk. You don’t even need to attach a physical scanner.   
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The  Input  tab lists a variety of input options; basically, here you confi gure how VueScan reads the analog 
original. Please be aware that most settings in this tab infl uence any raw fi le as well. Th is tab also infl u-

ences all other tabs, as many functionalities vary with diff erent Input options. 
Th is chapter lists all of the options that VueScan provides in this tab. Sooner or later, you may end up 

searching for a specifi c option described here that seems to be missing from the application. In most cases, 
this is due to the fact that VueScan fades out or even removes options that are not needed for specifi c tasks 
or that are not supported by the hardware. If your hardware actually supports the functionality, check your 
settings in the other tabs. 

If a changed setting does not create the desired result, look at the  Input  tab. Most likely a change of con-
fi guration in this place will restore the missing function. At the end of the day, the entire scanning process 
depends on data input and its appropriate confi guration, which is why this tab is so important.

Input ▶ Task 

Th is is the most used option in VueScan. Here you can tell the application what data input you have and 
how to control the input process. Th ere are many more input options in VueScan than just plain scanning, 
as described below. 

 ▶ Scan to fi le 
Th is is the most commonly used option. Here you instruct the application to do basic scanning. Th e scan 
(not necessarily from a physical scanner!) will be stored on hard disk. Th e exact storage location can be 
changed in  Output  ▶  Default folder . Th is option covers the standard scanning task, but there are a couple 
of other options available for specifi c cases. 

 ▶ Copy to printer 
Scanning a document and saving it on your hard disk can be cumbersome if you just want a quick photo-
copy. In this case, use  Input  ▶  Copy to printer  instead. Th e scanner will send the data directly from the 
scanner to the Windows print dialogue. 
If you have more than one printer installed on your system, choose the appropriate printer fi rst. In this 
mode, VueScan will not save the scan in the  Output  ▶  Default folder . Assuming that you don’t touch the 
default Auto values of  Input  ▶  Media size  and Input  ▶  Scan resolution , and that you set  Input  ▶  Quality 
to Print , you will get a good quality printout that has the same dimensions as your original. Th is is a handy 
option if you want to use your scanner as a photocopier.

 ▶ Profi le scanner 
Th is option ensures that the scanner can read the image data correctly, which is crucial for exact color repro-
duction. Color characteristics can vary not only among diff erent types of scanners, but also among scanners 
of the same model and type. Wear and tear is another reason why scanners have diff erent color character-
istics. To ensure that your scanner delivers repeatable results, you must profi le it from time to time, with an 

Profi ling vs. color balance

Please be aware that the results of profi ling your scanner are independent from what you confi gure in 
 Color  ▶  Color balance . Set  Color balance  to Neutral if you want the profi led scanner to deliver the 
authentic color of the original.
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IT8 target—i.e., an IT8 refl ective or transparent original. By comparing the scan data with the target’s stored 
color information, the scanner can create a profi le and reproduce colors more accurately.

 ▶ Profi le printer 
If you want to print scanned images via VueScan on your own printer with exact colors, the above-described 
scanner profi ling is only the fi rst step. You also need to profi le your printer to ensure that it will print out the 
correct colors. Unfortunately, you might need not only one, but several profi les for just one printer. A printer 
profi le is only valid for a specifi c printer/paper/ink combination. If you use diff erent paper, you have to cre-
ate a new printer profi le. If you buy another ink, you have to create a new printer profi le as well. Even when 
you use the same printer the whole time, you will need several printer profi les. Th at’s a lot of work, but it is 
necessary to produce consistent colors.

Additionally, you should be aware that each time you change the setup of your printer, you must create 
new profi les. Th e easiest way to get around this is to use one type of paper and to avoid changing your printer 
setup once you’ve found the right working confi guration. Please be aware that the VueScan printer profi le 
has no eff ect if you use another application (e.g., Photoshop) for printing. All in all VueScan is a highly 
sophisticated scanning application and printing is not its primary fi eld of application. Use the integrated 
printer calibration of VueScan as it is convenient and free of charge. For more sophisticated purposes you 
should invest in a dedicated colorimeter and use other output applications instead.

 ▶ Profi le fi lm 
If you have already profi led your scanner, you may fi nd it confusing that there is an additional dropdown 
option for creating fi lm profi les. Th e solution for this is quite simple: IT8 calibration only works for positive 
targets, like slides or refl ectives. For negative fi lm, you need separate fi lm profi les.  

Th e colors of negatives are not only inverted, but also the fi lm has some masking applied. Standard mask-
ing for color negative fi lm is orange. In the old days, this masking made it easier for photolabs to work with 
fi lm in their chemical processes. But in regards to scanning, the inversion plus the masking presents dif-
fi culties. It’s quite tough to get a scan with correct colors from a negative. Specifi c fi lm profi les can be a big 
help. Although VueScan comes with fi lm profi les for Agfa, Fuji, Kodak, etc., you still may need an individual 
profi le if you use an exotic fi lm. To profi le a specifi c negative fi lm, grab a roll, put it in your camera, and take 
a picture of an IT8 target. Aft er the fi lm is developed, you can use this frame in  Input  ▶  Profi le fi lm  to create 
your individual fi lm profi le. 

 ▶ Make IT8 target 
VueScan already contains the image data for an IT8 scan. If you use  Input  ▶  Make IT8 target  and press the 
(Scan) button, VueScan will print out an IT8 target. If you want to see the image, press the (Preview) button. 
An IT8 target will show up that can be “scanned” just like any image you physically put in the scanner.  Input  
▶  Make IT8 target  is used solely for printer profi ling. It cannot be used for scanner or fi lm profi ling.  But you 
can actually use it to generate an image fi le that serves as a perfect blueprint of how the color reproduction 
of your scanner should be. 

Film profi les and their limits

Please keep in mind that while fi lm profi les for negative fi lm can be useful, they are far from a univer-
sal remedy. Film changes its characteristics over time. If you generate a fi lm profi le from a fresh roll 
of Kodak Gold 100, it will not necessarily match your archived negatives of Kodak Gold 100 from the 
1990s. In the best case scenario, a fi lm profi le can alleviate post-processing complexity, but manual cor-
rections are oft en needed nevertheless.
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Input ▶ Source 

Th is option allows you to choose where VueScan gets its data. With  Input  ▶  Source , you can switch between 
diff erent data sources. Data sources for VueScan include all scanners installed on the system plus the File op-
tion where you can access image fi les stored on your hard disk. If VueScan does not fi nd a scanner on the 
system,  Input  ▶  Source  is not displayed but VueScan automatically sets it internally to File. 

If you have more than one scanner installed, you can use all of them at the same time. Just open as many 
instances of VueScan as you like and use them as separate applications. While this is convenient, you need 
a powerful computer, preferably a multicore system, for working smoothly with several scanners at once. 

Input ▶ Files 

You can use this option to specify the path where VueScan can fi nd RAW scan data on your computer. By 
default, this option points to the same path specifi ed in the  Output  ▶  Default folder . 

Input ▶ Mode 

Th is option allows you to switch between diff erent scanner modes. Better fl atbed scanners usually have two 
modes. Th e fi rst is Transparency, which means the transparency unit is used for scanning slides or negatives. 
Th e second is Flatbed, which means you can scan refl ective material. Th e dropdown options in this option 
will vary depending on your scanner. 

Input ▶ Media 

Th e dropdown options in this option will vary depending on your confi guration of   Input  ▶  Source  and   
Input  ▶  Mode . Here VueScan identifi es whether your media is refl ective (e.g., a printed photo) or transmis-
sive (e.g., a negative or slide).

If you are scanning slide fi lm, you can choose either Image or Slide fi lm. If you choose Slide fi lm, fi lm profi les 
will be applied in the  Color  tab. If you choose Image, no fi lm profi les will be applied. Th e reason behind fi lm 
profi les is that each slide fi lm has a diff erent color characteristic. 

Option Transmissibility Type Color gradient Remarks
Color photo Refl ective Positive Continuous tone ---
B/W photo Refl ective Positive Continuous tone ---
Line art Refl ective Positive Bi-level ---
Text Refl ective Positive Bi-level ---
Magazine Refl ective Positive Halft one Contains a color descreen fi lter
Newspaper      Refl ective Positive Halft one Contains a b/w descreen fi lter
Image Transmissive Positive Continuous tone no fi lm correction applied
Slide fi lm Transmissive Positive Continuous tone Changes default fi lm type
Color negative Transmissive Negative  Continuous tone Changes default fi lm type
B/W negative Transmissive Negative Continuous tone ---
Microfi lm Transmissive Positive Continuous tone ---
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If you want to preserve the fi lm’s color cast, use the Image option during scanning. If you want your scans 
to match the original scenery as closely as possible, use Slide fi lm instead and pick the matching fi lm profi le 
in the  Color  tab. Th e fi lm profi le will try to remove the fi lm’s color cast. Th e option you choose is a matter of 
personal taste, as there are good reasons to justify both decisions. 

Input ▶ Descreen dpi 

Th e halft one printing method used for magazines and newspapers can cause unwanted eff ects, e.g., moiré, 
when scanning. To produce better scan results, use VueScan’s integrated descreening functionality. Usually 
the descreening default value is set to 75 dpi, which covers most imaginable cases. 

But for specifi c purposes, you can adjust  Input  ▶  Descreen dpi  in (Advanced) mode. Unfortunately, there 
is no rule of thumb to determine the best setting. It depends not only on the printing method but also on 
the paper. You will have to make some sample scans at diff erent settings to fi nd the best setting for a specifi c 
original. 

Input ▶ Microfi lm zoom 

Th is option  is designed for scanning microfi lm or microfi che. Because microfi lm contains a small-scale 
version of the original document, it makes little sense to reproduce the original at a scale of 1:1. In order to 
restore the original, you have to enlarge the scan adequately. Typical zoom values for microfi lm range from 
a factor of 8 to a factor of 14. 

Input ▶ Media size 

Th is option helps you determine the size of any refl ective media you’re scanning with your fl atbed scanner. 
In Auto, the application previews the full size of the fl atbed unit (which equals the Maximum setting) and 
tries to detect the size and location of the media. Th is auto detection is quite reliable but not necessarily as 
exact as a manual adjustment. 

Input ▶ Quality 

Th is option is used to specify the scan resolution automatically. Since transparencies, like slides, allow large 
magnifi cation scales, it can be helpful to determine the purpose of the scan in advance to save some storage 
space. For refl ectives, in most cases, this is not really an issue. Usually you reproduce refl ectives 1:1. Magni-
fi cation is, of course, technically possible but not advisable. 

If you tell VueScan what kind of output you need, it recalculates the scan resolution (i.e., the input quality) 
accordingly. Determining the best scan resolution, however, can be tricky. For this, you need to know the size 
of the scanned media, which should be available at  Input  ▶  Media size . Th en, you need to know what out-
put size (e.g., 4" x 6") is desired and what your output media is. For screen display, anything above 96 dpi is 
suffi  cient; for good quality prints, you need at least 300 dpi. VueScan off ers some standard resolution fi gures 
for diff erent purposes, which may vary for originals of diff erent sizes as you can see in the following table.

Fixed setting vs. automatic detection

If you prefer to choose a size manually in  Input  ▶  Media size , you can skip the preview step and scan 
directly. Th is is quite handy, e.g., if you are scanning letter sized refl ectives on a letter sized fl atbed scan-
ner. You choose the media size only once, which save a lot of time during scanning. 
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If you set  Input  ▶  Quality  to one of these values,  Scan resolution  will be set to Auto. As these standard 
values cannot off er a perfect solution for every circumstance, it is recommended that experienced users 
confi gure scanning resolution manually.  

Input ▶ Bits per pixel 

Here you can specify how many bits you have for each pixel of the scan, i.e., the setting for the col-
or depth of the image fi le.  By default, this option is set to Auto  and depends on the chosen media in 
 Input  ▶  Media  (if you don’t change it manually). Usually, a modern scanner can save 16 bits per pixel for 
each color channel. As scanners operate mostly in RGB mode, they have three color channels (red, green, 
and blue). A scanned image fi le can therefore contain a maximum of 48 bits (3 x 16 bits) of image data. 

Better fi lmscanners  and some fl atbed scanners also have an infrared channel (I), since they scan the fi lm 
surface with infrared light for dust and scratch detection. If you want to keep all information the scanner 
can gather, you should save your scans as 64-bit RGBI (RGB + infrared) fi les. Th e big advantage of this fi le 
format for RAW scans is that you can decide, even aft er scanning, if and at what amount you want to use 
dust and scratch removal via infrared cleaning. Th is is not possible with any pixel depth in VueScan except 
with 64-bit RGBI. 

However, RGBI requires a lot of storage space, and for many purposes the scans would be oversized. Re-
gardless of your scanner’s actual abilities, you can confi gure any bit depth you like in  Input  ▶  Bits per pixel . 
If you are scanning negatives and slides at high resolution, you can save storage space if you switch to 24-bit 
color depth instead of 48-bit. Th is will accelerate the scanning process for some scanners, and in most cases 
there is hardly any visible diff erence between a 24-bit and a 48-bit scan. Keep in mind that you cannot store 
infrared data in 24-bit scans. For infrared, you need 64-bit RGBI. 

Option Dimensions in pixels Spi Remarks
Slide 24 x 36 mm (Nikon Coolscan 5000, max. 4000 spi)
Email 708 x 472 500 spi ---
Web 1417 x 945 1000 spi ---
Print 2834 x 1890 2000 spi ---
Edit 2834 x 1890 2000 spi ---
Archive 5669 x 3780 4000 spi max. optical resolution 
Refl ective 81/2" x 11" (Scanner: CanoScan 8800F, max. 4800 spi)
Email 620 x 875 75 spi ---
Web 1240 x 1750 150 spi ---
Print 2480 x 3501 300 spi ---
Edit 2480 x 3501 300 spi ---
Archive 2480 x 3501 300 spi ---

More control with manual resolution setting

Just to reiterate: the  Input  ▶  Quality  option is designed for inexperienced users. If you are a user who 
understands the basic principles behind scanning, you are probably better off  setting the scan resolu-
tion manually. In that case, VueScan will hide the  Input  ▶  Quality  option. 
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Input ▶ Make gray from 

A scanner usually has three color channels: red, blue, and green. All three of them are used for a full-color 
scan. A good fi lm scanner has an additional infrared channel as well. But if you are scanning grayscale, the 
RGB samples that the scanner picks need to be converted into just one channel: the grayscale channel. By de-
fault,  Input  ▶  Make gray from  is set to Auto. Depending on which scanner you use, the conversion is either 
processed by the scanner hardware or by VueScan. In Auto, VueScan uses all of the RGB channels for that, 
but mainly the green color information. With  Input  ▶  Make gray from , you can choose one specifi c color 
channel to deliver the raw data for grayscale conversion: the red, green, blue, or even the infrared channel. 
For old silver-based black-and-white negatives, give the red channel or even the infrared channel (!) a try if 
standard settings do not deliver suffi  cient results.

Input ▶ Threshold 

Th is option appears in the GUI of some scanner devices during 1-bit, black-and-white scanning. You can use 
this setting to defi ne the diff erence between black and white. For example, if your original has lightly colored 
type fonts, you can increase the default value from 128 to 200 or even more. But for most modern scanners, 
this option is meaningless, and consequently it does not appear in the GUI. 

Input ▶ Batch scan 

Th is option appears in the GUI when VueScan determines a setting that can be used for batch scanning. Th is 
can happen under the following conditions: fi rst, if you are using a fl atbed scanner and you scan more than 
one picture at a time; second, if your scanner is using a slide/negative feeder; and third, if you are processing 
more than one scan fi le directly from the hard disk and the  Source  is File and not a scanner. 
In all of these cases, you can either switch batch scanning Off , enable it via All, or choose specifi c fi les via List. 
Batch scanning from the hard disk is by far the most convenient option, as you have almost no holding time. 
If you are right in the middle of a batch scan, there are two ways to stop it. Th e fi rst and fastest way is to press 
the (Abort) button, but this can lead to a half-written fi le. Th e second way is simply to change the batch set-
ting to OFF. Th e application will fi nish processing the current fi le and then stop.

Disable infrared channel, save space

For any originals that cannot benefi t from infrared cleaning, i.e., all refl ectives and classic black-and-
white negatives, you should disable the infrared channel to save precious storage space.  

RGB scanning for black-and-white originals?

VueScan’s auto conversion to gray scale is quite convenient and delivers acceptable results under nor-
mal circumstances. But if you are a quality-conscious pixel peeper, you should not use it. In fact, you 
shouldn’t even use grayscale. Instead, scan your black-and-white negatives in full-color RGB and con-
vert them manually in Photoshop. Th at way, you can use Photoshop’s RGB mixer to determine the 
perfect setting before you actually convert the scanned image into grayscale. Th ese workfl ow steps give 
you maximum control over the resulting image. For everyday use, however, this sophisticated approach 
is quite cumbersome. Besides, the characteristic color casts of aged black-and-white negatives can give 
your scans a nice vintage look. If you want to retain those color casts, simply stay in RGB mode.
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Input ▶ Batch list 

Th is option pops up when you specify List in  Input  ▶  Batch scan . Here you can select frames for processing 
if you don’t want to process the whole stack with the same settings. Th is option is more powerful than it looks 
at fi rst glance, but it’s not really user-friendly. Each frame is numbered. You can select frames individually 
and separate them by a comma (e.g., 1,3,5), choose a range of frames (e.g., 1-5), or combine both methods 
(e.g., 1-3,5). Additionally, you can rotate each frame number individually, i.e., 90 degrees to the right by add-
ing an R, or 90 degrees to the left  by adding an L (e.g., 1,2L,5R). You can even allocate mirroring by adding 
an F to the frame number (e.g., 1F). You can only allocate one letter per frame. Th at means you cannot both 
fl ip and rotate an image during batch scanning (e.g., 1RF will not work). VueScan only processes the last let-
ter associated with a frame and skips the letter in the middle. 

Input ▶ Multipage 

If you have a multipage paper document and want to convert it into a single multipage PDF or a single multi-
page OCR, choose this option. Th e (Preview) window and button will disappear, which is quite surprising to 
beginners. In this mode, you actually have to press the (Scan) button to generate a preview! Aft er each scan, 
you can exchange the originals until you have processed your stack. When the last scan is fi nished, press the 
button (Last_page). Th is will eventually generate the image fi le. You can choose either multipage TIFF or 
multipage PDF, but PDF is usually the better choice due to its superior compatibility.  

Input ▶ Frame number 

During batch scanning, the scanner has to process more than one frame. Th is happens when you attach a 
slide or negative feeder to a fi lm scanner. If you insert a fi lmstrip with six negatives, six diff erent frames will 
appear in the GUI. With  Input  ▶  Frame number , you can switch back and forth between these frames. Th e 
same eff ect can be observed when you use more than one image fi le as a source, e.g., when you do RAW 
scanning from the hard disk. But even when you just use your plain fl atbed scanner, there can be frame 
numbers. When you select  Crop  ▶  Multicrop , you can scan more than one frame on the fl atbed unit at a 
time, e.g., negative strips. 

Input ▶ Frame off set 

Th is option only aff ects scanners that work with a fi lm feeder, like Nikon scanners (Nikon LS-30, LS-40, 
LS-2000, LS-4000, LS-8000, LS-9000), the Canon FS4000 with a feeding unit, and the Polaroid SprintScan 
120 with a medium-format adapter. Here you can adjust the frame off set manually, which can be helpful in 
scanning panoramic pictures or in correcting a frame off set.  

Image editor more comfortable and accurate

Although the workings of the VueScan system are not diffi  cult to understand, the author occasion-
ally experienced some surprises—especially when batch scanning RAW fi les. Sometimes rotation was 
not processed, and sometimes the preview window and the fi le output did not match (even though 
(Preview) had been executed). Due to their long-winded handling and sometimes erratic behavior, the 
mirroring and rotating functions in VueScan’s batch scanning mode cannot really be recommended at 
the current state of the application. Any image editor will allow you to readjust your scans more con-
veniently during post-processing.
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Input ▶ Frame spacing 

Th is is another option for scanners with a fi lm-feeding unit. Here you can set the spacing between the diff er-
ent frames manually. Usually the automatic frame recognition should sort this out, but if necessary, you can 
adjust these parameters manually. 

Input ▶ Preview resolution 

By default, the resolution for the (Preview) is set automatically by various predefi ned steps. Th e default value 
is Auto, but in some cases it can be useful to set it manually. A high-resolution preview allows you to zoom 
into the preview window at a larger scale; as a side eff ect, the time needed for the preview scan will be longer. 
To speed up the workfl ow, you can set the resolution lower. In most cases, the default value is fi ne and there 
is no urgent need to change it manually. If you choose  Custom , the option  Input  ▶  Preview dpi  will pop up. 

Input ▶ Preview dpi 

Th is option allows you to fi ne tune the preview resolution even further. You can choose any value in the 
range of the scanner’s optical resolution. Th is is more a gimmick than a useful feature, as VueScan will simply 
rescale the scan. Usually you are better off  choosing one of the proposed values in the dropdown list at  Input  
▶  Preview resolution , or just sticking with the Auto value. In contrast to the fi nal scan, the preview scan is 
usually not saved anyway, so there is no reason to invest much energy in the perfect preview setting. 

Input ▶ Scan resolution 

By default, the scan resolution is set to Auto and follows the setting chosen in  Input  ▶  Quality  (e.g., Print, 
Edit, Archive, etc.). To confi gure it manually, choose one of the resolution values in the dropdown list. For an 
CanoScan 8800F in transparency mode, this would be 4800, 2400, 1200, or 600 dpi. (Keep in mind that the 
correct unit for scanning resolution still is spi, not dpi as it is labeled here.) If you switch to refl ective mode, 
300, 150, and 75 dpi will be added to this list. Consequently, the dropdown choices depend not only on the 
scanner, but also on the scanning mode. Alternatively, you can choose Custom, which allows you to choose 
scanning resolution as described below. 

Input ▶ Scan dpi 

Th is option pops up whenever you set  Input  ▶  Scan resolution  to Custom. You can either type in the re-
quired scan resolution manually or use the slider for the same purpose. Th e maximum value is the optical 
resolution of the scanner. As with  Input  ▶  Preview dpi , this is not really a useful feature. 

Editing the PDF 

In the time between scanning and fi le generation, VueScan off ers a row of editing options via the 
Page settings of the menu bar. Th e preview windows will be populated aft er the scans. You can fl ip 
through the stack. Each page is a separate frame.  Input  ▶  Frame number display the chosen frame 
number and at the very bottom of the VueScan window you can fi nd it too. You can move pages back 
and forth, deleting and adding pages as you like, and control in detail the appearance of the PDF. Aft er 
pressing the (Last_page) button, however, no more changes are possible within the scanning program-
VueScan. To edit your PDF further, choose an appropriate application like Adobe Acrobat. 
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ab A scanner can scan properly only at its optical resolution (e.g., 4800 spi) or parts of it (e.g., 2400, 1200, 

600, or 300 spi). If you choose 297 spi, the scanner will actually scan at 300 spi and scale the image down to 
297 spi. Avoid this, as image quality does usually not benefi t from rescaling. It’s better to choose one of the 
values that VueScan proposes in the  Input  ▶  Scan resolution  dropdown list.  

Input ▶ Rotation 

Here you can rotate the image. Th ere are four options: None (no rotation), Right (90 degrees clockwise), 
Flip (180 degrees clockwise), and Left (90 degrees counterclockwise/270 degrees clockwise). So, you can ro-
tate the image in all four possible directions. Th e rotation is eff ective even in RAW fi les, and for TIFF, JPEG, 
and PDF fi les as well. To minimize post-processing eff ort, it is wise to rotate images here; but keep in mind 
that this operation needs some extra memory. If you have a modern computer with at least 2 GB of RAM, 
this should not be an issue. Note: although  Input  ▶  Rotation  is located above  Input  ▶  Mirror , the rotation 
is actually performed aft er mirroring. 

Input ▶ Auto skew 

A common problem during scanning is pictures that are not aligned correctly. Even when you insert an 
original with care, it is almost never aligned straight to the grid. In this case, you can use the  Input  ▶  Auto 
skew  option. In most cases it works fi ne, and it can be switched on by default.  

Input ▶ Skew 

Th is option works similarly to  Input  ▶  Auto skew , the only diff erence being that the user decides if and at 
what degree the skew angle should be corrected. If you want no skewing at all, just uncheck  Input  ▶  Auto 
skew  and don’t touch  Input  ▶  Skew . By default, they are set to 0, which means no correction at all. 

Input ▶ Mirror 

Here you can mirror an image. Apart from experimental use, this option is used only when scanning trans-
parencies—more precisely, transparencies that you inserted upside down in the scanner by mistake. While 
you can use  Input  ▶  Mirror  to fi x this, the better alternative is to insert the originals correctly in the fi rst 
place. In most scanners, the fi lm emulsion side should be face down to guarantee optimal scanning quality. 
To sum up: try to avoid mirroring and invest more energy in properly positioning the originals on the tray.

Confusing rotation directions?

Please note that these rotation options do not correlate with the pictures shown in the Preview/Scan 
window. Instead, they relate to the unrotated image from the scanner. Th is can be confusing, especially 
when you are trying diff erent settings. In this case, set the rotation back to None and then choose the set-
ting you need directly. Th e rotation buttons directly below the Preview window ((Rotate_clockwise)/
(Rotate_counterclockwise)) are more user-friendly. Just click a couple of times and watch how the 
settings change at  Input  ▶  Rotation .
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Input ▶ Autofocus 

First of all, congratulations if you see this option in your VueScan GUI! In that case, you most likely own a 
high-quality fi lm scanner; cheaper scanners cannot usually do autofocus. Focusing can be an issue when you 
scan transparencies, but for refl ectives it is of no concern. Nevertheless, autofocus functionality is a must for 
expensive scanners with marginal depth of fi eld. Th ere are four options: Manual, Preview, Scan, and Always. 
Performing autofocus takes some time, and with the  Input  ▶  Autofocus  option you can confi gure when 
you want to focus. 

How to determine the emulsion side of fi lm

If you hold a slide at an angle and look at both sides, you will see that one side is glossy and has no vis-
ible structure. Th at is the supporting level. Th e other side will show structure like a relief image. Th at 
is the emulsion side, and it should point towards the sampling unit of the scanner. While it is possible 
to scan through the supporting level of the fi lm, it will lead to a minor decrease in scanning quality.

Setting Focusing Advantage Disadvantage Recommendation
Manual Only by user Focusing can be 

done precisely 
when it is needed

You can easily forget the 
focus, and this will result in 
unsharp images

For control freaks 
only

Preview Before Preview. 
You focus only 
once per image, 
and the Preview 
focus is used for 
the scan as well

Preview image 
will be sharp, 
allowing you to 
make your best 
judgment of the 
original 

In some cases, you can do the 
scan without a Preview. In 
this case, the scanner will not 
focus at all. In very rare cases, 
the slide can bend between 
scanning and be out of focus. 
Th e same thing can happen 
when using slide/negative 
feeders.

Default option that 
works well with 
most standard 
scanning operations

Scan Before Scan. 
No focus before 
Preview

Will ensure a 
sharp fi nal scan

Preview might be unsharp in 
some cases

Focusing before 
scanning is the best 
way to ensure a 
sharp scan

Always Before every 
Preview and every 
scan

Preview and 
scan will both 
be sharp in any 
circumstances

Th is mode is time-
consuming and in many 
cases not needed

From the quality 
point of view, this 
setting is perfect, 
but it will slow down 
your workfl ow

Vue_book_large.indb   103 13.04.2011   19:46:07



104 8 Reference – Input Tab

In
pu

t t
ab In general, the focus settings for (Preview) and (Scan) will be the same, but there are some exceptions. In 

very rare cases, the scanner light source can heat up the slide over time, causing it to bend and subsequently 
be out of focus. As modern scanners usually use cold LED lights, this is no longer an issue, and the few de-
vices with old-style lamps usually don’t have autofocus. If you use a slide/negative feeding unit that moves 
the originals, refocusing before every scan can be a good idea.  

As with any other focusing mechanism, a scanner’s autofocus can only focus on one appointed area. Th is 
focus point is marked by an animated crosshair in the Preview window. You can specify the placement of the 
focus point at  Crop  ▶  Focus X/Y off set . If you have a curly piece of fi lm, you must place it carefully on the 
scanner—the area of greatest focus will not cover the whole negative! 

Input ▶ Focus 

Here you can adjust the autofocus manually if (!) your scanner supports autofocus and (!) you have set 
 Input  ▶  Autofocus  to Manual. Please keep in mind that you must do another preview scan before you can 
see the eff ect of the focus change in the  Preview  tab. If you actually want to see the eff ect, set the preview 
resolution up to the optical resolution of the scanner and zoom in to the  Preview  tab. You can either use the 
slide control or focus with the shortcut (Crtl)+(F).

Input ▶ Auto scan 

Pressing the (Scan) or the (Preview) button is not a big deal when you insert a slide into your scanner. But 
if you scan a few hundred slides in a row without the help of a slide feeder, it would be nice if the scanner 
started working directly when you insert an original. With the  Input  ▶  Auto scan  option, you can trigger 
either a Scan or a Preview automatically. Once you abort one of these operations, the option is reset to its 
default, None, and you must enable it again manually. 

In some circumstances, this feature can be a pain—e.g., if you are working with a fi lm adapter, like the 
SA-21 for Nikon scanners, and you have a fi lm off set. In this case, you waste a lot of time on preview only to 
fi nd out that all of the images are shift ed, and you have to do previews for the whole fi lmstrip again. But if 
you are working with a single slide mount adapter, like the MA-21 for Nikon scanners, then  Input  ▶  Auto 
scan  is indeed very helpful. Blessing or curse, it all depends on your scanning hardware. 

Th is option is only displayed when the scanner can sense inserted media or when the scanner is capable 
of addressing frames separately. Some scanners, especially the Nikon fi lm scanners, can sense when you’ve 
inserted a slide or a fi lm strip.  You can use this option to confi gure an automatic action when a slide or fi lm 
strip is inserted.  Th e option is only used when the scanner can sense a media change - either a page inserted 
in a document feeder, a slide inserted into a scanner, or a strip of fi lm inserted. 

Input ▶ Auto save 

Scanning and saving an image are generally two separate steps in the workfl ow. You can see this when you 
set the  Input  ▶  Autosave  option to None. Aft er each scan is completed, you must press the (Save) button 
to save the image on the hard disk. Th e automatic setting via preview or scan is more convenient. Aft er the 
preview or scan, the resulting fi le is stored automatically. 

Manually triggering autofocus

Use the shortcut (Crtl)+(F) to start autofocusing manually. You can perform this in any mode of 
 Input  ▶  Autofocus .
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Th e location of the folder is determined in the  Output  tab at the corresponding fi le type. As a default setting, 
the Scan option is recommended; storing previews is an interesting gimmick but usually not reasonable.  

Input ▶ Auto print 

Th is output option may be helpful in some cases. Here you can print automatically aft er each preview or 
scan. By default, it is set to None, which means no automatic printout. If you just want to use the scanner as 
a photocopier, use  Input  ▶  Task  ▶ Copy to printer instead, but the scanned image will not be stored on the 
hard disk.  Input  ▶  Auto print  is just another output option that allows printing parallel to saving. It may 
be preferable simply to trigger a print manually aft er preview or scan via the command File ▶ Print Image or 
the shortcut (Ctrl)+(P). 

Input ▶ Auto repeat 

Unique to VueScan, this option provides timer functionality that starts scanning at a specifi ed off set. You 
can determine whether it is really useful or not, but either way it is an interesting gimmick. By default, it is 
disabled via None. If you change the setting to Continuous and press the (Scan) button, the scanner will start 
to scan in an endless cycle. Aft er each completed scan a new scan will start—all of the same original! While 
this is a nice feature for fatigue testing your scanner, it is not necessarily useful in daily life. 

Alternatively, you can choose time intervals ranging from 2 seconds to 8 hours. Th is is useful if you have 
a sophisticated workfl ow, e.g., if you are scanning a batch of prints and you want to do nothing more than 
change the originals in the tray. From a manager’s point of view,  Input  ▶  Auto repeat  is perfect, as you can 
dictate the desired working speed to your assistant! OK, in all seriousness, if you are doing monotonous 
scanning operations, this option can be helpful—provided you can swap the originals in the scan tray dur-
ing the specifi ed time frame. Of course, any scanner with an automatic feeding unit is a smarter solution for 
this kind of scanning task.

Input ▶ Auto lamp off  

Some scanners can switch their lamps on and off  via soft ware. Modern scanners that use LED lights usu-
ally do not have this feature, but occasionally you can still fi nd it. LEDs need no preglow time, but old-style 
fl uorescent lights do. If you switch the old lights on and off  via soft ware, there will be some time delay until 
the scanner is ready to operate again.  

When you choose None, the scanner lamp is always on and never switches off . Th e option Always switches 
the lamp off  aft er each scan and when you exit VueScan. If you choose 5 minutes, the lamp turns on when 
VueScan starts and turns off  when the application exits. Five minutes aft er the end of the scan, the lamp turns 
off  as well. Th e last option, Exit, ensures that the lamp turns on when VueScan starts and turns off  when the 
application is closed. 

Input ▶ Auto eject 

Th is option is a useful feature when you are working with automatic feeding units like the Nikon SA-21 for 
Nikon Coolscan V and Coolscan 5000. In any case, you will need hardware that provides eject functionality, 
and a simple fl atbed scanner does not.  Input  ▶  Auto eject  allows you to eject the originals automatically 
under certain conditions. With None, the scanner never auto ejects the originals. You can eject them with the 
shortcut (Ctrl)+(J) or via the menu command Scanner ▶ Eject. With Preview, the auto eject happens aft er 
the preview scan. Usually this is not recommended, as you still want to do the scan. With Scan, the auto eject 
happens aft er the scan. In general this is useful, but sometimes it is quite the opposite. 
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fi lm feeder. You scan the fi rst image with no batch scanning, as you want to scan each image individually. 
Aft er the fi rst scan, VueScan ejects the fi lmstrip although there are still 5 images to go. Th is can be rather 
annoying. But if you scan all of the images on the fi lmstrip in a batch, that’s a diff erent story. Th en VueScan 
ejects the fi lmstrip aft er scanning the last image, which is very useful. Th e last option is Exit, which ejects the 
fi lmstrip when VueScan exits. Th is is convenient, because otherwise you would have to restart VueScan to 
release the fi lmstrip.   

Input ▶ Number of samples 

If your scanner supports multisampling, this option will be visible. By default, the number of samples is 1, 
which equals a standard scan. Th e technology behind multisampling is simple: each line is read multiple 
times before the scanner advances to the next step. For noise reduction purposes, you can increase the 
number of samples up to 16—which will extend the required scanning time considerably. Multisampling 
can improve overall image quality, image noise, and grain, but image quality will not necessarily improve 
with every additional pass. As an unwanted side eff ect, the overall sharpness may suff er a bit. But this really 
depends on the scanner you are using. You will have to do some sample scans to fi nd out how pronounced 
this eff ect is with your hardware.

Input ▶ Number of passes 

For those who do not own a scanner that supports multisampling, here is the solution:  Input  ▶  Number of 
passes . When you use this option, the entire image is scanned completely and repeatedly. Th e benefi ts and 
side eff ects are similar to the multisampling, and the chance of getting a blurred image is slightly increased. 
But the results ultimately depend on your hardware, and you will have to do some sample scans to fi nd the 
best setting.

Input ▶ Grain dissolver 

Th is option exclusively aff ects owners of the vintage Minolta Scan Elite 5400 I. Th is scanner has a hardware-
based light diff user to enhance grain appearance. A similar system is used nowadays by some high-priced 
Hasselblad scanners. You can also fi nd it in some accessories like the Scanhancer (www.scanhancer.com), but 
for desktop scanners it no longer plays an important role. 

With this option, you can enable the grain dissolver in the Minolta scanner that by default is turned off . 
Minolta disposed of the whole idea quite quickly, and the Minolta Scan Elite 5400 II was delivered without 
the grain dissolver. Th en Minolta was swallowed by Sony, but that’s a diff erent story.  

Input ▶ Frame alignment 

Here is another specifi c feature that only aff ects Nikon scanners with fi lmstrip adapters (Coolscan IV/4000 
and Coolscan V/5000). With this option, VueScan analyzes the small border between the fi rst and the sec-
ond frame of the fi lmstrip and uses that information for alignment. By default, this option is enabled but you 
can disable it if needed. 

Sometimes the automatic frame alignment doesn’t work, depending on the type of fi lm or the contrast 
between the image and the gap between the images.  In this case, turn this option off , do a preview of the 
second frame, move the cursor to where the gap between the frames starts, look in the lower right corner 
for the Y off set (in millimeters), and type this value into the  Input  ▶  Frame off set  option.  Th en re-do the 
preview of the second frame and see if everything is aligned properly. 
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Input ▶ Fine mode 

Th is is an option for the Nikon Coolscan 5000 and Nikon Coolscan 9000. Th ese scanners have multiline 
CCD sensors; the Coolscan 5000 has a sensor with two lines, and the Coolscan 9000 has a sensor with three 
lines. If  Input  ▶  Fine mode  is enabled, VueScan uses only one line. Th is reduces the scanning speed, but in 
some cases it can improve the scan quality if you have dark fi lm originals. By default, this option is disabled.

Input ▶ Multi-exposure 

Th is is an interesting option when you are scanning transparencies; it is not available for refl ectives. Multi-
exposure increases the dynamic range of your scanner and can help get additional details out of an image, 
especially in the darker regions. It resembles a 2x multisampling/multipassing, but there is a major diff er-
ence. With multi-exposure, only the fi rst pass has a normal exposure. Th e second pass has a longer exposure 
to get more details out of the shadows. Multi-exposure merges the two images into one, and the new image 
subsequently has a higher dynamic range than a standard scan. Th is option extends scanning times and 
shares the same side eff ects as multisampling and multipassing. 

Input ▶ Lock exposure 

With this option, you can lock the exposure of the image when scanning transparencies. Similar to a digital 
camera, the scanner analyzes the image and tries to fi nd the appropriate exposure time via exposure mea-
surement. Under normal conditions, the exposure measurement happens for each image separately. If you 
enable this option, the exposure will be locked for subsequent images. By default, it will keep the settings 
calculated for the most recent preview or scan. To confi gure the exposure value manually, use  Input  ▶  RGB 
exposure . You will save time by locking the exposure, as the exposure measurement will be skipped. Th is 
can be useful during batch scanning, especially when you are scanning a roll of fi lm and want to produce 
consistent colors. It will lock the exposure of the raw fi les only without directly aff ecting the fi nal images. 
Th is must be done by enabling  Input  ▶  Lock image color . By enabling  Input  ▶  Lock exposure , the addi-
tional options  Input  ▶  RGB exposure  and  Input  ▶  Infrared exposure  will appear in the GUI. 

Input ▶ RGB exposure 

Th is option allows you to control the exposure time of the scanner by controlling RGB brightness, provided 
you have a scanner that can vary its CCD exposure time. Under normal conditions, there is no reason to 
adjust exposure time manually; the automatic exposure is quite reliable. Like  Input  ▶  Lock exposure , this 
option aff ects the raw fi le, and the fi nal image output can be diff erent due to the settings in the  Color  tab. 
Changes in  Input  ▶  RGB exposure  can have some unwanted side eff ects. By increasing the exposure, you 
can in fact squeeze out some more details out of dark areas of the slide. But the dynamic range of a scanner is 
limited, and most likely your scan will have clipped highlights. In rare cases, you can use this option to save 
some details in underexposed or overexposed originals. But for daily scanning, you are better off  not touch-
ing this option. Using  Multi exposure  is usually better than tweaking the exposure.  

Input ▶ Infrared exposure 

Th is option controls the exposure of the infrared channel, if your scanner has one. Th e infrared channel 
is not a visible part of the fi nal image. Its information is used internally for dust and scratch removal via 
 Filter  ▶  Infrared clean . Th us, you can use  Input  ▶  Infrared exposure  indirectly to control the fi lter impact. 
It is a nice feature to play around with, but there is usually no reason to touch it. 
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are generally unsatisfi ed with the fi ltering quality of your scanner, you might want to try a diff erent setting.

Input ▶ Red/Green/Blue analog gain 

Nikon scanners can control the exposure time for each color channel separately; this is called analog gain. 
Apart from the separate control for each channel, it is identical to  Input  ▶  RGB exposure . Whether you in-
crease a setting in  Input  ▶  RGB exposure  or all three channels with the same value in  Input  ▶  Red/Green/
Blue analog gain , the result is actually the same. Please be aware that the setting in both options adds up if 
you use them at the same time. 

Input ▶ Lock fi lm base color 

Every fi lm has a base color that needs to be corrected independently from the image’s exposure, color casts, 
etc. You can see this easily with color negative fi lm. It is not only inverted but also has a prominent orange 
mask. VueScan tries to correct this base fi lm color automatically and independently from the other color set-
tings. If you are scanning a roll of fi lm you can—and, as a matter of fact, you should—lock these base color 
corrections for consistent scanning results. 

Th is is easier said than done, as this option is well hidden in the guts of VueScan. First, you have to select   
Input  ▶  Lock exposure . Th en, you have to perform another preview scan. Aft er the preview, the option  In-
put  ▶  Lock fi lm base color  will pop up (but only if  Input  ▶  Media  is set for fi lm originals!). If you select it, 
you will notice that three new options will appear in the  Color  tab ( Film base color red  and  Film base color 
green   and  Film base color blue ). Th ese display the automatically generated values for the fi lm base color, 
and you can confi gure them manually as you like. 

Input ▶ Lock image color 

Th is is another option that’s remarkably well hidden in the depths of the VueScan GUI. First, you must select
 Input  ▶  Lock exposure , then perform a preview scan. Aft er the preview, the option  Input  ▶  Lock fi lm base 
color  will pop up. If you select it, eventually  Input  ▶  Lock image color  will be visible. Th is option locks the 
black and white points used in the most recent preview or scan. It is helpful when you are scanning a series 
and want to provide consistent lighting for all of the images.  

Input ▶ Default options 

Th is is a convenient way to reset all of the options in the  Input  tab to default values. If you accidentally click 
it, you will lose all your manually confi gured settings in this tab and have to start from zero.  
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A complete reference for the  Crop  tab

9
Reference – Crop Tab
Cropping is an indispensable part of the scanning process, 
and VueScan off ers a wide rage of parameter adjustments for 
this work step. Whether you want to determine the frames 
manually or cede this step to the scanning application, there 
is defi nitely more than one road leading to Rome. It’s your 
choice as to which of these options suits your individual scan-
ning needs best. 
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9.1 Reference – Crop tab 

The crop area in VueScan serves two purposes. First, it marks the area that is actually going to be scanned 
by framing it with a blinking dashed line. Everything outside the crop area will—surprise, surprise—be 

cropped. Second, the crop area plays an important role in calculating color balance, histogram, and other 
exposure settings. If needed, VueScan has some options that allow you to confi gure exposure settings inde-
pendently from the crop. 

VueScan off ers a wide range of cropping options—manual, automatic, and in-between. For a preview of 
the cropped original, switch over from the  Preview  window to the  Scan  window. Th e cropping frame can 
be adjusted in the corresponding tab or simply via the mouse in the  Preview  window. Th e easiest way to 
change the coverage of the crop is the mouse. Position the mouse pointer over the blinking line, click and 
hold the left  button, and drag the line to the desired position. If you position the mouse pointer at a corner 
of the crop, you can change its size vertically and horizontally at the same time. For repositioning the whole 
crop without any size change move the mouse to the center of the crop box and drag it into any position you 
like. Th e cursor will change then. Cropping should be executed with care, as the options in this tab infl uence 
even the raw fi le. What you cut off  during scanning cannot be reproduced at a later stage. 

Crop ▶ Crop size 

Th is option determines the size of the crop area in VueScan. If you change the size of the crop frame via 
the mouse, you will easily see changes here. Moving the whole crop without changing its size has no eff ect. 
Although it may look easier at fi rst glance to use the mouse instead of the menu, the menu can be the better 
option for many scanning tasks. Let’s look at the diff erent options in detail. 

 ▶ Manual  
Th is option allows you to confi gure the crop manually. If you change the size (not the position!) of the crop 
manually, the setting jumps to Manual immediately. 

 ▶ Auto 
Th is setting automatically determines the size and position of the crop frame.  Crop  ▶  Auto  is enabled auto-
matically. If and to what degree this setting is useful depends on the type of analog original. For transparent 
media like slides, it is in general useful. Due to the sharp contrast between the slide and the dark, unexposed 
border of the fi lm, VueScan can detect the image reliably. It’s a diff erent story with night shots that are low in 
contrast; if your eye can not detect the diff erence between the image and fi lm border, any automatic setting 
is bound to fail. Even with standard paper documents (black print on white paper), automatic cropping can 
fail here and there. To sum up: automatic cropping can be useful in certain circumstances, but it is never as 
precise as the human eye.  

 ▶ Maximum 
Th is is not actually a cropping option, as the scanner simply scans the whole tray. It is quite handy when 
scanning RAW, but there are some things you should know. First, the scan fi le will be larger than needed, 
which can be a serious issue depending on the size of the original and the chosen resolution. Second, the 
whole tray will be used for the exposure measurement, which can lead to negative side eff ects if there are 
thick black borders. 

 ▶ Specifi c sizes 
Here you will fi nd cropping templates for standard analog originals—from tiny APS slides to huge 11" x 17" 
documents. Th e choices in the dropdown list will not necessarily refl ect the abilities of your scanner. 
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Th e list is the same for all scanners that VueScan supports. If you choose an option that is larger than your 
scanner’s tray, the crop will simply cover the whole area. Selecting one of these standard sizes can be ex-
tremely helpful during document scanning. If you scan a stack of 81/2" x 11" paper documents and convert 
them into PDF fi les of the same size, there is no need to fool around with cropping. In this case, the input 
and output sizes are exactly the same, which makes life easy. Just set the crop size to 81/2" x 11", position the 
originals properly on the scan tray, and start scanning. Other settings like 35mm fi lm and 35mm slide are 
less easy to handle because the standardization of these originals is less strict. Th e actual image size of 35mm 
fi lm depends not only on the camera but also on the lens. Th ere are slight variations, plus you have to take 
care of the notorious fi lm off set for the proper positioning of the crop. 

Crop ▶ X/Y size 

Here you can set the crop size manually and defi ne it with more precision than by using the mouse. Th is 
option is displayed only if  Crop  ▶  Crop size  is set to Manual. Th e X size determines the horizontal resizing, 
and the Y size the vertical resizing. Th e unit is millimeters by default; you can change it in  Prefs  tab. 

Crop ▶ Auto off set 

Detecting the proper position of the analog original is an important workstep when the original is much 
smaller than the scan tray. If you enable  Crop  ▶  Auto off set , the application will try to fi nd the position au-
tomatically. In general, this function is quite reliable, but there are some limitations already described above 
in the Auto setting of  Crop  ▶  Crop size . With  Crop  ▶  Auto off set  enabled, VueScan needs to perform a 
preview before actually performing the scan. For batch scanning, it should be disabled. 

Crop ▶ X/Y off set 

Here you can confi gure the off set of the crop manually if  Auto off set  is disabled. Th is is more precise than 
using the mouse for repositioning the crop box, but it is quite cumbersome to handle. In most cases, using 
the mouse is more convenient. You can enhance the precision of manual off set either by using a big screen 
(for a big preview window) or by zooming in to the preview on a smaller screen if needed. Th is will combine 
suffi  cient accuracy with comfortable handling. 

Crop ▶ Multi type 

Th is option is displayed when you are using a fi lm scanner for 35mm slides with the option  Crop  ▶  Crop size  
set to Auto. By default,  Crop  ▶  Multi type  is disabled and the scanner will search for standard-sized 35mm 
frames (24 x 36 mm) only. But if you enable  Crop  ▶  Multi type , it will search for more exotic size variations 
of 35mm fi lm as well (10 x 13 mm, 24 x 18 mm, 28 x 28 mm, 28 x 36 mm, and 40 x 40 mm). Enable this op-
tion only when needed to avoid erroneous detections. 

Crop ▶ Multi crop 

Th is option is used for scanners that can have more than one original in the scan tray at a given time. A typi-
cal example is a fl atbed scanner with a transparency unit that are uses black plastic masks for the tray. Here 
you can process whole fi lmstrips or multiple slides at a single blow. Of course, you don’t want to scan the 
whole tray as a single image; you want to choose the images separately. With  Crop  ▶  Multi crop , you can tell 
VueScan (or let it detect automatically) how many frames you need for your scan operation. Th ere are three 
options. If you disable it with Off , you will have only one frame for the whole tray. 
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If you set it to Auto, VueScan will try to detect the number of analog originals on its own. Th e hit rate 
varies, depending on the originals; in general, it is advantageous to use original fi lm holders to improve the 
detection rate. If you set it to Custom, you can manually confi gure the number and size of frames needed. For 
details, please compare the next option.  

Crop ▶ X/Y images 

Here you can confi gure how many separate frames you need when using  Multi crop  ▶ Custom . With  Crop  
▶  X images  (e.g., 2 frames), you determine the number of frames in the horizontal line. With  Crop  ▶  Y 
images  (e.g., 3 frames), you determine the number of frames in the vertical line. Th e absolute number of 
frames is the scanning grid, i.e., the product of X and Y (e.g., 2 horizontal x 3 vertical frames = 6 frames 
overall). Only one frame is displayed at a given time, which might be confusing for beginners—most scan-
ning applications from hardware manufacturers work diff erently. 

In the author’s opinion, the multi crop implementation of VueScan needs an overhaul—but once you are 
familiar with it, it’s good enough. If you change to  Input  ▶  Frame number , you can switch back and forth 
between the frames. Any chosen frame of a multi crop can be confi gured like any frame of a standard single 
crop. You can change the size and position of the crop as you like, even rotate it. In case you get lost, the cur-
rent frame number is always displayed in the footer of the VueScan GUI.  

By default, the frame grid is identical with the crops of the diff erent frames. You can reconfi gure each 
frame’s size and location separately if needed. In this case, the grid will still be displayed in the background.  

Crop ▶ X/Y spacing 

Th e option only shows up when  Crop  ▶  Multi crop  is set to Custom and more than one frame is specifi ed via  
Crop  ▶  X/Y images . Th is option determines the absolute widths (X spacing) and the heights (Y spacing) of 
all frames of the multi crop. Actually, the nomenclature is somewhat misleading, as you defi ne the size of the 
individual crops here. For 10 x 15 cm prints you would have to set   Crop  ▶  X spacing  to 100 and  Crop  ▶  
Y spacing  to 150 (if the crop unit is millimeters). In general, these sizes should equal the sizes of the analog 
originals. You can change easily the crop units from millimeters to inches in  Prefs  ▶  Crop units .  

Crop ▶ X/Y padding 

By default, the grid with the cropping frames is centered in the preview window. Use  Crop  ▶  X/Y  padding 
if you want to change this. You can only do so if  Crop  ▶  Multi crop  is set to Custom and if there is more 
than one frame. Correct positioning of the grid with this option can be tricky, as you will soon fi nd out when 
playing around with it.  

Displaying and handling multi crops 

If you want to see all the frames of the multi crop, enable  Crop  ▶  Show multi outline . By default, you 
will only see the selected frame, which might be confusing if you are working with multiple crops. You 
might have to rerun the preview to actually show them. If your mouse pointer is located over the crop, 
VueScan will display the corresponding frame number inside the grid. With one click, you can select 
the appropriate frame directly; there is no need to use  Input  ▶  Frame number . Th e frame number will 
only be displayed for frames that are currently inactive. Once you choose a frame, its frame number 
will no longer be displayed in the grid.
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Crop tab

Crop ▶ X/Y linked 

By default, the confi guration of a fi lm off set is valid only for the chosen frame. With  Crop  ▶  X/Y linked , 
you can link the frames in a horizontal (X) or vertical (Y) direction. Th e off set of one image will be applied 
to the whole fi lmstrip. Th is is a very useful option when you are scanning fi lmstrips with an automatic fi lm 
feeding unit.

Crop ▶ Show multi outline 

Th is option shows the lines that defi ne the multi crop boxes in the Preview window. By default, you will only 
see the selected frame. Th is can be quite confusing when you are working with multiple crops. But you can 
fi x this easily. You have to rerun the preview. Th is will actually show you the multiple crops in the Preview 
window. 

Crop ▶ Auto rotate 

Th is option works only with a single crop; multi crop is not supported.  Crop  ▶  Auto rotate  will automati-
cally rotate the crop into portrait or landscape alignment. Th e rotation direction will depend on the crop 
size;  Crop  ▶  Auto rotate  will try to cover as much of the image as possible. Of course, this will work only if 
the crop is small enough to be rotated within the preview area in both directions. It is useful for some slide 
scanners that allow you to insert the slide in any direction. 

However, Nikon fi lm scanners will not benefi t from this option, as there is only one way to insert a slide 
properly. If you do it the other way, this will result in cutting the edges. Preview is mandatory for this option, 
so it should be disabled for batch scanning. 

Crop ▶ Crop orientation 

 Crop  ▶  Auto rotate  rotates the crop (specifi ed in  Crop  ▶  Crop size ) automatically, and   Crop  ▶  Crop 
orientation  is the manual alternative. Here you can align the crop as a Portrait (long side vertical) or as a 
Landscape (long side horizontal) by choosing the appropriate adjustment. Th is option shows up only when   
Crop  ▶  Auto rotate  is disabled. Another thing worth mentioning: multi cropping is not supported with this 
option.

Crop ▶ Lock aspect ratio 

By default, this option is disabled (Off ), and you can change the aspect ratio of the crop box by dragging it 
with the mouse. If you choose  Crop  ▶  Lock aspect ratio , you can still modify the crop size, but the aspect 
ratio will not change. With Image size, the aspect ratio is inherited from  Output  ▶  Printed size .  With 
Manual, you can confi gure it as you like; compare below. 

Crop ▶ Aspect ratio 

Th is option shows up when you choose  Crop  ▶  Lock aspect ratio  with the setting Manual. Th e value 1 will 
produce a perfect square; if you increase the value, it will convert into a rectangle. If you need a crop with an 
aspect ratio of 2:3 (e.g., for a 4" x 6" print), you must divide the longer edge by the shorter edge for a value 
of 1.5 (3/2 = 1.5). Th is option is very useful if you need the scans for a dedicated output size and you don’t 
want to crop them again in post-processing. It is a great help if you want to produce consistent scans and for 
batch scanning, too.
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Crop ▶ Border (%) 

Th is option eff ectively enlarges or diminishes the scanned area beyond the crop box. Since the scan exposure 
measurement only includes what is inside the crop, you can use this option to create a security margin that 
ensures you will not accidentally crop an edge of the original. Th e default value is 0; if you increase it (e.g., 
+10), the scan will be bigger than the crop. 

If you decrease it (e.g., -10), the scan will be smaller than the crop. Th e values are a percentage of the 
original crop size. Unfortunately, there is no way to display the border area, which makes the confi guration 
somewhat imprecise. To see the eff ect of this option, you must change from the  Preview  window to the  Scan  
window and pull the slider of  Crop  ▶  Border (%) .  

Crop ▶ Buff er (%) 

Unlike  Crop  ▶  Border (%) , this option leaves the eff ective crop size untouched. It causes VueScan to ignore 
some of the image data at the inside edges for exposure management and color balance. Th is is perfect for 
raw scanning. Slides can be scanned full size, and you don’t have to worry about the black edges that can 
wreck a scan. With  Crop  ▶  Buff er (%) , VueScan will simply ignore the border areas of the image. It should 
be noted that the buff er value is a percentage of the eff ective crop size, and there is no feasible function in 
VueScan to show you its coverage. 

As stated above, the eff ective and the displayed crop are not identical if you use  Crop  ▶  Border (%) . In 
that case, the offi  cial VueScan reference recommends setting  Crop  ▶  Border (%)  slightly higher than Buf-
fer values, but this is only needed if you are enlarging the eff ective crop size via a positive value for  Crop  ▶  
Border (%) . If you are diminishing the eff ective crop size with a negative value, you will not need this. As 
VueScan has no proper preview function to show you the coverage of Buff ers and Borders, it is best to use 
only one of these options at a time.  Actually,  Crop  ▶  Buff er (%)  is more precise as the displayed crop is 
identical with the scanned image.

Crop ▶ Preview area 

By default, the scanner will display the whole scan tray for the preview. In some cases, however, this is not 
desirable or necessary. Scanning 35mm slides is a common example, as most scanners use only a small area 
in the middle of the scan tray for this purpose. Another example is scanning 81/2" x 11" documents. Most
scanners have a scan tray that is slightly bigger than 81/2" x 11"—so if you reduce the  Preview area  to 
81/2" x 11", you can reduce scanning time without eff ectively losing anything. 

With Manual, you can defi ne the size and position of the preview area exactly. Th is can be a bit tricky, as 
there is no preview functionality for this option. You will have to perform a (Preview) to check your settings.  
Th e Crop box is easier to handle, as the current crop box is the preview area. Aft er performing a preview, the 
setting automatically changes to Current. You cannot confi gure this setting; it is just a status notifi cation. De-
fault and Maximum are in most cases identical. Maximum displays the full scan tray, and this is usually the 
default setting, too.  Small originals can be placed on the scan tray either in portrait or landscape alignment. 
For most scanners, landscape is the better option because in that position, the stepper motor moves as little 
as possible. Consequently, scanning in landscape mode is faster than in portrait mode. Especially when you 
do batch scanning, this can help you to save some time

Crop ▶ Preview X/Y off set 

Th e option  Crop  ▶  Preview X/Y off set  allows you confi gure the position of the preview area with  Crop  ▶
 Preview  set to Manual. Th e general process ist describe in  Crop  ▶  Preview X/Y size  below. 
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Crop tab

Crop ▶ Preview X/Y size 

Th is option confi gures the size of the Preview area. Th ere is no preview functionality for size and/or off set, so 
it can be cumbersome to fi nd the best setting—especially when the preview is not clinging to the upper left  
corner of the scan tray (i.e., where X off set = 0 and Y off set = 0). Th e only way to check your settings is to run  
(Preview) aft er each confi guration change. Th is will take some time and that’s why the use of this option is 
not really easy to handle at the current development stage of VueScan.

Crop ▶ Focus X/Y off set 

Better fi lm scanners have autofocus functionality that allows you to position the autofocus measuring fi eld 
at will.  Crop  ▶  Focus X/Y off set  and the blinking cross that marks the autofocus measuring fi eld are only 
visible if your scanner supports autofocus. Aft er you change the off set confi guration, you will have to per-
form a preview to update the position of the blinking cross. Good fi lm scanners, e.g., Nikon scanners, have 
an extremely small depth of fi eld. It is actually smaller than the depth of fi eld needed to scan a curly piece 
of fi lm accurately across its width. Th e depth of fi eld is less than 1 mm and that is not enough for curly fi lm.

Th ere are two ways to deal with curly fi lm. Th e easiest is to locate the focus point on the most important 
part of the picture—e.g., for a portrait, that usually would be the eyes. 

If you closely examine a piece of curly fi lm, you will see that the curling is usually most pronounced in 
the middle of the fi lm strip. In general, depth of fi eld covers some of the area in front and behind the actual 
focus point; this eff ect is well known, as photographic lenses and scanner lenses work similarly. For optimal 
depth of fi eld, the focus point should be located somewhere between the image center and the border. As 
most originals tend to show a degree of sharpness at the border anyway—a well-known limitation of most 
lenses—the focus point should be closer to the image center than to the border. In general the only way to 
completely avoid this problem is to use perfectly fl at originals. Easier said than done, as fi lm tends to get 
more curly during aging. But actually that is not an exclusive problem of scanners. It starts much earlier 
while the fi lm is inside the camera where the fi lm strip is never completely fl at. Th ere were cameras like the 
Contax RTS III that even had a little vacuum pump built into the camera body, which was intended to en-
hance the fl atness of the fi lm. I am not sure if the Contax system really worked, but especially for small fi lm 
formats like 35mm fl atness of the fi lm always has been an issue. 

Crop ▶ All frames 

By default, the settings in the crop tab apply only to the chosen frame. If you enable this option, the confi gu-
ration will apply to all frames equally.  Crop  ▶  All frames  is visible when you use multiple frames.

Crop ▶ Default options 

Here you can reset the default confi guration of this tab with a single click.

Slide mounts vs. fi lm holders

For good scans, you should ensure that the fi lm you are scanning is as fl at as possible. Th ere are special 
slide frames on the market (e.g., Wess) with tensioning features. Th ese devices fl atten any piece of fi lm 
more effi  ciently than the fi lm holders provided by scanner manufacturers. You can use slide frames for 
negative fi lm if you don’t mind cutting your negative strips. In any case, a fl at original is the basis for a 
good scan.
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By default there is only one crop per scan. If you place more than one original on the scantray, use the  Multi crop  functionality of VueScan 

instead. Then you can have separate crops for each original.
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10
Reference – Filter Tab
A good scanner will reproduce your refl ective or transparent 
original exactly, but the resulting unprocessed scan is usually 
far from desirable. Depending on the condition and the age of 
your original, there can be undesirable side eff ects. Faded col-
ors, dust and scratches, and a generally fuzzy appearance are 
frequently visible in an unprocessed scan. Th is is usually not 
a malfunction of the scanner, but rather simply what happens 
when you reproduce an analog original 1:1 with a state-of-
the-art device. To convert an unprocessed scan into a decent 
picture, you will have to fi lter it! Th is is the point where the
 Filter  tab of VueScan deserves your attention. 
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10.1 Reference – Filter tab 

Filtering is an important step in image refi nement, but you can wreck your scan completely with a wrong 
fi lter setting. Fortunately, a big advantage of VueScan over other scanning soft ware is that its fi lter set-

tings do not manipulate the raw fi le. Just choose an output fi le type that can store all of the information of the 
raw scan. You can perform any fi ltering option in VueScan conveniently aft er the raw scan—e.g., you can try 
as many fi lter settings as you like without having to rescan once. Th is alone is a good reason to dump your 
manufacturer’s soft ware and buy a VueScan license. 

Filter ▶ Infrared clean 

Modern scanners can read the tiniest bit of information on an image. Unfortunately, they also record details 
we could do without: specks of dust and scratches. A tiny scratch in a 35mm slide may seem insignifi cant 
when you examine the original on a lightbox, but the scanned image will tell a diff erent story. A tiny scratch 
in the original will appear as a major ditch on the computer screen due to the strong magnifi cation of the 
scanner.   Th ere are four confi guration options for  Infrared Clean : None, Light, Medium and Heavy. Th ey 
control the fi ltering intensity. If you choose a setting that is too weak, VueScan will not remove all scratches 
and dust particles. If the fi lter setting is too strong, this may lead to artifacts. You can control the display of 
fi ltering intensity by enabling  Color  ▶  Pixel colors .

Manual vs. automated correction 
Aft er scanning, you can always touch up dust and scratches image by image in Photoshop. Most image 
editors can handle these functions, and Photoshop also has convenient plug-ins. However, soft ware cannot 
easily distinguish dust and scratches from other image details. Th erefore, the process cannot be automated. 
In some cases, manual retouching makes sense; it gives full control over the corrections required to improve 
image quality. For large numbers of images, however, it is too time-consuming and therefore not practical. 

To sum up: manual dust and scratch removal in soft ware is used mainly as a makeshift  when hardware-
based methods fail. Th e dust and scratch removal option in VueScan is  Infrared Clean . Like all of the other 
fi ltering options discussed in this chapter, you will fi nd it in the  Filter  tab. It is hardware-based and costs you 
no eff ort. Simply activate  Infrared Clean , choose an intensity level, and let VueScan do the rest automatically. 

How it works: Infrared channel 
Before a fi lter can eff ectively remove dust and scratches, the program needs to know the location of those 
interferences in the image. Th is is a crucial issue, as soft ware-based algorithms are far from precise. A classic 
scanner with only three color channels for RGB reproduction is not suffi  cient for this task. A good scanner 
nowadays has an additional channel, the dedicated infrared channel, which contains the information that an 
infrared beam gets by sweeping the image. VueScan not only uses the infrared channel for Infrared Clean, 
but also allows you to store it separately or together with the RGB information in the image fi le. 

 Infrared Clean  works perfectly with transparent media like color negatives (C41 process) and color slides 
(E6 process). Switch on  Infrared Clean  when scanning these types of originals. Dust and scratches will be 
visibly reduced, and negative side eff ects of the fi lter are minimal. You can use it with refl ective originals as 
well, but usually it will not lead to a visible improvement. In some cases, e.g., with matte fi nish refl ective 
originals, using  Infrared Clean  can even result in a completely blurry image. So, in general,  Infrared Clean  
should be disabled for refl ective media.  

Scanner light source and scratches 
Th e scanner’s light source plays a major role in highlighting scratches in transparent originals. Th e compara-
tively harsh LED light of Nikon fi lm scanners (e.g., Coolscan V/5000) tends to emphasize scratches. 
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Th is eff ect is less pronounced in scanners with soft er, more diff use light sources like the fl uorescent lamps 
in older fl atbed scanners (e.g., Canon 9950F). Th ere is little you can do about this eff ect once you have 
bought the scanner, but infrared-based dust and scratch removal makes it a nonissue for color slides/nega-
tives. However, for black-and-white scanning where infrared beams are misrouted, it may be worthwhile to 
change your scanner model. 

Infrared Clean with black-and-white fi lm 
Conventional black-and-white fi lm contains silver crystals that prevent dust detection via the infrared beam. 
Th ese fi lms are explicitly not supported by  Infrared Clean ! Th is is a general technical limitation, as there is 
no scanner or scanning soft ware that off ers eff ective automated scratch removal for black-and-white origi-
nals. Th is does not apply to chromogenic black-and-white fi lms that can be developed with the C41 process 
for color negatives like Ilford XP2. But, in fact, those fi lms cannot be regarded as true black-and-white fi lms; 
they are more or less color fi lms without any color. 

Infrared Clean with Kodachrome 
Kodachrome slides are also special; they are based on a diff erent technology (K14) than normal slide fi lm. 
Kodachrome slides very much resemble classic black-and-white fi lms. Due to this, infrared-based dust and 
scratch removal with Kodachrome is tricky. VueScan includes a sophisticated algorithm for determining the 
relationship between visible light and infrared light with Kodachrome, since Kodachrome dyes can be seen 
strongly in infrared light. Even diff erent batches of Kodachrome will have diff erent relationships between 
visible and infrared light, but VueScan determines this relationship for each slide scanned and compensates 
for it. Th e only time VueScan has a problem with Kodachrome is when the slides weren’t properly developed 
and there are residual silver particles in the dark areas of the slide. In this case, you can determine this by 
enabling  Color  ▶  Pixel colors  . By default this option is set to Red for  Infrared defect color . Th ere you can 
follow up which pixels VueScan regards as dust spots, they will be displayed in Red. If too many pixels in the 
dark areas are red, pay careful attention to whether the cleaning worked in these areas. Only some types of 
improperly developed Kodachrome will have this problem though. 

  
Confi guring Infrared Clean 
Th e confi guration of the fi lter is quite simple. Th ere are four options: Light, Medium, Heavy, or None (which 
disables the fi lter). In general, every fi lter has some unwanted side eff ects, so it is best to use a fi lter only when 
absolutely necessary. It follows that  Infrared Clean  should be switched on only when needed and then only 
at the lowest intensity level that produces the desired result. Infrared-based dust and scratch removal can 
reduce the sharpness of an image, although this eff ect is less pronounced in VueScan than in other programs 
that use such methods as Digital ICE. 
Like its competitors,  Infrared Clean  uses interpolation to fi ll in the pixels where the the infrared beam de-
tects scratches. Although this interpolation is on a high level, it is still just a guess. Th e stronger the fi lter is, 
the more image space will be detected as faulty, and the more likely it is that your correction will produce 
some unwanted artifacts. Th at’s why you should only use a fi lter when it’s actually needed. 

When you’re doing batch scans and have no time for individual fi ne tuning, simply switch on  Infrared 
Clean  and let the scanner automatically processes the scans. Usually the Light setting is suffi  cient; if that’s 
not enough, switch to Medium. Heavy should only be used when the originals are in very poor condition. By 
the way, properly cleaning the originals before scanning is far better than using a strong fi lter on scans from 
dirty slides. 

Speaking from experience, it is next to impossible to fi nd any slide or negative that has no scratches and 
is completely dust-free. Scanning services that process thousands of pictures every day usually use  Infra-
red Clean  or comparable fi lters. Th ese fi lters defi nitely improve the overall image output with little eff ort. 
Manual correction will lead to even better pictures, but you have to invest a lot of time for it.
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This piece of color negative fi lm (Agfa Optima) from the early 1990s has a scratched surface. It needs either  manual retouching after 

scanning or appropriate fi ltering during scanning.

no Infrared Clean
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Infrared Clean can detect and remove scratches and dust automatically. This will improve the quality of the scan visibly. There is only little if 

any need for manual retouching if the user enables this fi lter.

Infrared Clean heavy
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VueScan is able to display and save the infrared channel where you can see the amount of surface damages. This fi lmstrip is extremely 

scratched and a good test for the effi  ciency of  Infrared clean .

 Enable Color  ▶  Pixel colors  and VueScan’s  Infrared clean  will mark everything it regards as scratches or dust in red colors. This is great 

to estimate the eff ect of the fi lter before scanning, it helps to fi nd the right setting. 
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The Heavy setting fi lters out many more scratches than the Light setting, but of course there are limits. You can remove these remaining 

long and deep scratches only by manual retouching in Photoshop.  

The fi ltering intensity in the Light setting of  Infrared clean  is low. This is enough for originals that are in very good condition, but this 

negative needs a stronger setting.
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Infrared Clean light

Infrared Clean heavy
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Projecting E6 and Kodachrome slides 

Kodachrome slides have a reputation for keeping their original colors stable even over long periods. In 
general, this is true, and many archives have old Kodachrome slides that are in very good shape despite 
their age. On the other hand, Kodachrome is notorious for dying out extremely fast, which can result 
in dull colors compared to newer slides. 

Th is may sound like a paradox, but there is truth in both statements. Th e long-term stability of Ko-
dachrome depends on its storage conditions. Like any other fi lm, Kodachrome should be stored in a 
cool, dry, dark place. If exposed to sunlight or the harsh beam of a slide projector, slides fade quickly. 
With Kodachrome, this eff ect is even more pronounced than with average E6 slides. 

So, if you want to keep your slide collection in good shape, store your slides properly and avoid pro-
jecting them. A slide show with scanned images on your computer screen may seem tiny compared to 
a traditional slide show of analog originals on the silver screen—but from a conservation point of view, 
it is clearly the better choice.

Filter ▶ Restore Colors/Fading 

A digital picture is immune to aging. If it is stored properly, a digital image will not show any signs of wear, 
even if you store it for decades. Th is attribute makes digital images the perfect solution for archiving analog 
originals. With scanning, you can preserve the given state of an analog original for eternity. 

Unfortunately, many analog originals may already be in a condition where the ravages of time are highly 
visible. If you scan slides from the 1980s, at least some of them will show age-related damage. Fading is the 
most common occurrence. All color pigments fade over time; there is no way to stop this. With time, slides 
that were once luminous and colorful will lose some of those qualities. Th at is one reason—apart from hair-
styles, automobiles, and fashions—you can easily distinguish vintage slides from new slides.  

In addition to fading, you will most likely see age-related color casts. Color casts can happen even with 
brand-new fi lm. A good example is Fuju Velvia 50, a very popular slide fi lm in the 1990s. Th is Velvia pro-
duces a light magenta color cast by default. Th is color cast is a wanted eff ect, and you should preserve it. But 
more oft en you will see age-related color casts that are less pleasant, e.g., strong green or red. Th ey simply 
ruin the whole picture.  

Th e reason for age-related color casts is simple. Take color slides as an example. Slide fi lm has several lay-
ers, each of which represents a diff erent color. Over time, as slide fi lm ages, each of these layers ages—but 
sometimes at diff erent speeds. Over time, this will misalign the color balance of the slide and result in color 
casts. In the  Filter  tab, VueScan has two options for color restoration. 

Effi  cient workfl ow with RAW scanning 

If you are quality conscious, there is no other option that equals fi ltering each picture individually. Th e 
preview window in VueScan will show the diff erent fi ltering results as you switch through the options. 
Since VueScan works with raw data internally, you don’t need to rescan when you change the fi ltering 
intensity. VueScan will take a few seconds to apply the new fi lter setting, and that’s it. 

Still, it is time-consuming to do this procedure before every scan. It is far more convenient to scan a 
whole batch in raw fi rst. As a second step, you can read the whole batch by changing  Input  ▶  Source  
to File. Th en you can do all of the fi ltering very effi  ciently, as you no longer have to wait for the scanner. 
It is much faster to access a RAW fi le from the hard disk than from even the best scanner. Th e RAW 
workfl ow is possible with any fi lter in VueScan, not only with  Infrared Clean .
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Grain reduction vs. dedicated noise specialists 

If you are looking for alternative noise fi ltering options, you will fi nd a wide variety of programs. Al-
most any image editing program (e.g., Photoshop) and any RAW converter (e.g., Adobe Lightroom 
or Apple Aperture) come with integrated noise fi ltering options. However, these programs are usually 
designed for digital noise and not for fi lm grain. Programs like Neat Image, Noise Ninja, AKVIS Noise 
Buster, Noiseware, Kodak Digital GEM, and Nik Dfi ne are dedicated noise specialists that allow more 
fi ne tuning in noise/grain removal. 

Th e fi rst fi lter,  Restore Colors , will restore each color channel—i.e., the program itself tries to restore the 
red, green, and blue color channels separately. Th e second fi lter,  Restore fading , will restore the eff ects of 
fi lm fading and thus remove color casts. Both options are quite limited with no fi ne tuning possible—you can 
only enable or disable them. In practical use, the results of these color restoration options vary. Sometimes 
they improve an image, sometimes not. In any case, the results will not match what you can achieve with 
post-processing in Photoshop or any other good image editor where you can control the level of correction 
yourself. If you are not a Photoshop guru, you can use plug-ins like ASF Digital ROC. Digital ROC is a good 
plug-in for color restoration, but unfortunately you have to buy it separately. To sum up: color restoration is 
an important issue in scanning, especially for old slides. You can try the VueScan onboard solutions, but for 
outstanding results you would be better off  shift ing this work step to image post-processing in Photoshop. 

Filter ▶ Grain reduction 

Film grain is the analog counterpart of digital image noise. From a technician’s point of view, both eff ects are 
nothing more than interferences. If you look at real-life scenery, you will see neither grain nor image noise. 
If you take a picture on fi lm, you will most likely see fi lm grain; if you take a picture with a digital camera, 
some image noise may be visible, especially in low-light conditions. Th e perception of these eff ects is un-
equal. While digital image noise is widely regarded as undesirable, analog fi lm grain is nothing less than an 
object of worship. Film grain is reputed to give each type of fi lm an individual fi ngerprint, and it actually 
does. While a good digital photo usually has no visible image noise, a good analog shot will most likely show 
prominent fi lm grain. So, in general, nobody should be unhappy about some fi lm grain in a scan, right? Well, 
that depends on exactly what happens to the analog original when you scan it. 

Most analog pictures were taken when nobody had a computer at home, not to mention a scanner. In the 
past, the wet chemical process of the photo lab optimized fi lm grain to give the best results. Nowadays some 
fi lms on the market have improved scanning abilities. But for most analog fi lms in the archives, this is not 
the case. Th e appearance of fi lm grain in a scanned image can range from acceptable to annoying. At least in 
some cases, there is a need to minimize or even remove the grain completely. 

Grain is not a fi xed parameter, either on fi lm or during scanning. First of all, the appearance of grain de-
pends on the fi lm and its speed. Slow fi lms like Kodak T-Max ISO 100 tend to have extremely fi ne grain. Th e 
faster the fi lm, the bigger the grain, as you can easily see by looking at the prominent grain of Kodak T-Max 
ISO 3200. But choosing the fi lm type is only one factor. Th e amount and appearance of the grain is heavily 
infl uenced by the fi lm’s exposure and development. Th e grain can diff er not only among diff erent fi lm rolls 
of the same type, but also among diff erent pictures on the same roll! 

Once you start scanning, things get even more complex. Th e scanner light, the chosen resolution, and the 
overall sharpness of the optical system all play important roles in reproducing grain. First-class fi lm scan-
ners like the Nikon Coolscan 5000 with its harsh LED lighting relentlessly chisel every bit of grain out of 
the analog original—especially when scanning at maximum resolution. In regard to grain reproduction, the 
much cheaper fl atbed scanners are usually more docile, especially those that use old-style fl uorescent lamps.
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Filter ▶ Sharpen

Sharpening is an indispensable part of the workfl ow when processing digital images. Both digital cameras 
and scanners use anti-aliasing fi lters to improve overall image quality, but these fi lters have an unwanted 
side eff ect: they reduce sharpness. So no matter how good your scanner or your lens is, the unprocessed raw 
image will appear unsharp! 

If you want to convert a raw image into a crisp, clear picture, you will need to sharpen it. Some cameras 
and cheap scanners presharpen their images automatically to leave a better impression, but from a quality 
point of view this is far from optimal.  

VueScan off ers the option  Sharpen  in the  Filter  tab for this purpose, but you should use it with care. 
Th is built-in sharpening option is fully automatic. You can enable or disable it, but no fi ne tuning is possible 
at all. Th is is far from desirable, as unsharp masking can be a sophisticated process—especially if you are a 
quality-conscious pixel peeper who wants to enjoy pictures even in 100% view. A full range of confi guration 
options would be better, but unfortunately VueScan has nothing to off er here. 

In a quality-conscious workfl ow, VueScan is only the fi rst step. For appealing results, the scan should be 
post-processed via an image editor. Th is is the point where a previously applied unsharp mask would be 
troublesome. Unsharp masking should be the very last step in any workfl ow. If you adjust contrast levels or 
correct the tonal range, both standard corrections in any workfl ow, these settings would interfere with an 
existing unsharp mask. 

All in all, the sharpening option of VueScan should only be enabled if you are defi nitely sure that the scan 
will not be post-processed, e.g., during PDF creation. Th en it is a convenient option to improve the overall 
sharpness of the picture. If you plan to post-process your images, it should be disabled. You can produce bet-
ter results if you do sharpening with a good image editor aft er scanning. Of course, this requires some extra 
time and may not be necessary for some purposes.  

Filter ▶ Default options 

Here you can reset the default confi guration of this tab with a single click. Th is option is only displayed if you 
actually changed the default confi guration previously.
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A complete reference for the  Color  tab

11
Reference – Color Tab
Vibrant colors make the diff erence between an ordinary and 
a superior scan. Since fi nding the correct color is a crucial 
part of every scanning activity, VueScan off ers a wide variety 
of options to serve this purpose. You can control the color 
balance of the scan itself, apply a fi lm profi le, manipulate the     
brightness, or set up full-fl edged color management, just to 
name a few options. 
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11.1 Reference – Color tab 

Color is a vital part of photographic images, and since the 1950s most photographers have preferred 
color fi lm to black-and-white. In scanning color originals, you will face two major challenges. Th e fi rst 

challenge is reproducing the analog original as closely as possible. For positive targets, you can calibrate your 
scanner to enhance its accuracy; for negative fi lm, there is no comparable technique. Th e second challenge 
is accurately reproducing the colors of the original scenery. Th is is a task where fi lm profi les can potentially 
help improve your scanning results. Keep in mind that the settings in the  Color  tab do not aff ect the RAW 
fi le itself, so you can conveniently apply color settings aft er the scan if you are scanning RAW.  

Last, but not least, the accurate reproduction of colors depends on your scanning hardware. A good scan-
ner can reproduce vibrant and brilliant slide colors, but a cheap scanner can look quite dull in comparison 
and not even calibration can help. Neither VueScan nor Photoshop has any way to compensate for this. To 
obtain the best colors in your scans, buy the best scanner you can aff ord. 

Color ▶ Color balance 

Every cheap digital camera has built-in functionality for  White balance . Th is nomenclature is not precise; in 
fact, it does not refer to white balance at all, but rather to color balance that aims to achieve natural colors—one 
of which is white. Th e appropriate function in VueScan is  Color  ▶  Color balance . Th is option will balance out 
all three color channels individually, and usually there are some predefi ned settings for ease of use. None of 
these settings aff ect the RAW fi le. Check it yourself by displaying the raw histogram with the shortcut (Ctrl)-
(1). You can fi ddle around with these settings as much as you like, but the histogram of the RAW fi le will not 
be aff ected—only the histogram of the image itself (Ctrl)-(4).  Color  ▶  Color balance  is only accessible if
 Input  ▶  Lock image color  is disabled. In all cases, the RAW fi le will be gamma corrected for proper display.
  

 ▶ None 
None is the most basic color correction that VueScan has to off er. Th is is a gamma correction applied to 
convert a dark raw scan into an acceptable image and to correct the color response of the scanner’s CCD.  

  
 ▶ Manual 

Here you can control the color balance manually—the expert’s choice. Th ere are sliders for black point and 
white point, plus appropriate options for the red, green, and blue color channels. With black point and white 
point, you can stretch the intensity range of the image. In both cases, you try to shift  the curves (all three 
RGB channels together) to the ends of the scale. For black point, it’s the left  side of the histogram, and for 
white point it’s the right side of the histogram. A perfect setting is achieved when the outer curve adjoins the 
end of the scale, there is no empty space, and none of the curves is cut off . 

In the next step, you can adjust the diff erent color channels separately. If you adjust each of them as de-
scribed above, you will usually remove color casts that result from shift ed color balance. But since each histo-
gram and each analog original is unique, there is no universal cure. With  Color balance  ▶ Manual, however, 
you can comprehensively control the color balance of your scan. Th e controls are a bit unwieldy compared to 
the tools in Photoshop. In VueScan, you have to fi ddle around with the sliders until you fi nd the best setting. 
Th e displayed image histogram (Ctrl)+(4) is a big help. 

 ▶ Neutral 
With this option, the black and white points are stretched automatically and the color channels remain 
untouched. It’s a minimalistic and convenient correction. If you still have color casts, you might want to try 
another option or switch over to Manual. Th ere is no way to control the balance of the color channels here. 
If you want to do post-processing and color correction in Photoshop, the setting Neutral is a good choice. 
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 ▶ Tungsten 
Tungsten light is produced by standard incandescent light bulbs—i.e., old-fashioned bulbs, not energy-sav-
ing fl uorescents. Th is setting will adjust the black and white points and remove the distinctive reddish color 
cast that most indoor images get from tungsten light. For indoor pictures taken with fl ash, this setting is not 
appropriate, as the fl ash will outshine the bulbs. 

 ▶ Fluorescent 
Fluorescent light usually produces a cold green color cast, but the exact color varies depending on the exact 
type of light. Th is option corrects the black and white points plus the color balance of fl uorescent light. You 
can try it for any green color cast—sometimes fl ash can produce a similar cast. 

 ▶ Night 
Th e average correction of black and white points is useful for any picture taken under normal daylight con-
ditions. For night shots, it is not recommended and can even completely ruin your image. Night is a special 
setting for night pictures. Th e darkest 10% of the image is used for calculating the white point. Th is option 
is designed to produce the best results in images that contain a good portion of black along with fl uorescent 
lights (green color cast) or average light bulbs (yellow color cast).  

 ▶ Auto levels 
Th is simple automatic setting assigns an intensity of 0.00 to dark colors and 0.95 to highlights. In one setting, 
you can achieve a good color correction and more brilliant colors for most images. It’s ideal for beginners 
or people who are short on time. Experienced users can achieve better results with manual tweaking and a 
bigger investment of time. 

 ▶ White balance 
Th is setting is designed to produce neutral colors. It sets the black and white points and corrects each color 
channel separately. Th e way VueScan’s White balance works is it searches for the colors that are closest to 
neutral (i.e. shades of gray) and adjusts the overall color balance so that these colors are shades of gray.  Most 
images have signifi cant areas of neutral (i.e. gray) colors, so this works well with most colors.  However, 
images that should have a strong color cast, like photos taken at sunset, don’t always work well with the 
automatic white balance in VueScan. VueScan detects when an image doesn’t have a signifi cant amount of 
neutral color, and in this case falls back to the Neutral color balance setting. Th e results of White balance may 
look boring when compared to the vibrant colors of Auto levels, but White balance will defi nitely be closer to 
the original shot. As with all color corrections, beauty lies in the eye of the beholder. 

 ▶ Landscape 
Here is another setting that corrects the black and white points plus all the color channels separately. Th e 
aim is to produce neutral colors and to achieve an accurate reproduction of blue sky and green foliage. Th at 
means, the Landscape setting is perfect for the average usual landscape photography. But of course there are 
diff erent types of landscape that demand another type of color reproduction. Th ese are any landscape photos 
with vibrant colors, e.g., active volcanos. Th en the Landscape setting may not be your fi rst choice. 

 ▶ Portrait 
Color correction of portrait photos is a diffi  cult issue, as skin tones can be critical. Th is option is worth a try 
if you need neutral colors and lifelike skin tones. Th e Portrait option leaves the color balance between the 
diff erent channels largely untouched. Th at means it will preserve the original tone of the skin as closely as 
possible. Please consider that diff erent types of fi lms have a very diff erent color reproduction. You will get 
neutral skin colors with this setting only if you used an appropriate type of fi lm for the original.
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Color ▶ Neutral red/green/blue 

You can use this option if  Color  ▶  Color balance  is set to Manual and  Input  ▶  Lock image color  is disabled. 
Here you can confi gure each color channel separately. Don’t forget to display the histogram of the image dur-
ing the process (Ctrl)-(4). If you move a slider, e.g., for neutral red, you will notice that the red curve of the 
histogram hardly moves but that blue and green curves change. Th e same eff ect (with diff erent color curves, 
of course) happens when you move the blue or green sliders. Confi guration via sliders is cumbersome; it’s 
much more convenient to use the gray point that can be set with a mouse click.

Color ▶ Black point (%) 

Th e black point marks the darkest spot of an image. A properly set black point will improve an image’s bril-
liance and contrast, while a careless setting will result in a loss of tonal values (since dark tonal values will be 
clipped). Th is functionality is well known from Photoshop, but VueScan has no way to set a black point via 
a mouse click. You must use cumbersome sliders instead. 

 Color  ▶  Black point (%)  will set the black point for all RGB channels combined. By default, it is set to 0; 
sometimes setting it to a higher value can improve an image, but this depends on the image’s tonal value. 
Check the histogram. Th e curves (at least, the outer curves) should ideally start at the histogram’s left  corner. 
In most cases, there will be a gap between the left  corner of the histogram and the beginning of the curves. 
Change the black point settings until the curves start directly at the corner. Avoid cutting off  a curve, as you 
will lose tonal values. 

Color ▶ Black point red/green/blue 

Here you can set the black point for each color channel separately. As these values are applied directly to 
linear color space (not gamma corrected space), they are only available when  Input  ▶  Lock image color  is 
set. If you want to survey your changes, you have to display the histogram for the image. 
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Setting a gray point with the mouse 

Th e gray point is a well-known feature in Photoshop. If an image has a color cast, you can set a gray point 
to balance out the three color channels automatically and hopefully remove the color cast. Th is works 
only if the gray point is set to a neutral-colored spot on the image—preferably a neutral grey spot, but 
any neutral-colored spot will do (i.e., where red, green, and blue values are equal, like 188/188/188). 

VueScan off ers grey point functionality as well. Just right click with the right mouse on any neutral-
colored spot. Th is will work unless you enable  Input  ▶  Lock image color . You will see that  Color  ▶ 
 Color balance  switches to Manual mode. If you have problems fi nding a neutral-colored spot (not 
many people take photos of calibration targets!), there is an alternative if you’re scanning slides. Just 
click on the black border of the fi lm. Th is is, or at least should be, neutral black. Please be aware that 
although the border may look pitch black, it may be unevenly colored. Try out diff erent positions on 
the border, and you will most likely fi nd a neutral spot.

Image graph for black and white points

With Image ▶ Graph b/w, you can display the curves and control  Color  ▶  Black point  and  Color  ▶
 White point  via triangled sliders. Reset any changes with a double click on the appropriate curve. 
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You can do this with (Ctrl)-(4); the graph for the raw scan (Ctrl)-(1) is not helpful for this task. Th e 
changes will be applied at the raw level, but they will not change the RAW fi le itself. You basically apply the 
same settings here as in  Color  ▶  Black point (%) ; the only diff erence is that you can control every channel 
separately. Th is option’s controls are diffi  cult to handle; in most cases, you are better off  not touching them 
and sticking to the default value of 0. 

Color ▶ White point (%) 

Th e white point, like the black point, is generated automatically, and the default value is 1. Th at means 1% 
of the brightest pixels in the image are converted to pure white by default. In general, the eff ect and the han-
dling of the white point equals  Color  ▶  Black point (%) , but of course the white point aff ects the highlights. 
A properly set white point increases the contrast and brilliance of an image. An inaccurately set white point 
can result in clipped highlights and an overall fl at look. In VueScan, there is no way to set the white point via 
a mouse click; you have to use the slider instead. For better control, display the image histogram. Th e white 
point is set correctly when all curves (or at least the outer curve) end at the right corner of the histogram. An 
empty gap is not ideal, and a curve that is clipped is worse. But there are some cases when you cannot avoid 
clipping completely, because you cannot move the sliders far enough.

For average daylight photos, the ideal histogram is shaped like a bell. Th e curves start in the left  corner 
of the bottom line, go up, then down, and end at the right corner of the bottom line. In most cases, this type 
of histogram produces the best results, and it can be remembered as a rule of thumb. For exotic cases, like 
high-key or low-key photos, diff erent rules may apply.

Color ▶ White point red/green/blue 

Here you can set the white point for each color channel separately. As these values are applied directly to 
linear color space (not gamma corrected space), they are only available when  Input  ▶  Lock image color  is 
set. If you want to survey your changes, you have to display the histogram for the image and not for the raw 
scan. Th e changes will be applied at the raw level, but they will not change the RAW fi le itself. You basically 
apply the same settings here as in  Color  ▶  White point (%) ; the only diff erence is that you can control every 
channel separately.

Color ▶ Threshold 

Th is option shows up when you set  Input  ▶  Media  to Text or Line art or scan in 1-bit mode. Here you have 
only two colors while scanning: the black text and the white paper. With the option   Color  ▶  Threshold , you 
confi gure the threshold, i.e., the border between black and white. Th e default value is 0.5. If you decrease it, 
the text will be thicker and more of the image will be black—even light impurities will appear black on the 
scan. Th us, the higher sensitivity for text recognition brings the risk of unwanted image noise. 

If you increase the default value, the sensitivity for text recognition will drop. Th at means less image noise 
and a cleaner-looking scan—but parts of the text may be hard to see as an unwanted side eff ect in some cases. 
Th e best individual setting depends on the paper and ink of your original; it is always a compromise. But this 
sounds worse than it is. In general the readability of the scans really improves by using Text or Line art mode. 

Color ▶ Invert 

Th is option is a simple inversion of black and white. It comes with  Color  ▶  Threshold  and is useful in the 
rare case when you are scanning white letters on a black background. Usually, it’s the other way around, but 
exceptions are possible of course. 
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By moving the slider to the outer part of the curves, you can usually fi x the problem with the blown highlights easily. The slider allows you 

stronger settings than  Color  ▶  White point .

Blown highlights may occur if the slider for the white point clips the highlights. In most cases you can easily fi x this by moving the slider to 

the outer part of the curve. 
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In most cases it is possible to remove clipped shadows by moving the slider to the outer part of the curve. Not all histograms have a bell 

shaped curve like this; sometimes they are somewhat clipped in the shadows already, which limits the amount of correction you can apply.

Clipped shadows may occur if the slider for the black point clips the shadows. In some but not all cases you correct it by moving the slider 

to the outer part of the curve. This image suff ers from clipped shadows at the tip of the polar bear’s nose.
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Color ▶ Curve low/high 

Th ese options can be used aft er the black and white points are set. Th ey work similarly to the Highlights/
Shadows fi lter in Photoshop.  Color  ▶  Curve low  can be used to show more details in the black parts of the 
image.  Color  ▶  Curve high  can be used to show more details in the highlights. Another way to confi gure these 
options is via Image ▶ Graph curve (Ctrl)-(3) using the triangled sliders directly below the graph. While this 
seems to be more convenient, you can’t see the histogram when the graph curve is displayed! Th is is like fl ying 
blind—it’s better to display the image histogram with Image ▶ Graph image and use the confi guration options 
of the  Color  tab.

Color ▶ Brightness 

Th is option controls image brightness by changing the gamma of all three RGB channels at once. Like its 
Photoshop equivalent, this correction method should be used with care, as it can lead to loss of tonal values.  

Color ▶ Brightness red/green/blue 

Th is is basically the same option as  Color  ▶  Brightness ; the only diff erence is that you can control each color 
channel separately. 

Color ▶ Film base color red/green/blue 

Th is option is displayed when  Input  ▶  Lock fi lm base color  is selected. By default, VueScan detects the base 
color of the fi lm automatically, but here you can confi gure it. Th is is helpful when you are scanning a com-
plete roll of fi lm at one go. It is less helpful when your originals are from diff erent fi lm rolls. Even if you have 
diff erent fi lms of the same type, they can have diff erent base colors. For example, factors like development, 
aging, and storage can change base color. 

Color ▶ Slide/Negative/B/W vendor/brand/type 

Here you can choose fi lm profi les for diff erent types of fi lm. Depending on the setting in  Input  ▶  Media , ei-
ther negative or positive fi lms will be displayed. If you have problems identifying your fi lm, look closely at its 
edges. Usually there is a number that you can Google to fi nd its name. If you don’t fi nd your specifi c fi lm, you 
can choose a generic fi lm profi le. Even a compatible fi lm profi le will not guarantee perfect colors. Aging, de-
velopment, and storage conditions can change fi lm color over time, and manual correction may be needed.

Color ▶ Scanner color space 

Th is is the color space used internally by the scanner. You can either use the Built-in profi le or embed an ICC 
profi le of your choice. If you profi le your scanner with VueScan (Profi le ▶ Profi le scanner), the created profi le 
is embedded automatically. 
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Resetting Curve low and Curve high to default 

If you display Image ▶ Graph curve and double click on the curve, you can reset it to the default values. 
Th is is the only dedicated reset option for  Curve low  and  Curve high , as  Color  ▶  Default options  
resets the whole  Color  tab. 
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Color ▶ Printer color space 

You can print out of VueScan directly and confi gure a special color space for the print data. If you use Win-
dows or any other application for printing an image created in VueScan, this color space has no (!) eff ect. It 
is only useful when you print in VueScan directly via File ▶ Print image. You can choose predefi ned color 
spaces here, or your own ICC profi le for the printer. 

Color ▶ Film color space 

With VueScan, you can create your own fi lm profi le and embed the resulting ICC profi le here. 

Color ▶ Show IT8 outline 

Th is option displays a grid with the outline of an IT8 target in the  Preview  window. Th is is useful you when 
you are creating a scanner profi le. You must position the crop directly over the appropriate parts of the target. 

Color ▶ Output color space 

Th is is the color space written into the output fi les in JPEG, TIFF, PDF, and BMP index fi les. If you open the 
output fi le in Photoshop, the image editor recognizes the output color space and uses it. If the color space of 
the image fi le diff ers from the default color space confi gured in Photoshop, Photoshop will ask you which of 
the color spaces you want to use. 

Color ▶ Monitor color space 

Th is is the color space for your screen. It ensures that preview and scan images are displayed correctly. By 
default, it is sRGB—an outdated value that should be changed. Most monitors can display more colors than 
sRGB. Th e best practice is to embed an ICC profi le that is dedicated to your specifi c screen. You can either 
download it from the manufacturer’s website or create your own profi le with a colorimeter.   

Color ▶ Scanner/Printer/Film/Monitor ICC profi le 

Th is option pops up if you choose the option ICC profi le for scanner, printer, fi lm, or monitor space. Here 
you can specify the location of the desired profi le. By default, VueScan only reads existing ICC profi les. If you 
use the profi ling functions of VueScan, however, the program will write ICC profi les as well. 

Color ▶ Scanner/Printer/Film ICC description 

If you use several ICC profi les, it is easy to lose track of them as they all have the same *.icc fi le extension. 
You can solve this either by a consistent fi lenaming convention or by a description. Th is option allows you to 
add a descripton when you create an ICC profi le. A consistent fi le naming convention, however, is the better 
option, as you don’t have to open the profi le to identify it. 

Color ▶ Scanner/Printer/Film IT8 data 

For calibrating your scanner/printer/fi lm, you need an IT8 target. Th ere are diff erent IT8 targets on the mar-
ket; they are not fully standardized. So, for proper calibration, you will need the matching IT8 description 
fi le that was shipped with the target. Choose it with care—a wrong IT8 description will wreck the calibration.  
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Color ▶ View color 

Th is option allows you to pick the color channel you want to see in the preview. Internally, scanners work 
with red, green, and blue color channels, and newer scanners also have an infrared channel. Th e default set-
ting is RGB, which shows the resulting color picture. But if you use this option to pick each color and the 
infrared channel seperately, the image shows in black-and-white! Th is option is useful if you want to choose 
the color channel for black-and-white scanning that best suits your personal taste. 

Color ▶ Pixel colors 

Th is enables all colored markers in VueScan that visualize clipped colors, out-of-gamut, and infrared detec-
tion. It can be a big help in fi nding the best confi guration. Once it is enabled, the entire list of options will 
roll out, and by default there are markings for every option. You can reconfi gure the color for each option 
separately; if you don’t need a specifi c option, simply set it to None. A perfect image will show no markings 
at all, but perfection is always diffi  cult to reach. 

Color ▶ Clipped black color 

Th is option shows all of the dark parts of the image that are clipped to black. In this case, color information 
that is part of the RAW fi le will get lost during output. You can fi x it in most cases by setting the black point. 

Color ▶ Clipped white color 

With this all of the light parts of the scan that are clipped to white will show up as green. In this case, color informa-
tion that is part of the RAW fi le will get lost during output. You can fi x it in most cases by setting the white point. 

Color ▶ Out-of-gamut color 

Th is shows all parts of the image that are out-of-gamut in a cyan. In this case, color information that is part 
of the RAW fi le will get lost during output, because the output color space has a small gamut and cannot 
properly display a scanned color. You can avoid this by changing to another output color space with a bigger 
gamut. In some cases fi ltering options can lead to Out-of-gamut, like  Filter  ▶  Sharpen .  

Color ▶ Infrared defect color 

Th is displays the results of the infrared detection process. If you enable  Filter  ▶ Infrared clean , it will show 
all defects in a striking red color. If you switch through the diff erent fi lter settings—Light, Medium, Heavy—
you will see how the detection rate changes. 

Color ▶ All frames 

If you work with multi crop, you may want to apply color settings to all frames in equal measure. You can 
do this with a single click by selecting  Color  ▶  All frames . Th is option aff ects all settings of the  Color  tab 
in equal measure. 

Color ▶ Default options 

Here you can reset the default confi guration of this tab with a single click.
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12
Reference – Output Tab
Th ere is no other current scanning program that off ers as 
many sophisticated output options as VueScan. Th e variety of 
choices is nothing less than impressive. Th is chapter will help 
you choose the best output format for your individual scan-
ning task.  
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The VueScan fi lenaming options  

Every naming option (e.g.,  Output  ▶  TIFF fi le name ) has an [@] button. If you click it, a fi le and the 
folder navigation window of your operating system will open, and you can specify fi lenames and stor-
age locations individually. But you only have to do this if you want individual fi lenames. 

Default fi lenaming 
By default, fi lenames and numbers are generated automatically. A simple @sign + fi le extension (e.g., 
@.tif) is the default setting. Th is results in an output fi lename like Scan-YYMMDD-0001+. YY is the 
year (e.g., 10 for 2010), MM is the month (e.g., 11 for November) and DD is the day (e.g., 22 for the 
22nd of the month). Th e plus sign (+) indicates that VueScan will count automatically. Th e fi rst fi le-
name in the row will be Scan-101122-0001.tif, the second Scan-101122-0002.tif, and so on. 

Serial numbering with + 
You can place the plus sign (+) anywhere in the fi lename. If you place it behind digits, VueScan will 
start counting from the given number. You can add as many plus signs as you like, but VueScan will 
ignore all but the last. For example, if your fi lename is 0000+.tif, the output fi les will be 0000.tif, 0001.
tif, 0002.tif, and so on.  

Leading zeros are useful, since they guarantee fi lenames of the same length. For example, +.tif pro-
duces fi lenames like 1.tif, 10.tif, 100.tif, and so on. A naming convention like 0000+.tif avoids this and 
produces fi lenames like 0001.tif, 0010.tif, and 0100.tif instead. File administration is much easier when 
fi lename lengths are identical. You can start at any number. Numbering is always relative to the con-
tents of the folder, not absolute. VueScan will check fi rst to see if there are existing fi les with the same 
naming convention. If so, it will start numbering at the lowest free slot. Th is can lead to some confusion 
if you deleted some fi les in a batch.  

For example, say your fi lename is 0000+.tif and you scan fi ve images in a batch. Th e resulting fi les 
are 0001.tif, 0002.tif, 0003.tif, 0004.tif, and 0005.tif. Now you delete 0002.tif. If you perform two more 
scans, they will be named 0002.tif and 0006.tif. Th e fi rst fi le will fi ll the gap in the existing row, and the 
second fi le will continue the naming convention of the batch. 

Inheriting RAW fi le names with * 
If you are processing RAW fi les ( Input  ▶  Source  set to File), you can assign the output fi les identical 
names as the RAW fi les. Just replace the default @ sign in the fi lename with an asterisk *.  
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12.1 Reference – Output tab 

The  Output  tab is the command center that allows you to specify the output format of your scan. Here 
you can choose between diff erent fi le formats and confi gure fi lenames, storage folders, and subsequent 

options like fi le compression or output size compression. Th e text below gives a brief overview of general 
options that apply to diff erent fi le formats.

By default, all fi les are stored in the folder specifi ed in  Output  ▶  Default folder . Th e naming is automated 
as well; every naming option (e.g.,  Output  ▶  TIFF fi le name ) has a code (here, @.tif) that assigns fi lenames 
automatically. Of course, you can confi gure everything individually as well. 

Please keep in mind that VueScan is able to execute multiple fi le formats in parallel. With your scanner 
manufacturer’s soft ware, you may be used to choosing between TIFF and JPEG; with VueScan, that is pos-
sible but not mandatory. Instead, you can have TIFF and JPEG output at the same time.  

Vue_book_large.indb   138 13.04.2011   19:47:21



Frame numbering with = 
Th e frame number assigned by VueScan can be written into the fi lename of the output fi le. Just insert 
an equal sign (=) in the fi lename. If you save the scan more than once, VueScan will try to overwrite the 
existing fi le. By default, the application will warn you before actually replacing the fi le.  

Specifying a starting number is a little diff erent from serial numbering with the plus sign. Th e start-
ing number will be the specifi ed number + the frame number -1. Th is may sound complicated, but it 
actually is very useful in batch scanning fi lmstrips when you want the fi lenames to match the numbers 
on the negatives. Simply confi gure the fi rst number of the original, and VueScan will do the rest. 

For example: your fi lename is Scan_33=.tif because the number of the fi rst negative on the strip is 
33. Th ere are four images on the fi lmstrip, from 33-36. Now perform a batch scan of the four frames. 
Th e resulting fi lenames will be Scan_33.tif (frame 1, 33+1-1), Scan_34.tif (frame 2, 33+2-1), Scan_35.
tif (frame 3, 33+3-1) and Scan_36.tif (frame 4, 33+4-1). Since the frame numbering is relative and not 
absolute, you should assign a new name for each fi lmstrip you scan. Th is is necessary anyway, as each 
fi lmstrip has a diff erent starting number. 

Output ▶ Default folder 

Th is is the default folder for all output fi les generated by VueScan. All fi le types relegate in standard confi gu-
ration to this folder. Th at’s why simple fi lenames like @.tif are a suffi  cient description in the default settings; 
the fi le path is the default path. Of course, you can reconfi gure this. If you specify diff erent paths for indi-
vidual fi le types (e.g.,  Output  ▶  Tiff  fi le name ,  Output  ▶  JPEG fi le name ,  Output  ▶  PDF fi le name , and so 
on), they will override the default settings.  

Output ▶ Printed size 

Th is setting has no practical infl uence on fi le size or on the scan itself. It is simply a descriptive function that 
can be useful for printing.  Output  ▶  Printed size  does not (!) resample the image, it will not (!) change the 
absolute numbers of pixels, and it will not necessarily be used for output purposes. Th e important value is 
always the scan size itself, i.e., the absolute number of pixels. 

For example: you scan a 35mm slide (25.025 x 36.678 mm) with an  Input  ▶  Scan resolution  of 2000 spi. 
Set  Output  ▶  Printed size  to 8˝ x 12˝. Th e resulting fi le will be 2888 x 1971 pixels. If you open it in Photo-
shop, it will display a document size of 11.692˝ x 7.98˝—approximately the confi gured output size of 8˝ x 
12˝. Th e relative resolution for this document size is 247 pixels/inch. Th is is not suffi  cient for a high-quality 
printout; in that case, you would need a relative resolution 300-400 dpi instead. But changing  Output  ▶ 
Printed size  will have no eff ect at all, as it does not aff ect the fi le size; you will have to increase  Input  ▶  Scan 
resolution . You can confi gure  Output  ▶  Printed size  in four ways. Th e fi rst option is to choose Scan size, 
in which case the relative scan resolution (e.g., 2000 spi) equals the printed resolution (here, 2000 dpi). Th e 
second option is to choose a predefi ned value like 8˝ x 12˝ as described above. Th is and the following option 
are handy to estimate whether your scan resolution is suffi  cient for the desired output. Check the bottom line 
of VueScan where absolute and relative pixels for a given output size are displayed (e.g., Output: 2480 x 3580 
pixels 213 dpi 297 x 420 mm). In this case, the scan resolution is too low for the given output size; 213 dpi is 
not suffi  cient for printing. You will need a higher resolution for scanning. If you don’t fi nd the the desired 
output size in the list, you can defi ne it yourself with Manual, the third option. Th e fourth and last option is 
Fixed dpi. Th is option is useful if you just want to show the maximum enlargement for your scan. If you set 
it to 300 dpi per our example, it will show Output: 2480 x 3580 pixels 300 dpi 210 x 297 mm, the exact print 
size for a relative resolution of 300 dpi. 
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Output ▶ Printed width/height 

Th ese options show up only when you choose to confi gure the printed size as Manual. You can confi gure
 Output  ▶  Printed width  and  Output  ▶  Printed height  manually via sliders. Units (pixels, mm, cm, inches, 
etc.) can be defi ned in  Prefs  ▶  Printed units .   

Output ▶ Printed dpi 

In the author’s personal opinion,  Fixed dpi  is the best option in  Output  ▶  Printed size . Here you can con-
fi gure a fi xed relative resolution, e.g., 300 dpi, which will be applied to all scans and will help you estimate 
the printable size of your scans. 

For example: you scan a 35mm slide (25.025 x 36.678 mm) with an  Input  ▶  Scan resolution  of 2000 spi. 
Set the  Output  ▶  Printed size  to Fixed dpi and choose 300 dpi for  Output  ▶  Printed dpi . As in the example 
above, the resulting fi le will be 2888 x 1971 pixels. If you open it in Photoshop, it will display the document 
size as 9.627˝ x 6.57˝ at 300 dpi. Th is is the maximum print size for 300 dpi; if you need bigger prints, you 
will have to increase the  Input  ▶  Scan resolution.

Output ▶ Magnifi cation (%) 

Th is option is available when  Output  ▶  Printed size  is set to Scan size. It allows you to set a magnifi cation 
factor.  Output  ▶  Magnifi cation (%)  does not (!) resample the image and will not (!) change the absolute 
number of pixels. 

For example: you scan a 35mm slide (25.025 x 36.678 mm) with an  Input  ▶  Scan resolution  of 2000 spi. 
Set the  Output  ▶  Printed size  to Scan size. Confi gure a magnifi cation of 100% (the default value). As in the 
example above, the resulting fi le will be 2888 x 1971 pixels. If you open it in Photoshop, it will display the 
document size as 3.67 x 2.5 cm (the size of the original) at 2000 dpi (the scan resolution). Now scan again 
with a magnifi cation of 400%. Th e resulting fi le will still be 2888 x 1971 pixels. If you open it in Photoshop, 
it will display the document size as 14.67 x 10.01 cm (400% of the size of the original) at 500 dpi (the scan 
resolution divided by four).

Output ▶ Auto fi le name 

Th is option is enabled by default and ensures that the fi lenames specifi ed for various fi le types ( Output  ▶   
TIFF fi le name ,  Output  ▶  JPEG fi le name , etc.) are generated automatically. Disable it if you want to assign 
fi lenames for each scan individually. In that case, a window will pop up for every scan asking for the fi lename. 

Output ▶ TIFF fi le 

Th is option enables you to output TIFF fi les. Subsequently, all dependent TIFF options will show up when  
Output  ▶  TIFF fi le  is selected. TIFF is a lossless format, but a TIFF fi le it is not a RAW fi le anymore.

 ▶ Output ▶ TIFF fi le name 
Here you can specify fi lename and storage location for TIFF fi les.

 ▶ Output ▶ TIFF size reduction 
Here you can eff ectively reduce the pixel count of a scan by reducing its output size. By default, the output 
size is set to 1, which means no size reduction. Please see the table below for the eff ects of size reduction. 
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Th e TIFF size reduction merges blocks of several pixels into single pixels. A TIFF size reduction of 2 com-
bines blocks of 2 x 2 pixels and merges them into a single pixel. A similar technique is used for rescaling in 
image editing programs. Th is eff ectively reduces fi le size, and it can help to lessen image noise. Th e eff ect is 
comparable to multiscanning.  

For example: you want a 2000 spi scan of a 35mm slide. Set  Input  ▶  Scan resolution  to 4000 spi and
 Output  ▶  TIFF size reduction  to factor 2. Th e scanner will read the 4000 spi scan and resample it into a 2000 
spi fi le. Depending on your scanner, this can reduce the amount of visible image noise compared to a 2000 
spi scan with no size reduction.  

 ▶ Output ▶ TIFF multi page 
Th is option will create TIFF fi les of several pages comparable to PDFs with every scan (or frame) as a sepa-
rate page. Please keep in mind that few applications support TIFFs with multiple pages, compatibility is 
defi nitely an issue here. Especially for scanning documents, PDFs may be the better alternative when you 
don’t need the superior picture quality of TIFFs.  

 ▶ Output ▶ TIFF fi le type 
Th is option describes the pixel depth of the TIFF fi le. Due to the versatile defi nition of the TIFF format, you 
can choose all steps between 1-bit B/W and 64-bit RGBI—you can even process the infrared channel sepa-
rately. TIFF fi les may be bigger than JPEGs, but they are the best choice when you plan to do post-processing 
in Photoshop. 

 ▶ Output ▶ TIFF compression 
Here you can enable TIFF compression, which in most but not in all cases will reduce the eff ective fi le size. 
TIFF compression is lossless and does not aff ect image quality. In some cases, the eff ect can be counter-
productive and actually increase the fi le size. Th at’s why VueScan has an Auto setting that activates TIFF 
compression only if its use is justifi ed. Alternatively, you can switch it Off  or On. (By default, it is switched 
off .) On rare occasions, TIFF compression can lead to incompatibilities with other applications, as not all 
programs or specifi cations support it. But in general this is really a good way to save storage space without 
any loss of image details.

 ▶ Output ▶ TIFF DNG format 
If you select this option, VueScan will export the fi le in DNG format (*.dng) instead of standard TIFF format 
(*.tif). Regardless of the fi le type, it is still a processed TIFF and not a true RAW fi le. Th is can lead to some 
confusion; either you avoid this, or you choose an appropriate naming convention for these TIFF-DNGs. 
You should avoid mixing them with true RAW-DNG fi les. 

 ▶ Output ▶ TIFF profi le 
VueScan can embed the ICC color profi le specifi ed in  Color  ▶  Output color space  into the TIFF fi le during 
output automatically. When disabled, the output fi le will have no embedded profi le. Th e embedded profi le 
can be identifi ed and used automatically by image editing programs like Photoshop. Image editing applica-
tions can, but don’t nescessarily have to use the embedded color profi le.

TIFF size reduction Width x Height File size Resolution
1 (=no size reduction) 2888 x 1971 pixels 13.2 MB 5.6 megapixels
2 (by factor of 2) 1444 x 985 pixels 3.0 MB 1.4 megapixels
3 (by factor of 3) 961 x 657 pixels 1.3 MB 0.6 megapixels
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Output ▶ JPEG fi le 

Th is option enables JPEG output. JPEGs are processed scans like TIFFs, but they use lossy compression while 
TIFF is a lossless format even when compression is activated. Th e smaller JPEG fi le size comes at a price, as 
JPEGs are not well designed for post-processing. However, if you don’t have big plans for post-processing, 
JPEGs are a good choice due to their small fi le size and the reasonably good image quality.  

 ▶ Output ▶ JPEG fi lename 
Here you can specify fi lename and storage location for a JPEG fi le. VueScan will use this confi guration when-
ever you are scanning JPEGs.

 ▶ Output ▶ JPEG size reduction 
Th is option is identical to  Output  ▶  TIFF size reduction ; please refer to that reference for details. Th e ben-
efi ts and side eff ects of the output size reduction are basically the same, whether TIFF or JPEG is the output 
format. 

 ▶ Output ▶ JPEG quality 
Th is option deals with genuine JPEG functionality. JPEG is by design a lossy fi le format. It uses strong 
compression algorithms to achieve small fi le sizes. Th at’s why JPEGs are smaller than comparable TIFFs. In 
some cases, this lossy compression can lead to visible JPEG artifacts. Th e use of  Output  ▶  JPEG quality  can 
improve image quality. At the default value, which is 90, the images will be already quite small but show few 
artifacts. Lesser values, like 50, will produce even smaller fi les but more visible artifacts. Higher values, like 
100, will produce considerably larger fi les and fewer artifacts than the default value. JPEG is a good choice if 
you don’t want to post-process your images. If you do post-processing with an image editor, your JPEGs will 
most likely be compressed again, which leads to even more artifacts. High compression ratio during scan-
ning is only useful if you are not going to post-process your images.

 ▶ Output ▶ JPEG black/white 
By default, JPEGs store image information for all three color channels (RGB). If you are scanning black-
and-white images, you can use this option for monochrome JPEG fi les. Th ey are even smaller than standard 
JPEGs. 

 ▶ Output ▶ JPEG profi le 
You can embed the ICC color profi le specifi ed in  Color  ▶  Output color space  into the JPEG fi le during out-
put. When disabled, the output fi le will have no embedded profi le. Th e embedded profi le can be identifi ed 
and used automatically by image editing programs like Photoshop. 

Output ▶ PDF fi le 

Th is option enables PDF output. PDF is not an image format but rather a document format that can contain 
text, images, and graphics. PDF is vector-based, meaning that the text it contains can be enlarged indefi nitely 
without any pixelization. Of course, this is not possible for embedded graphics and images, which are not 
vectorized. PDF is the perfect output format if you want to generate electronic documents from your scans. 
It is not well suited for post-processing scans or for producing facsimiles of analog originals.  

 ▶ Output ▶ PDF fi le name 
Here you can specify a fi lename and storage location for a PDF fi le.
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 ▶ Output ▶ PDF size reduction 
Th is option is identical to  Output  ▶  TIFF size reduction ; please refer to that  reference for details. Th e ben-
efi ts and side eff ects are the same, whether TIFF or PDF is the output format. PDF only embeds images, but 
its fi le size will shrink subsequently when the scan size is reduced with this size reduction option. 

 ▶ Output ▶ PDF multipage 
Th is option enables you to create PDFs with multiple pages. For example, if you want to scan a four-page 
document into a single PDF with four separate pages, this is your option of choice. Every scan will be added 
to the PDF until you press the (Last_scan) button. 

 ▶ Output ▶ PDF fi le type 
Here you can confi gure the pixel depth of the PDF, respective of the pixel depth of the scans that VueScan 
embeds into the PDF. Although VueScan displays the full range of options, only these are usable in practice: 
1-bit B/W, 8-bit Gray, and 24-bit RGB. 24-bit (i.e., 8 bits per color channel) is the maximum pixel depth that 
can be embedded into PDFs. 

If you want, you can even choose the 16-bit Infrared channel, but there is hardly any reason to use it for 
PDF generation.  

 ▶ Output ▶ PDF compression 
By default, PDF compression is Off . High-resolution scans lead to very large PDF fi les. You can reduce the 
fi le size by switching compression to On. Th is will instantly shrink even the largest PDF fi les, as the internal 
image format is switched over to JPEG (compression level 90). You can further reduce the PDF size by set-
ting compression to Maximum (JPEG compression level 75).  

 ▶ Output ▶ PDF paper size 
Here you can choose the paper size of the PDF document. If the scanned image is smaller than the chosen 
PDF paper size, it will be centered. If the scanned image is larger than the chosen PDF paper size, VueScan 
will automatically switch to a larger paper size. Th is option will not shrink the scanned image to fi t the cho-
sen paper size.

 ▶ Output ▶ PDF profi le 
You can embed the ICC color profi le specifi ed in  Color  ▶  Output color space  into the PDF fi le during out-
put. When this option is disabled, the output fi le will have no embedded profi le. Th e embedded profi le can 
be identifi ed and used automatically by programs in the subsequent workfl ow. Like with any other embed-
ded profi le, the application will decide whether to use the embedded profi le or not. Embedding a profi le is 
just an off er, but it simplifi es post processing.

 ▶ Output ▶ PDF OCR text 
VueScan’s Optical Character Recognition (OCR) option detects text in the image and marks its location au-
tomatically. Th e resulting PDFs are searchable, and you can mark and copy text in them. Th e documents can 
be searched by search engines as well. All in all, OCR is a very useful feature; a standard scan without OCR 
only displays the image without off ering any of the described options.

While VueScan’s OCR feature is convenient and useful, you can only use it as it is—i.e., it is not self-
learning like dedicated OCR soft ware. For more sophisticated tasks, OCR soft ware like ABBYY FineReader 
is the better (although quite pricey) choice. Professional OCR soft ware can cost much more than a VueScan 
license; but for standard tasks, the integrated functionality of VueScan delivers suffi  cient results. Th ere is an 
easy way to improve the hit rate of VueScan’s OCR. You can and should choose the text language, see text 
below. 
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Output ▶ OCR text fi le  

Another output option, aside from the PDF, is a simple text fi le—more precisely, a Rich Text (*.rtf) fi le which, 
by default, can be edited with many text editors. Th is is a good option if you want to overhaul and process 
automatically detected text easily.  

 ▶ Output ▶ OCR text fi lename 
Here you can specify fi lename and storage location for an OCR text fi le.
 

 ▶ Output ▶ OCR text language  
Here you can choose the language of the text you are scanning. By default, VueScan is shipped with English 
only. Th e option More directs you to the VueScan homepage where you can download many more languages, 
ranging from Bulgarian to Vietnamese. Common languages like Chinese, French, German, Spanish, and 
Portuguese are supported as well; VueScan supports 32 languages at the time of writing this book. Please be 
aware that only characters in the Windows 1252 character set can be written into a PDF. Th is narrows the 
OCR application area mainly to Western European languages. 
 

 ▶ Output ▶ OCR text multi page 
Th is option creates OCR text fi les with multiple pages. For every scan, a new page is created within the same 
text fi le. Th e purpose is the same as  Output  ▶  PDF multipage ; select both options if you want both PDF and 
OCR text fi les as multipage documents.  

 ▶ Output ▶ OCR text RTF format 
Th is option is enabled by default. OCR text fi les are in Rich Text format (*.rtf). Rich Text supports pages and 
some formatting options; it is easier to use than plain text and is supported by most text editors. If you dis-
able this option, the output will be plain text (*.txt) instead. Plain text has an even broader compatibility but 
hardly any formatting options. Plain text does not even support pages, and it does not store the location of 
the text on the original like RTF does. For everyday use Rich Text format is defi nitely easier to handle and its 
compatibility should be suffi  cient as well.

Output ▶ Index fi le 

In the analog world, the index print used to be common. For every roll of fi lm, the photographic labora-
tory would give you an index print—a print with thumbnails of all the pictures on the roll. When you
enable  Index fi le , every scan will be added to the index print until you disable this feature or create a new 
index fi le. Th is option is especially useful when combined with batch scanning. Th e index fi le is saved aft er 
each scan, but you can add more pictures to it with every additional scan. 

 ▶ Output ▶ Index fi lename 
Here you can specify a fi lename and location of an index fi le, which is saved as a Bitmap (*.bmp) fi le.

 ▶ Output ▶ Index frame 
Th is option controls the placement of index fi les. Th e default setting is zero, which means images are added 
in the same way you write: from left  to right and from top to bottom. Th e number of images in a row is de-
fi ned in  Output  ▶  Index across . Aft er each scan, the index setting increases automatically. An index setting 
of 6 in an index with 5 images across indicates the fi rst image in the second row. Confi gure  Output  ▶  Index 
frame  only when you want to replace a specifi c single image in an index print. 
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 ▶ Output ▶ Index width 
Th is is the pixel-width of every single image frame in the index. 

 ▶ Output ▶ Index height 
Th is is the pixel-height of every single image frame in the index. 

 ▶ Output ▶ Index margin 
Th is is the pixel-width margin around every single image frame in the index. 

 ▶ Output ▶ Index across 
Th is is the number of single image frames in one row of the index fi le. For example, when set to 5, the fi rst 
fi ve pictures of the batch scan will be in the fi rst row and the subsequent scan will be the fi rst image in the 
second row.

Output ▶ Raw fi le 

Th is is an exclusive option in VueScan Professional; the Standard Edition does not support RAW output. It 
shows up when your input device is a physical scanner but not when your input device is a fi le. Unless of 
couse, you select  Prefs  ▶  Enable Raw from disk . But genuine raw data comes from the scanner directly. Th e 
RAW fi le is the unprocessed scan data. By storing the scan data, you can perform crucial processing steps, 
like infrared cleaning, at a later stage. 

RAW fi les can be opened with most image editing programs (e.g., Adobe Photoshop) or converters (e.g., 
Adobe Lightroom). However, the full range of scan-specifi c processing options is only available within the 
scanning program VueScan. Depending on your settings or the application you use, Raw scans may look 
dull. For 16-bit scanning (16-bit Gray, 48-bit RGB, 64-bit RGBI), no gamma correction is applied, and un-
corrected images with gamma 1.0 will look gloomy. All 8-bit scans (8-bit Gray, 24-bit RGB) are gamma cor-
rected (gamma 2.2) even as RAW fi les. At this stage, the scans are rough diamonds waiting for fi ne tuning. 
To sum up: RAW fi les are the best way to archive analog originals in digital mode. 

 ▶ Output ▶ Raw fi lename 
Here you can specify a fi lename and location of a RAW fi le. By default, the fi le type is TIFF; if you enable
 Output  ▶  Raw DNG format , it changes to DNG. 

 ▶ Output ▶ Raw size reduction 
Th is option is identical to  Output  ▶  TIFF size reduction ; please refer to that reference for details. If you 
enable the size reduction, the resulting fi le is not a RAW fi le in a strict sense any more because it has been 
rescaled. For true RAW output, choose a lower scan resolution instead.  

If you have used size reduction at the raw level already, a size reduction of the JPEG and TIFF output can 
be critical in some cases. Th e benefi t of the RAW size reduction is that it reduces the scan size to the size you 
actually need. Th e rescaling usually improves overall image quality of the scan as it will eff ectively  reduce 
image noise.

 ▶ Output ▶ Raw fi le type 
Here you can choose all pixel depths ranging from 1-bit B/W to 64-bit RGBI. If you want real RAW data 
output to preserve the full quality of the scan, you should choose 48-bit RGB for black-and-white negatives 
and all refl ectives and 64-bit RGBI for color slides and negatives. Th is is the full color information of the 
scanner, and you will have maximum range for post-processing. 
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 ▶ Output ▶ Raw output with 
Here you can choose what operations in VueScan trigger RAW output. You have the options Save, Preview, 
and Scan. Save should be avoided for true raw data scanning, as it saves the processed data—even infrared 
cleaning and grain are applied to the RAW fi le and cannot be reverted. Preview saves the raw data of the pre-
view. For most purposes, the best choice is Scan. Both Preview and Scan save unprocessed RAW. 

 ▶ Output ▶ Raw save fi lm 
If you choose this option, fi lm corrections in the  Color  tab are written into the RAW fi le. Furthermore, rota-
tion and infrared cleaning are written into the RAW fi le as well. Th e resulting fi le is not exactly RAW data 
anymore, but it is well suited for post-processing with programs like Adobe Lightroom. 

 ▶ Output ▶ Raw compression 
Th is is more a TIFF compression than a RAW compression as the name may suggest. It is only available for 
TIFF and not for DNG. For details, refer to  Output  ▶  TIFF compression ; the function behind it is the same. 

 ▶ Output ▶ Raw DNG format 
Here you can set the RAW format to DNG instead of TIFF. With DNG, the fi les are better adapted for post-
processing in Adobe Camera Raw or Lightroom than TIFF RAW. Please keep in mind that scan-specifi c 
corrections like  Infrared clean  can be performed only in VueScan itself.

Output ▶ Description 

Here you can add a description of the scan. For image fi les, it will be part of the EXIF fi elds; for OCR text 
fi les, it will show up at the top of the page.    

Output ▶ Copyright 

Th is is another EXIF fi eld for copyright information. 

Output ▶ Date 

Th is EXIF fi eld is used to record the creation date of the analog original. According to ISO standards, the 
syntax is YYYY:MM:DD HH:MM:SS. YYYY is the year, MM is the month, DD is the day, HH is the hour, MM 
is the minute, and SS is the seconds. You can use diff erent syntax options for the input (e.g., 1989, April 1989, 
19980401, 01/04/1989, 1989:04:23), and VueScan will try to convert them to ISO automatically. 

Output ▶ Log fi le 

Th e log fi le records all operations of the scanner. Th is fi le is named vuescan.log. You will fi nd this fi le in the 
VueScan folder. In case of a problem, you can send the log together with a bug report to Ed Hamrick. 

Output ▶ Log fi le max size (MB) 

Th e standard size of the log fi le is 2 megabytes.  You can enlarge it up to 100 megabytes if needed.  

Output ▶ Default options 

Here you can reset the default settings of the  Output  tab with a single click.
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A complete reference of the  Prefs  tab

13
Reference – Prefs Tab
Th e  Prefs  tab—an abbreviation for preferences—is the central 
control box for confi guring VueScan. Here you can confi gure 
all of the general settings that will help you adjust the pro-
gram to your individual needs. A few clicks in the  Prefs  tab 
can save a lot of eff ort in your daily routine.  
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13.1 Reference – Prefs tab 

The  Prefs  tab is the central control box for confi guring VueScan. Here you can confi gure general settings 
for the program and you can tweak VueScan according to your individual needs. Please keep in mind 

that the color management settings in VueScan are not part of the  Prefs  but rather of the  Color  tab. 

Prefs ▶ Language  

Th e original language of VueScan is English, but now it supports all of the popular western languages—Ger-
man, French, Spanish, and Portuguese—and a good portion of the rest, including Vietnamese. In the default 
setting, Standard, VueScan will switch automatically to the same language as your operating system. Alter-
natively, you can select one of the languages from the dropdown list. If you cannot fi nd your language in the 
list, choose More, which will redirect you to Ed Hamrick’s website where you can check the current status of 
the localization. By the way: Ed Hamrick is always happy if somebody supports him with translations. 

Prefs ▶ Font size (pt) 

Here you can confi gure the font size in VueScan according to the acuteness of your vision or the size of your 
screen. Th e unit of measurement for font size is point. When you choose a diff erent font size, the display will 
change immediately. Th e recommended minimum font size by Ed Hamrick is 6 points, but for daily use it 
should be 8 points or larger. Larger fonts improve readability but consume more monitor space. 

Prefs ▶ Crop units 

Th is option allows you to select how crop units are measured. Th e default is mm, but you can also choose 
pixel, cm, inch, pica, or point instead. Picas and points are typographic units; if you want to select them, you 
should know what they represent. Lesser mortals will be happier with metric (mm, cm) or inch units.  Prefs 
 ▶  Crop units  only aff ects the display units in the  Crop  tab. It will not change the output sizes of the scan.  

Prefs ▶ Printed units 

Compare  Prefs  ▶  Crop units . Th e only diff erence is that this option is for print sizes.  Prefs  ▶  Printed units  
is displayed in the status area (lower right line below the  Preview / Scan  window).

Prefs ▶ External viewer 

Here you can enable an external image viewer that opens the images aft er scanning automatically (see next 
option).

Prefs ▶ Viewer 

In this option you can set the fi le path to an external viewer for your scanned images. Th e standard setting 
is default, i.e., the system default of your operating system, but you can of course choose any other viewer 
you like. Th e system default handling depends on your operating system. In Windows 7, you have Default 
Programs in the control panel where you can assign a default program for each fi le extension individually. In 
Mac OS X, you have to click on an image, choose File ▶ Show info, select an application, and choose Change 
all to make it a general system setting. Tip: You can even choose an image editor like Photoshop. Th at’s very 
convenient when you want to do post processing immediately aft er scanning.
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Prefs ▶ External editor 

Here you can enable an editor for OCR text fi les.  

Prefs ▶ Editor 

Here you can set the fi le path to an external editor for OCR text fi les. See  Prefs  ▶  Viewer  for details; the 
process is the same.  

Prefs ▶ Browser 

Th is option is found exclusively on Linux systems. It allows you to choose a diff erent web browser from the 
default browser. Most Linux systems use Mozilla by default.

Prefs ▶ Graph type 

You can display a graph (i.e., histogram) in VueScan below the tabs via Image ▶ Graph. It is not visible in 
[Guide_me] mode. Depending on your choices, it will show diff erent graphs.

 ▶ Raw 
Th is graph shows the uncorrected (gamma 1.0) curves of RGB color and the infrared channel. Th e histogram 
curves of the RAW fi le will not change when you confi gure settings in the  Color  tab. 

 ▶ B/W 
Th is graph shows the black-and-white points in the histogram. You can confi gure them here manually by 
pulling the triangular sliders below the curve. Th e curves of the histogram displayed in the background will 
not change when you confi gure settings in the  Color  tab.

 ▶ Curve  
Th is option basically resembles the Curves option in Photoshop. In Photoshop, Curves is a popular and 
versatile option, e.g., to control the contrast of an image. In VueScan, it’s a diff erent story. First, there is no 
histogram display that allows you to supervise the eff ect of your changes in real time. Second, you can con-
trol the curve only by two rectangular sliders that are far from precise. Photoshop is by far the better tool.

 ▶ Image 
Th is is where you can survey, in real time, the eff ect of your changes in the  Color  tab on the histogram of 
the fi nal image. Enable it by default if you want to see what your confi guration does to the scan’s tonal values.  

Prefs ▶ Button 1/2/3/4 action 

Most fl atbed scanners have this option; it is displayed when your scanner has buttons for rapid access. If you 
use the manufacturer’s soft ware, you can press a button and the scanner will perform the scan automatically. 
With VueScan, you can use them for general commands like  Scan, Print, Preview, and Save. Th is is nice, 
but usually the customization in the manufacturer’s soft ware is even better. With the manufacturer’s soft -
ware, you can assign one button to 81/2" x 11" PDFs, another to Photocopier, and so on. When you press the 
diff erent buttons, the scan program will use the diff erent confi gurations. To achieve a similar eff ect in 
VueScan, you must confi gure the application accordingly before you press a button. 

Vue_book_large.indb   149 13.04.2011   19:47:22



150 13 Reference – Prefs Tab

Pr
ef

s 
ta

b

Prefs ▶ Auto refresh 

Th is option, enabled by default, refreshes the image automatically to display changed settings in the preview 
in real time. You can switch it off  and do the refresh manually via the menu Image ▶ Refresh if you want. 
Unless you have a very old and slow computer—which you should not use for scanning, anyway—there is 
no reason to disable the automatic refresh. 

Prefs ▶ Display Raw scan 

Th is option provides a display of the scanning process in real time. Like the option above, you can disable 
it to save some computing resources, but with a fast computer this is not necessary. Apart from that, it is 
interesting to see what happens in VueScan during scanning, especially if you display Image ▶ Graph image. 

Prefs ▶ Display positive 

Th is option is displayed only when  Input  ▶  Media  is set to either B/W negative or Color negative. It shows 
the raw scan as a positive so you can evaluate the initial visual impact of the scan. Th e fi nal conversion can 
look quite diff erent, depending on what fi lm profi le you use. 

Prefs ▶ Splash screen 

Here you can disable the splash screen that pops up when you start VueScan. Th is accelerates the start of the 
application for a split second.  

Prefs ▶ Histogram type 

By default, the histogram is Linear, meaning that it displays the number of samples on the Y axis (the vertical 
axis). If you want to display the square root of the number of samples, use Square root. For the logarithm of 
the number of samples, use Logarithmic. For average use, Linear is recommended.  

Prefs ▶ Animate crop box 

Th e crop box is animated by default, which makes it easier to see—especially when you use skewing. But if 
you disable it, you can set the crop more precisely as there is no blinking line to confuse your eye. 

Prefs ▶ Thick crop box 

By default, a thick line marks the crop box. Th is is easier to see but less precise than the thin line you get by 
disabling this option. 

Prefs ▶ Add extensions 

VueScan’s automatically generated fi lenames always have a fi le extension (like *.tif). By default, this op-
tion is enabled. If you manually choose fi lenames (e.g., Scan_001), the system will add the extension (*.tif) 
automatically, and the complete fi lename will be Scan_001.tif. Since you don’t have to add a fi le extension 
manually, this saves you some typing. If you type in a fi lename with a period (e.g., Scan_001.abc), the period 
and everything following it will be cut off  and the confi gured fi le extension will be added (e.g., Scan_001.tif). 
Th e offi  cial VueScan documentation states, that no fi le extension will be added if the fi le name has a period. 
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But at least on Windows computers, this is not the case. Even with disabled  Prefs  ▶  Add extensions , 
VueScan will still automatically add a fi le extension on a Windows computer but will not cut off  periods.

Prefs ▶ Substitute date 

Th is is a clever option that helps you assign the date of the scan to fi le names. It substitutes codes with date 
specifi cations. Th e date codes are YYYY (for the four-digit year, e.g., 2011), YY (for the two-digit year, e.g., 
11 for 2011), MM (the month, e.g., 03 for March) DD (the day of the month), HH (the hour) II (the minute), 
and SS (the second). VueScan uses the system time of your computer. Th e date substitution works only when 
at least three date/time codes are used in the fi le name. YYYYMMDD.tif will work, while YYYYMM.tif will 
not work. Hyphens, underscores, and other fi llers are accepatable as well, e.g., YYYY-MM-DD.tif is fi ne. You 
can combine date substitution with auto numbering (YYYY-MM-DD_0001+.tif) to avoid double naming.  

Prefs ▶ Warn on delete 

Th is option displays a warning message when you scan multipage originals with  Input  ▶  Multi page . With 
Page ▶ Delete, you can delete single pages, and to avoid inadvertent deletions, VueScan will ask you if you 
are sure you want to delete. 

Prefs ▶ Warn on overwrite 

Th is option warns you when VueScan wants to write a fi lename that already exists. It is enabled by default, 
and you should not touch it. Instead of overwriting an existing fi le, it is better to delete it manually from the 
hard disk. If you disable the warning, mistakes like this can easily happen: you scan a full batch, and every 
new scan wipes out the preceding scan because of an inaccurate naming convention.  

Prefs ▶ Warn on not ready 

Th is option displays a warning message when the connected/chosen input device is not ready, e.g., a scanner 
that is not ready or a RAW fi le that does not exist.

Prefs ▶ Warn on no scanner 

Th is option warns you when the scanner is not connected. Aft er connecting the scanner, you may need to 
exit VueScan and start it again for proper functioning. 

Prefs ▶ Exit when done 

Th is option closes VueScan aft er the scan is fi nished. It can be useful if you do batch scanning unsupervised. 
Once the VueScan window disappears from the screen, the batch is completed. 

Prefs ▶ Beep when done 

Here’s another VueScan option that is nothing less than ingenious, despite or even because of its simplicity! It 
makes the computer beep aft er the scan is completed. Th is may sound not too exciting, but it is a rare feature 
among scanning programs. It can be very handy when you stay in the room while the scanner is busy with 
a batch and you just need acoustic feedback when it’s done. VueScan uses the default sound in Windows 
(Control Panel ▶ Sounds in Windows 7) and a simple beep in Linux and Mac OS X.

Vue_book_large.indb   151 13.04.2011   19:47:22



152 13 Reference – Prefs Tab

Pr
ef

s 
ta

b

Prefs ▶ Beep when auto eject 

Once again, the computer will play a sound, this time when the scanned original is auto ejected. Th is is use-
ful when you are scanning fi lm strips with a slide feeder and the auto ejection is confi gured aft er the scan. 
When you hear the beep, not only is the scan ready but also you can grab the ejected analog original. 

Prefs ▶ Use temp fi le name 

If this option is enabled, VueScan will use the *.tmp fi le extension for TIFF, JPEG, or PDF fi les that are being 
written but are not closed yet. When the fi le is closed, it will be renamed with its appropriate fi le extension. 
Th is is useful for monitored directories; once the fi le has the proper extension, it can be processed automati-
cally by another application.

Prefs ▶ Anti-alias text 

Text and line art scans (i.e., 1-bit B/W) can be displayed with anti-aliasing in the  Preview  or  Scan  window 
for a smoother look. Th is option consumes some processing power and is enabled by default. You can dis-
able it if you are using an older computer. But seriously, you should better get a new computer for scanning.

Prefs ▶ Anti-alias image 

Th is option enables anti-aliasing in grayscale and color images. Please refer to  Prefs  ▶  Anti-alias text  for 
details. 

Prefs ▶ Enable density display 

Th is option enables you to display density values in the footer. To activate it, position your mouse over the 
image in the  Preview  or  Scan  window, press the (Ctrl) key, and move the mouse. You will see density 
values (e.g., Density: 1.84 1.76 1.84) replace RGB values (e.g., Color: 202 187 185). Release the (Ctrl) key 
and move the mouse again to reactivate the RGB display. Ed Hamrick comments on this feature as follows:

“Th e density is computed as log10 (max intensity/(intensity+1)).  For instance, if a scanner has 12 bits per 
sample, the maximum sample value is 4095 and the minimum sample value is 0.  Th e maximum density of this 
scanner is log10(4095/1) or about 3.6.  Basically, the darker the fi lm, the bigger the density value. Th e scale is 
logarithmic.” 

Prefs ▶ Enable raw from disk 

Raw data is the original unprocessed data of the scanner; that’s why you usually can’t produce raw fi le output 
from RAW fi les on your hard disk. As a general rule, you must use a scanner if you want to save raw fi le 
output. 

Here is an exception to the rule: with  Prefs  ▶  Enable raw from disk, you can actually use a RAW fi le on 
your hard disk for raw output. Th is can be justifi ed if you need RAW fi les with a lower resolution than the 
source fi les (e.g., 2000 spi instead of 4000 spi) or with a lower pixel depth (e.g., 48-bit RGB instead of 64-bit 
RGBI, or grayscale instead of RGB). Th is will free up some hard disk space if you delete the originals. In 
case you aren’t sure about the best pixel depth/resolution, here is my advice: if possible, scan everything at 
the maximum settings, and you will always be able to shrink even the RAW fi les! Th is is another remarkable 
feature of VueScan that you will not fi nd in standard scanning soft ware. 
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Prefs ▶ Disable scanners 

By default, VueScan lists all scanners plus the option File in  Input  ▶  Source . Here you can switch between 
scanners. However, in practice, this can lead to some confusion as the individual scanners may need some 
scanner-specifi c confi gurations. If you have a fl atbed scanner and a fi lm scanner, and if you are using raw 
data from disk, you should install three copies of VueScan. Th en you can use each installation exclusively for 
each scanner and also work with them in parallel. A multicore CPU is advisable. With  Prefs  ▶  Disable scan-
ners , you can disable some or all scanners. For example, you can use the setting All scanners to completely 
disable all scanners for an installation, then use it for raw data processing exclusively. Disabling individual 
scanners can be a bit more tricky, as they are not always listed. All in all, this functionality is interesting but 
could use some revision before it becomes really useful. Th e settings take eff ect aft er you restart VueScan.

Prefs ▶ Enable sliders/spin buttons 

Use these options to enable or disable sliders and spin buttons. Th e spin button is the little up/down arrow 
to the right of the sliders.  It lets you adjust values in small increments, while the sliders let you adjust the 
options more coarsely. Disabling sliders and spin buttons can save some space if you are working on a small 
screen, but usability will suff er. 

Prefs ▶ Enable popup tips 

Popup tips are displayed for many options and buttons by default. Just hover your mouse over the text of the 
option to see the eff ect. It will take a second or so for the popup to appear. You can disable the popups if you 
don’t need that kind of help. 

Prefs ▶ Calibration period 

Scanner lamps, lamp color, and uniformity can be aff ected by the ravages of time. Th is eff ect is less pro-
nounced in modern LED scanners, but it is defi nitely an issue in old-fashioned scanners with fl uorescent 
lights. A calibration from time to time is recommended. Th is option allows you to set the maximum number 
of days before VueScan reminds you to calibrate the device again. It shows up only for  certain scanners.   

Prefs ▶ Image memory (MB) 

Usually computer applications grab as much memory on your computer system as they want, and this can 
lead to a shortage of available memory. Since VueScan is a polite little program, it lets you decide how much 
memory it is allowed to use. On a computer with 2 GB RAM it will assign 1 GB by default to be used for 
all previews and scans. Depending on the size and resolution of your scans, you may want to increase this.

Prefs ▶ Window maximized 

By default, VueScan remembers the size and position of its window. If you exit VueScan and restart it, the 
window will restore to the last position and size automatically. With  Prefs  ▶  Window maximized , VueScan 
windows will always pop up in full frame.

Prefs ▶ Windows iconized 

Enable this if you want VueScan to start minimized, and it will only appear in the task bar as an icon.
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Prefs ▶ Window x/y off set/size 

Th is option lets you confi gure the off set (i.e., position) of the VueScan window and its exact size. Use the slid-
ers for confi guration as it does not scale stepless. Th ese options only take eff ect when you restart VueScan. 
Next time you open the program you will see the diff erence. 

Prefs ▶ Default options

Here you can reset the confi guration of this tab to its default value.

In the  Prefs  tab you can choose between diff erent measurement units. It does not matter whether you prefer inch or millimeter, with 

VueScan you can pick any of these options. Even units like centimeter, pica, pixel, or point are supported.
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14
Menus, Buttons, and 
Shortcuts
You will fi nd most options of VueScan in the tabs, but if you 
use the tab section exclusively, you will probably miss the best 
part. Th e menu section hosts some of the most powerful op-
tions of VueScan, and these do deserve your attention. Many 
of the menus have keyboard shortcuts, and on Windows and 
Linux these shortcuts generally use the Control key.  On Mac 
OS X most shortcuts use the Command (or Apple) key. Th e 
shortcut is displayed in the menu next to the option. 
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156 14 Menus, Buttons, and Shortcuts

Function in 
menu path

Button-
name

Icon Shortcut 
Windows + 
Linux

Shortcut 
Mac

Defi nition 

14.1 File menu
File ▶ Save 
image

Save Ctrl-S Command- 
S

Saves the last image scanned, either 
Scan or Preview.

File ▶ Last 
page

Last page Ctrl-G Command- 
G

Option 1: When using  Input  ▶  
Multi page , all pages in memory 
will be saved to the hard drive. 
Option 2: When using Output  ▶  
TIFF multi page  or Output  ▶  PDF 
multi page , VueScan will write all 
pages in memory to the hard drive. 

File ▶ Page 
setup

-- -- -- -- Page setup for printing.

File ▶ Print 
image

Print 
image

Ctrl-P Command- 
P

Prints the current image in the 
memory, either Preview or Scan.

File ▶ Load 
options

-- -- F10 F10 Loads an *.ini fi le with 
confi guration options. Th e current 
setting of the program is stored in 
vuescan.ini.

customized 
entries 
depending 
on user 
settings

-- -- F1 to F9 F1 to F9 Any customized *.ini fi le in 
VueScan folder will appear in 
the dropdown list of the menu. 
Subsequently you can load them 
by the associated function key 
shortcut. 

File ▶ Save 
options

-- -- -- -- Saves the current confi guration 
options to an *.ini fi le.

File ▶ 
Default 
options

-- -- -- -- Resets all options for VueScan 
and all scanners to default 
values. Should only be used in 
emergencies, e.g., if you wreck the 
system completely. Better to use 
the  Default options  for each tab if 
needed—they are more selective.

File ▶ Quit -- -- Ctrl-Q -- Th is exits VueScan, it closes the 
program. In Mac OS, you can fi nd 
this function in the VueScan menu 
instead. 
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menu path

Button-
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Icon Shortcut 
Windows + 
Linux

Shortcut 
Mac

Defi nition 

14.2 Edit menu
Edit ▶ Copy 
image

-- -- Ctrl-C Command- 
C

Copies the current image to the 
clipboard of your computer. You 
can insert it from there into any 
image editor.

Edit ▶ Copy 
OCR text

-- -- Ctrl-T Command- 
T

Copies the OCR text of the current 
Preview or Scan into the clipboard 
of your computer. You can insert it 
from there into any text editor. It 
is available only if  Input  ▶  Media  
is either Text or Microfi lm. For a 
good text detection rate, the scan 
resolution should be at least 300 spi.

14.3 Scanner menu
Scanner ▶ 
Preview

Preview Ctrl-I Command- 
I

Triggers a preview.

Scanner ▶ 
Scan 

Scan Ctrl-N Command- 
N

Triggers a scan.

Scanner ▶ 
Eject

-- -- Ctrl-J Command- 
J

Ejects the analog original from a 
feeding unit.
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Shortcut 
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Scanner ▶ 
Calibrate

-- -- -- -- Triggers a calibration. Th is is a 
kind of pre-glow process that will 
help to fi x three things: 
- Uneven lighting of the scan
- Diff erent light sensitivity of the 
CCD elements
- Diff erent dark voltage level of the 
CCD elements
Don’t confuse scanner calibration 
with scanner profi ling! Th e goal 
of calibration is for the scanner 
to produce consistent scans on 
the whole tray. Th e goal is not 
to achieve true colors. Scanners 
have to support calibration on 
the hardware level. In contrast, 
profi ling needs no hardware 
support; instead, it needs  soft ware 
support and an IT8 target. Th e 
goal of profi ling is to produce true 
colors. If you are profi ling your 
scanner, in general you should 
execute a calibration beforehand.

Scanner ▶ 
Focus

-- -- Ctrl-F Command- 
F

Focuses the scanner if the scanner 
supports it. Film scanners usually 
do; fl atbed scanners usually don’t. 

Scanner ▶ 
Exposure

-- -- -- -- Calculates the exposure, i.e., the 
values for  Input  ▶  RGB exposure  
and  Input  ▶  Infrared exposure . 
By default, the exposure is based 
only on the cropped part of the 
image; change that with  Crop  ▶
 Border %  and  Crop  ▶  Buff er % .

Scanner ▶ 
Previous

-- -- PgUp PgUp Switches to the previous frame if 
you are scanning multi page.

Scanner ▶ 
Next

-- -- PgDn PgDn Switches to the next frame if you 
are scanning multi page.
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14.4 Profi le menu
Profi le ▶ 
Profi le 
scanner

-- -- -- -- Profi les the scanner. Th e process 
will generate an ICC profi le for the 
scanner. You need a prefabricated 
IT8 target. For refl ectives and 
transparencies, you need diff erent 
targets and diff erent profi les.

Profi le ▶ 
Profi le 
printer

-- -- -- -- Profi les the printer, i.e., the 
individual combination of printer, 
ink, and paper. You must print out 
a target on your printer before you 
can do the profi ling.

Profi le ▶ 
Profi le fi lm

-- -- -- -- Profi les fi lm. You will need to take 
a photo of an IT8 target with the 
specifi c fi lm before you can start 
profi ling it.

14.5 Image menu
Image ▶ 
Refresh

-- -- Ctrl-E Command- 
E

Refreshes the displayed image and 
histogram automatically by default. 
If you disabled  Prefs  ▶  Auto 
refresh , you can refresh the image 
here manually.

Image\Zoom 
in

Zoom in Ctrl-Z Command- 
+

Zooms into the image.

Image ▶ 
Zoom out

Zoom out Ctrl-U Command- 
-

Zooms out of the image.

Image ▶ 
Rotate right

Rotate 
right

Ctrl-R Command- 
R

Rotates the image clockwise by 90 
degrees.

Image ▶ 
Rotate left 

Rotate left Ctrl-L Command- 
L

Rotates the image 
counterclockwise by 90 degrees.

Image ▶ Flip -- -- -- -- Flips the image. Flipping equals a 
rotation of 180 degrees. 

Image ▶ 
Mirror

-- -- -- -- Mirrors the image from left  to 
right.
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Shortcut 
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Image ▶ 
Release 
memory

-- -- Ctrl-Y Command- 
Y

VueScan stores raw data of scans 
and previews in memory for 
faster processing. You can use 
this command to release this 
data from the memory. Th is will 
temporarily free up the memory 
for other programs. If you want 
to reduce the amount of memory 
that VueScan uses permanently, 
change the confi guration in  Prefs  
▶  Image Memory  instead.

Image ▶ 
Graph off 

-- -- Ctrl-0 Command- 
0

Default setting, no graph is 
displayed.

Image ▶ 
Graph raw

-- -- Ctrl-1 Command- 
1

Shows the uncorrected (gamma 
1.0) curves of the RGB color and 
infrared channels. Th e histogram 
curves of the RAW fi le will not 
change when you confi gure 
settings in the  Color  tab.

Image ▶ 
Graph black-
and-white

-- -- Ctrl-2 Command- 
2

Shows the black and white 
points in the histogram. You 
can confi gure them manually 
by pulling the triangular sliders 
below the curve. Th e curves of 
the histogram displayed in the 
background will not change when 
you confi gure settings in the  Color  
tab. 
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Image ▶ 
Graph curve

-- -- Ctrl-3 Command- 
3

Resembles the Curves option in 
Photoshop. In Photoshop, this 
option can control the contrast 
of the image. In VueScan, it’s a 
diff erent story. First, there is no 
histogram display that allows you 
to supervise your changes in real 
time. Second, you can control the 
curve only by two rectangular 
sliders, which is far from precise. 
Photoshop is the better tool for 
curve corrections.

Image ▶ 
Graph image

-- -- Ctrl-4 Command- 
4

Surveys in real time the eff ect of 
your changes in the  Color  tab on 
the histogram of the fi nal image. 
Enable it by default if you want to 
see what your confi guration does 
to the tonal values of a scan. Th is 
is “the” histogram of the processed 
image. 

14.6 Page menu
VueScan displays the  Page  menu only for  Input  ▶  Multi page . Use the page menu to navigate within 
the pages (frames) and to organize the scans for the fi nal output fi le. 
Page ▶ 
Previous

-- -- PgUp PgUp Jumps to the previous frame.

Page ▶ Next -- -- PgDn PgDn Jumps to the next frame.
Page ▶ First -- -- Shift -Home Shift -Home Jumps to the fi rst frame.
Page ▶ Last -- -- Shift -End Shift -End Jumps to the last frame.
Page ▶ Move 
front

-- -- Shift -PgUp Shift -PgUp Moves the current page one 
position to the front, e.g., from 
frame 3 to frame 2.

Page ▶ Move 
back

-- -- Shift -PgDn Shift -PgDn Moves the current page one 
position to the back, e.g., from 
frame 3 to frame 4.
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Page ▶ 
Reverse

-- -- -- -- Reverses the order of the pages. 
Th e original fi rst page will become 
the last page and vice versa. Your 
batch is turned upside down.

Page ▶ 
Interleave

-- -- -- -- Most document feeders will not 
support double-paged/duplex 
scanning. For example: You have 
a batch of 3 paper documents, and 
all are double sided. One front 
page (F) and one back page (B) 
each. Th e whole stack is FBFBFB. 
You will have to scan the front 
pages fi rst (FFF) and the back 
pages aft er (BBB). Th e resulting 
image fi le is FFFBBB. With the 
Interleave command, you can 
restore the order of the document 
to FBFBFB.

Page ▶ 
Separate

-- -- -- -- Converts a stack of FBFBFB into 
FFFBBB. Th is command is simply 
the opposite of  Page ▶ Interleave. 

Page ▶ Swap 
even/odd

-- -- -- -- Swaps front and back pages. If 
your scan is BFBFBF because you 
scanned the documents with the 
back side fi rst by mistake, the 
command will convert the order 
back to FBFBFB.

Page ▶ 
Delete

-- -- Shift  - Del Shift  - Del Deletes the current page/frame of 
the batch; the other pages remain 
intact. It’s quite handy if you need 
to rescan a page for whatever 
reason.

Page ▶ 
Delete all

-- -- -- -- Deletes all pages. Aft erwards, you 
will have to start from zero. 
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14.7 Help menu
Help ▶ User’s 
Guide

-- -- -- -- Directs you to the User’s Guide 
on Ed Hamrick’s web page. Th e 
User’s Guide contains a complete 
reference for all VueScan’s options 
and buttons, plus some workfl ows. 

Help ▶ 
Usage tips

-- -- -- -- Opens a popup window with usage 
tips in VueScan.

Help ▶ 
Release 
Notes

-- -- -- -- Directs you to the release notes on 
Ed Hamrick’s web page. Here you 
will get detailed information about 
the version history of VueScan.

Help ▶ 
About

-- -- -- -- Directs you to information about 
your licensing status and the 
version number of your soft ware. 
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14.8 Troubleshooting

VueScan will not detect my scanner in the Input tab; why?

VueScan will only display scanners if the driver for the scanner is installed properly on the operating system 
and the scanner is up and running before (!) you start the VueScan application. VueScan will not update its 
status when you power up a scanner aft er you started the application. Close VueScan and start it again.

The scans of my slides look dull; what is the reason?

Even if you use the confi gurations of the  Color  tab you will most probably experience that a brillant slide will 
result in a rather dull looking digital image. If you own a good scanner and have followed the instructions 
of this book, there is nothing to worry about. Th ere is simply one step left  in the work process that’s missing: 
post processing! Post processing with a good image editor like Adobe Photoshop will convert the scan into 
a presentable digital image. Th is is an essential step in the workfl ow, you cannot fully automate this. You will 
likely have to process tonal corrections, remove color casts, and apply unsharp masking as the very last step 
of your workfl ow. Th e amount of processing needed will vary from image to image. But this has nothing to 
do with scanning, this is basic image editing. If you just want fast scans and don’t want to spend time on post 
processing use  Color  ▶  Color balance  ▶ Auto levels and the built-in unsharp mask of VueScan’s fi ltering 
options instead. Th is will improve your scans to some degree without too much eff ort. But manual post-
processing is surely the better, yet more time consuming, choice.

My scans are less sharp than the images of my DSLR; why?

Scanning is basically the conversion of an analog original into a digital image fi le. Th is conversion is far 
from being perfect. And you should be aware of the fact than all small imperfections in this long process-
ing change will add up in the end to a visible loss of image quality. Th e analog image itself, especially small 
formats like 35mm, will usually have its issues as well. Film is never as fl at as a digital image sensor and the 
lenses of ancient times left  something to be desired as well. But in the old times nobody realized that, be-
cause you had no 100% view in Photoshop as nowadays. Even the best fi lm scanners suff er from problems 
like shallow depth of fi eld; even a curvature of less than 1 mm in the fi lm can lead to additional unsharp-
ness. Th at’s why even a 20 megapixel scan will usually have a lower absolute quality than a shot with any 
6 megapixel consumer DSLR of the fi rst generation. Even when you take all this into consideration you 
can still achieve good quality with scanning by absolute standards. You just have to take it into proportion,
technologies change and improve over time. And a scanned image will still look like an analog image. Th is 
is part of the fascination of analog originals and some people love it, some don’t.

I have weird colors in the Preview/Scan. What happened?

Weird colors in VueScan are usually caused by wrong settings in the  Color  tab. In most cases they are due to 
a wrong ICC-profi le. Th at can happen easily if you are using two scanners with the same VueScan installa-
tion. To avoid this, you can install VueScan two times, then you have a separate installation for each scanner 
and can not mix up ICC-profi les any more.

Preview/Scan is not working at all. What is the reason for this?

Th is happens frequently when you are using a fl atbed scanner in transparency mode. In this case, just open 
the scanner and remove the blindfold that is covering the transparency unit. Th at should fi x the problem.
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My scans are too small/too big. What went wrong?

Usually this problem is caused by a wrong confi guration in  Input  ▶  Quality . You can avoid this by choosing 
the scanning resolution manually in Input  ▶  Scan resolution . If this does not help, check the output size 
reduction that you can fi nd in  Output  tab for the diff erent  fi le types. If set to a value higher than 1, VueScan 
will shrink the fi les during output process. Sometimes this eff ect is desired, sometimes not.

I have 40,000+ slides. How can I scan them fast and in good quality?

Th ere are some technologies like batch scanning and automated document/slide feeding that will help you to 
scan large numbers of originals. But the key factor for effi  cient scanning is found on another level. You have 
to carefully sort out your analog originals and choose only the good ones for scanning. Th at’s the fastest and 
most effi  cient way to tame even big archives.

My RAW scans look dark in Explorer View. What can I do about it?

You are probably using TIFF-RAW. For many applications this just looks like any average TIFF fi le and the 
application assumes, that the image gamma is 2.2 although it is just a gamma of 1.0 as a RAW fi le. Th e solu-
tion is easy. Use DNG for your RAW fi le output instead. DNG has a gamma of 1.0 as well, but most applica-
tions will recognize it as a RAW fi le and automatically apply a gamma correction for proper display.

My scans have artifacts. What is the reason?

First of all, you have to ensure you are using a lossless image format like TIFF or RAW. Lossy formats like 
JPEG can add artefacts to your scan due to their compression algorithm. If this does not solve the problem, 
have a closer look at the fi ltering options. A strong setting for dust and scratch removal via  Filter  ▶  Infrared 
clean  can in some cases lead to unwanted artifacts. Like with any other fi ltering option, you should use  In-
frared clean  with the weakest setting that leads to the desired correction result.

Infrared Clean wipes out the details. Why?

For classic black-and-white fi lm you cannot use  Infrared clean  due to the silver particles it contains.  Infra-
red clean  will in general work fi ne with Kodachrome, but only if the development of the fi lm had been done 
carefully. In some rare cases there are still silver particles from the development left  in the Kodachromes and 
that will lead to loss of image details as well. With E6-slides and C41-negatives you should experience no 
problems. But even then, you have to ensure that the fi lter setting is not too strong.

Some of my slide scans are out of gamut. How can I avoid this?

Out of gamut always happens when the output color space cannot display all colors of the raw scan. Th is 
happens frequently when you are using small color spaces like sRGB. But even larger color spaces like Adobe 
RGB can not always display all colors of the scan. You can choose a larger color space to avoid this, like Ekta 
Space, Pro Photo or Device RGB, the color space of the scanner. Th is will save the full gamut for the moment, 
but you should be aware that you will have to convert these fi les again at a later stage for most output pur-
poses. Usually it is not visible in the fi nal image that parts of it were out of gamut. It is not as obvious as e.g. 
blown highlights. In VueScan, the RAW fi le will contain the full gamut of the scan, no matter what output 
color space is confi gured. Please be aware of the fact that some corrections like  Filter  ▶  Sharpen  can lead 
to out of gamut as well.
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Get in the Picture!

c’t Digital Photography gives you exclusive 
access to the techniques of the pros.

Keep on top of the latest trends and get your 
own regular dose of inside knowledge from our
specialist authors. Every issue includes tips 
and tricks from experienced pro photographers
as well as independent hardware and software
tests. There are also regular high-end image
processing and image management workshops
to help you create your own perfect portfolio.

Each issue includes a free DVD with full and c’t
special version software, practical photo tools,
eBooks, and comprehensive video tutorials.

Don’t miss out – place your order now!
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